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FOR BEGINNERS

Starting something new can be daunting. Learning a skKill or
mastering a new piece of hardware is tough. Even tougher if
you have no-one at hand to help. Conversely as the complexity
of our consumer technology increases, the size of the requisite
instruction manual decreases or in some cases it simply disappears.
At numerous times in our lives we have all been“beginners’, there
is no shame in that fact and rightly so. How many times have you
asked aloud, “What does this button do?”.“Why doesn’t that work?".
“What do you mean it doesn’t do that?”.“HELP!". At the start of any
new journey or adventure we are all beginners but fortunately for
you we are here to stand beside you at every stage.

Over this extensive series of titles we will be looking in great depth
at the latest consumer electronics, software, hobbies and trends
out of the box! We will guide you step-by-step through using all

aspects of the technology that you may have been previously
apprehensive at attempting. Let our expert guide help you build
your technology understanding and skills, taking you from a novice
to a confident and experienced user.

Over the page our journey begins. We would wish you luck but
we're sure with our support you won't need it.
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New to Pi? Where to Buy?

New to Pi? Where to Buy?

If you're starting out with the Raspberry Pi, it helps to know where to get hold of one. There
are four main Raspberry Pi approved resellers throughout Europe, and hundreds more
internationally. Let's look at the top four Pi sellers.

THE PIHUT Open a browser and navigate to https://
thepihut.com/collections/raspberry-pi. The Pi
Hut is one of the most popular online shops for all things Raspberry
Pi, including the Piitself, cases, HATSs, kits and bundles, cables,

addons and much more. Prices vary depending on what you're
looking for, but they're some of the best around.

1: :r il
.:. BP'HUt Search for...
r—

Superfast Shipping Five Star Service MNo Quibble
from just £2.99 >S0K customer reviews returns policy

/ &y N Welcome to The Pi Hut

You asked and we listened! We've added thousar
products to our new maker range. Adafruit, DFRa

More! Browse our Maker Store to see what's new

OKDO With its huge range of Raspberry Pi products, including

all manner of maker accessories, kits, parts and

addons, OKdo is one of the top go-to stores for all the tinkerers
out there. You'll find the Pi section of the shop at https://www.
okdo.com/product-category/raspberry-pi/, so hunt around and
see what's available.

Hesourcns ['Raspbery Pi
< | | | https;//www.okdo.com/product-category/raspberry-pi/

Q. Sesrch for aryrhing

RASFEEREY P w0 B 1OT

RASPBERRY PI

QFFICIAL P ACCESSORIES (35) OTHER ACCESSORIES (112)
FILTER BY

MORE Pl

Onitsrelease in 2012 CPC Farnell was one of the original
resellers of the Raspberry Pi. Therefore, not only does CPC
stock a huge amount of Pi-related goodies, but it's also one of the
premier global online electronics stores. Browse the Pi section at:
https://cpc.farnell.com/c/maker-circuit-development/single-board-
computers-microcontrollers/raspberry-pi.

= Shop by Category

ome > Maker B Cocwit LDevelopment > # Board Compulers & Fecracontroiere > Eacpoermy B

Haspbew Fl 319 Froducts Found

e Rrch WERA | 0', B’J Compare Selected (0
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This kit is the perfect -:I'e:'.'-:'Er.-:-:i-' i
@,__,_5 Intreduction ta the Raspherry R

Fi J B= and mclude evenything

wau need ta start right aut of

the boxl The kit includes a

Raspberry M 3 B comput
16GE MicroSD card with

=

»

Founded in 2012, and the makers of the excellent
Pibow case for the original Raspberry Pi,

Pimoroni is a superb resource for tinkerers, makers and Pi fans

everywhere. Found at https://shop.pimoroni.com/products/

raspberry-pi-4?src=raspberrypi, Pimoroni stocks everything you'll
need for your Pi, among other great technologies.

Resources | Raspberry Pi _ -.T;Fr;;. ﬁ

JJ https://shop.pimoroni cum/producl:s/raspbeny—pl-ﬁl‘?src-raﬁpberrypl e] Fl| #|
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Naturally, you don't have to go through any of these recommended stores. Look around the Internet and you'll find plenty of other

places to get hold of a Pi. Both Amazon and eBay are firm favourites for international customers.
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} A Slice of Raspberry Pi INDEX -

ASliceof
Raspberry Pi

Do you already own a Raspberry Pi
but don't know what to do with it, or

are you on the verge of purchasing
your first Pi? This section of the book
will help you build the foundations
required to get the most from this
amazing, tiny computer.
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A Slice of Raspberry Pi

Say Hello to
Raspberry Pi

Let's take a look at the best-selling British computer ever: the Raspberry Pil This bare-
bones machine just looks like any other piece of circuitry, until you realise it's a full-
blown credit-card sized computer ideal for learning programming and home hacking.

Raspberry Pi 2 Model B
Raspberry Pi 1 Model B+

The older Raspberry Pi 2 model can still be found on sale. It has the
same form factor as the Raspberry Pi 3 with 4 USB Ports, Ethernet
connection and Micro USB.

It may look the same but it has a slower 900 MHZ quad-core ARM
Cortex-A7 CPU and 1GB RAM. This brings it close in line to many

low-end desktop computers.

Complicating matters slightly is the existence of a Raspberry Pi Model
1 B+, which is identical in layout to the Raspberry Pi Model 2 but with
an even slower ARMv6 700MHz processor. If you are confused which
type you own then type cat /proc/cpuinfo at the command line. If it
lists four ARMvV7 processors you are using a Raspberry Pi 2, if you see

just one with ARMv6 then you have the older Raspberry Pi Model 1 B+.

Sl
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Raspberry Pi 3 Model B+

The Raspberry Pi 3 Model B+ was launched on 14 March -
International Pi day 2018. This is an improved version with a Faster
1.4GHz, 64-bit quad-core ARM Coretx-A53 processor, a dual-band
802.11ac wireless LAN and Bluetooth 4.2 controller, faster Gigabit
Ethernet, improved mass storage, USB booting, improved thermal
management and Power-Over-Ethernet support. All other aspects
of the new Raspberry Pi are the same as the previous Pi 3 and as
such, all the previous content you come across is compatible. if
you're new to the wonderful world of the Raspberry Pi, this is the
board we recommend you buy.




The Raspberry Piis a British built low
cost computer that enables everybody to
learn computing, start programming and
explore basic electronics. It's the size of

a credit card but capable of running a full
operating system and doing everything a
desktop does.

More importantly, with the Raspberry Pi
you install your own operating system,
connect all your devices and create your
own programs using languages like Scratch
and Python. There's no case so you can hook
up electronic circuits to the pins and control
them to get input and output, so you can
hack together electronic projects at home.

Setting up a Raspberry Pi is pretty simple,
and throughout this book we'll take you
step-by-step from unboxing your Raspberry
Pi to setting it up and getting started.

There are many different models of
Raspberry Pi available and each has slightly
different Features (see opposite).

The Fundamentals of each Raspberry Pi are

Raspberry Pi 4 Model B

Released on June 24th 2019, the Raspberry Pi 4 Model B
introduced a new direction in the layout and hardware
specification of the Pi. The Pi 4 Model B now comes in three

different memory size versions: 1GB, 2Gb, and 4GB. Obviously, the
4GB version is the most powerful of the three, and the Pi with the
highest amount of on-board memory. Subsequently, it was sold

out on the day of release and as such, has taken some time to get

into the hand of the mainstream Pi users.

There’'s also an improved CPU, dual-monitor support in the form of
a pair of micro-HDMI ports, and improved connectivity. Overall, it's

certainly a more capable Pi.

! Say Hello to Raspberry Pi

similar though. Each modelis a lightweight
computer on a single board that's roughly
the size of a credit card. Each Raspberry Pi
board features a processor made by ARM,
which is similar to the models you find in a
mobile phone. The ARM processor is fast
and lightweight but it runs a different set of
software than you might be used to. There
are many different operating systems (OS)
available, but for most of this book we'll
focus on one called Raspbian JESSIE with
PIXEL, which is the OS recommended by the
Raspberry Pi Foundation.

There's no hard drive on the Raspberry Pi,
instead the operating system is installed

on an SD Card (the cards typically used in
cameras). The operating system is installed
onto the SD Card by copying the files to the
SD Card using a computer. We'll show you
how to set up Raspbian JESSIE with PIXEL
(and other OS's) using a Mac, Windows or
Linux computer.

Once you have an OS installed on the SD
Card you can set up your Raspberry Pi. The

Raspberry Pi is connected to a monitor via a
HDMI socket whilst a keyboard and mouse
is attached to the USB socket. A smaller
Micro USB connection is used to provide
power to the device. Most Raspberry Pi
models feature an Ethernet connection,
and an Ethernet cable is connected from
your Raspberry Pi to a socket on your
modem router.

The Raspberry Pi 3 has built in wireless
networking and Bluetooth, making it easy
to get online. You can attach a USB Wi-Fi
dongle or Ethernet adaptor to older models.

First it will help to know which Raspberry

Pi you are using. This can be tricky as there
have been several distinct models so far. The
layouts opposite will help you determine
which Raspberry Pi you have.

This book covers all the different models,
and they offer largely similar Features,
although newer models offer additional
extras. Once you know which Raspberry Pi
you own, you can get it up and running.

Raspberry Pi Zero

The new Raspberry Pi Zero is a super small, super cheap computer
that costs just £4. It's half the size of the model A+ but has a
surprising amount of power, including a 1Ghz single-core CPU and
512MB RAM. It has the full 40-pin GPIO header but you'll need to
buy the pins separately and solder them in. It uses the same
Micro-SD card as the other Raspberry Pi devices, so you can swap
SD cards between them. Last but not least, it draws an incredibly

low amount of power (Micro USB) making it ideal For small power
devices. The ports are smaller than you'd find on the larger
Raspberry Pi though, so you'll need a mini-HDMI adaptor as well as
a micro-USB adaptor to connect devices. A four-port USB Hub and
Ethernet adaptor will come in handy too.

www.bdmpublications.com




A Slice of Raspberry Pi )

Get to Know the

Raspberry Pi

While the Raspberry Pi 4 is the newest model, the Pi 3 models are the most popular among
the community. They're cheaper, more compatible with current hardware and software, and
still pack a significant performance punch. Heres what powers the fantastic Pi 3.

40 GPIO Pins

The GPIO (General Purpose Input Output) pins can be
accessed directly on the Raspberry Pi. These are used
in projects to connect the Raspberry Pi to electronic
circuits and control electric devices. Some can be
turned on and off while the Raspberry Pi is running.

\ll-'f

ARM-Powered

At the heart of the Raspberry Pi 3 is a
Broadcom BCM2837 System on Chip
(SoC). It contains a powerful 1.2GHz
64-bit quad-core ARM Cortex-A53
CPU. This is 50-60 percent faster than
the Raspberry Pi 2 and ten times as
fFast as the original Raspberry Pi.

DSI

The Display Interface (DSI) can be used to connect a
display directly to the Raspberry Pi board.

SD Card Slot USB Power | .

A standard Micro USB power supply is
used to provide power to the Raspberry
Pi. You don’t get a power supply but can

Instead of a hard drive you use
an SD Card with the Raspberry

Pi. The Raspberry Pi 3 (pictured
here) uses a Micro SD Card.
Some older Raspberry Pi models
use a regular SD Card.

use any 5V 2000mA Micro USB power
supply and compatible cable, or buy an
official power supply separately.

10 www.bdmpublications.com




! Get to Know the Raspberry Pi -

USB ports

The Raspberry Pi USB Ports to connect
standard computing accessories such
as a keyboard, mouse and webcam.
Raspberry Pi 2 and 3 boards contain
fFour USB ports but you might need

a USB Hub to get more ports on the
Raspberry Pi A+ and Pi Zero.

Ethernet and Wi-Fi

Connect the Raspberry

Pi 3 to a network or
home modem router
using an Ethernet cable
and this connection. The
Raspberry Pi 3 has built in
wireless networking, but
you must add a USB Wi-Fi
adaptor to older models.

This 3.5mm audio jack is
normally used to attach
headphones or speakers. On
the Raspberry Pi 2 and 3 it also

carries composite video using a
compatible cable.

CSI (Camera Serial Interface)

You can attach the official Raspberry
Pi Camera Module directly to the
motherboard via this CSI connection.

The HDMI connection enables you
to hook up the Raspberry Pi to most

modern monitors and digital televisions.
It carries both video and audio.

www.bdmpublications.com 11
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Up Close with the
Raspberry Pi 4 Model B

Released at the end of June 2019, the Raspberry Pi 4 Model B is a significant improvement

in terms of hardware. Labelled the ‘Ultimate Raspberry Pi, this new generation offers true
desktop computing power.

FASTER AND CONNECTED

There's a lot to like about the Raspberry Pi 4: Up to 4GB of on-board memory, a faster quad-core CPU, support for dual 4K displays : 5 .
via a pair of micro-HDMI ports, and more. Let’s take a look at the Pi 4 and see what its got under-the-hood. 1 /°

PRICING

Since the Raspberry Pi 4 now offers three different
versions within the new model, it stands to reason that the
pricing for it has changed slightly. The 1GB memory version
of the Pi 4 is priced at around £34, depending on where
you shop. The 2GB memory version is on sale for around
£44, while the top-end, 4GB memory version will set you
back in the region of £54. Together with the cost of the Pi
itself, you will also need to factor in one or two micro-HDMI
cables (depending on whether you want to connect one or
two monitors), each costing roughly £5-plus.

Improved GPU

With a VideoCore 6 GPU, the Pi 4 is capable of
4K resolutions at 60FPS (Frames per Second),
and thanks to some tweaks to the video codes in
both Raspbian and the version of VLC packaged
with Raspbian, the Pi 4 is now a pretty decent
media device.

Improved Processing

The 1.5GHz, 64-bit quad-core ARM Cortex-A72
CPU, is the driving force behind the Pi 4's improved
performance. Thanks to this CPU, you're able to
enjoy faster apps and content.

Dual Display

In @ shock move the team behind the Pi 4 decided
to include a pair of micro-HDMI ports. This means
you're able to connect two monitors for dual-
screen displays.

12  www.bdmpublications.com



! Up Close with the Raspberry Pi 4 Model B -

Pl 4 SPEC SHEET

* 1.5GHz 64-bit quad-core ARM 2x micro-HDMI ports
Cortex-A72 CPU (ARM v8, BCM2837) (up to 4Kp60 supported)

1GB, 2GB or 4GB RAM (LPDDR4) H.265 (4Kp60 decode)
On-board wireless LAN - dual-band H.264 (1080p60 decode,
1080p30 encode)

802.11 b/g/n/ac

On-board Bluetooth 5.0, low-energy
(BLE)

2x USB 3.0 ports, 2x USB 2.0 ports DS display port, CSI camera port
Gigabit ethernet Combined 3.5mm analogue audio
and composite video jack

OpenGLES, 3.0 graphics

Power-over-Ethernet (requires the
Raspberry Pi POE HAT) Micro-SD card slot

l 40-pin GPIO header USB-C power

USB 3.0

The inclusion of a couple
of USB 3.0 ports is an
excellent choice. The
faster data bandwidth of
USB 3.0 will, For example,
enable the Pi to read and
write that data, both to
and from an external
drive, far quicker than
ever before.

-
e '.":..?.

Connectivity

Now with Bluetooth 5.0,
alongside 802.11 b/g/n/
ac wireless, and a gigabit
Ethernet port, the Pi 4 is
certainly well connected.

The RPi4 now comes
with a choice of
memory: 1GB, 2GB,
or a 4GB model. The
more memory means

you're able to have
more applications open,
without degrading the
overall performance of
the Pi.

www.bdmpublications.com 13
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Raspbian:
Operating

The Complete
System

The main Raspberry Pi operating system is Raspbian, which is a Linux-based OS. While

the Pi is primarily an educational and project board, with Raspbian, it does become a fully-
functional desktop computer.

POWERING THE Pl

The Raspbian OS has been powering the Raspberry Pi since its release
backin 2013. Atits core, Raspbian is a Linux operating system, based on
the hugely popular Debian Flavour of Linux.

Mike Thompson and Peter Green created Raspbian in 2012, to work on
the low-performance ARM CPUs found in the early Pi models. Toward
the end of 2014, Raspbian was further improved to work on the then
new model Pi, the Raspberry Pi 2; utilising the 3.18 Linux kernel while
still having Debian 7 (codenamed Wheezy) as the base.

Mid-way through 2015, Raspbian started using Debian
8 (Jessie) as the base, with kernels 4.1, 4.4, and 4.9.
Kernel 4.9 was also used from 2017’s Raspbian
release, which has since used Debian 9
(Stretch) as the foundation distribution. ’

More recently, from November 2018, |
the Raspberry Pi Foundation has split
the Raspbian OS project into three
separate distributions. Although these
are essentially the same core operating
system, those available now are a Lite,
Minimal and Full desktop set of images.

One of the primary reasons for the three-
way split is due to the overall size of the
continually improving Raspbian. In its early
years, the Raspbian desktop image size
was a little under 1GB. This image contained
everything the Pi user of the time needed to get
their projects up and running, as well as enjoying
third-party applications such as LibreOFffice. Slowly,
as the Pi itself evolved, the Raspbian image increased. These
days the image weighs in at around 1.8GB and it’s likely to continue
to expand over the coming years as new software is improved on and
added, alongside changing hardware. However, the three-way split
addresses the issue of an ever-expanding OS image, while still enabling
the user to get the most from their Raspberry Pi.

The Lite version image comes in at roughly 350MB in size. While
it may seem like a logical choice to opt for the Lite version, it's not
recommended for every user. The Lite version basically installs without
any of the software you expect from the previous versions of Raspbian;
it doesn't even come with the graphical desktop. This makes it an
incredibly streamlined and efficient version of the OS that's ideal for
those who run headless Pi servers (a Pi without a monitor, keyboard or
mouse attached, that the user remotely connects to in order to input

14  www.bdmpublications.com

commands). You will need to know your Linux commands in order to
get the most from the Lite version, so for most beginners it's not a
good place to start. The more advanced users will, however, be able
to setup their Pi projects without the unnecessary baggage of all the
other applications clogging up the Pi's precious system resources. It's
worth noting that the Lite edition can be made up to a fully functional
desktop version by installing all the relevant software manually.

The Minimal edition is now the default wversion

recommended for most new Raspberry Pi users.

This version is around 1GB in size and includes

the PIXEL desktop, Chromium web browser,

new hardware accelerated VLC player and

Python. It does not include LibreOffice,

Scratch, Sonic Pi and many of the other

\  tools, programs and applications that

previous versions of Raspbian included.

It's a perfect start for most users and

those who are more Ffamiliar with

the workings of Raspbian and Linux

can easily add more apps later, as
they require.

cl—
-

The Full desktop version is 1.8GB in size

(at the time of writing) and as you imagine,

contains pretty much everything you can

squeeze into Raspbian. You get the PIXEL

desktop, LibreOffice, VLC, browser, games,
programming resources and much more.

So, which version should you download and use on your

Pi? Normally, as recommended by the Raspberry Pi Foundation,

most new Pi users are best opting for the Minimal desktop; but that

depends greatly on what your plans are for using your Raspberry Pi.

We recommend new users begin with the Full desktop version, as this

is the version that gives you the complete Pi experience along with all

the associated software; even if you only use a small percentage of it.

In Fact, this entire book was written using the Full desktop version on a
Raspberry Pi 3 Model B+.

As you learn more about the Raspberry Pi, Raspbian and Linux and
begin to form your Pi into a working project, you can easily downgrade
the version of Raspbian to reflect your use. One day, you may even opt
for the Lite, command line only version, occasionally connecting to it
remotely and issuing a few commands. As with most things Pi-related,
it's purely up to you.
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contains all the software you'll
need for a complete OS.
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We recommend beginners try the Full desktop
version First, then downgrade when they know
more about the Pi and its OS.
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Which Pi is Right for Me?

With several models of Raspberry Pi available to purchase, you can be forgiven for any

confusion over which model you should buy. So, to help save you time and money, let’s see

which Pi is best for your needs.

THE POWER OF Pl

With many different versions, across four generations of models, the Raspberry Pi is certainly a busy little board. However, while each Pi
offers something slightly different, for the newcomer it's a confusing medley of hardware specifications and model numbers. Which Pi, then,

is best for you?

Naturally, that question depends greatly on what it is you want to do with your Raspberry Pi. If you have a particular project in mind, such as

a home media centre server, then you'd probably opt for the more powerful and hardware-capable model of Raspberry Pi. If you want to set
up a wireless security camera project, using the Raspberry Pi as the core hardware, then perhaps the Pi Zero W would be a better fit. To begin

with, let’s have a brief look at the models available.

FIRST GENERATION:

Although now quite old, in computing terms, the first generation
Raspberry Pi models are still available to purchase. These are the
Raspberry Pi 1 Model A+ and Pi 1 Model B+.

The Pi 1 Model A+ was released in November 2014 and replaced the
original Model A. It features the now standard 40-pin GPIO, Micro SD
Card, lower power consumption, and better audio circuitry. It's also a
smaller package than the original Pi, while having a 700MHz processor
and 512MB of memory.

While a worthy Pi, it does lack the built-in networking of its newer
model counterparts; both Ethernet and Wi-Fi. The processor is
somewhat lacking in the performance department, which can be an
important factor if you are thinking of using this model for any serious
CPU-related projects. In short, it's probably worth avoiding the

Pi 1 Model A+.

The Pi 1 Model B+ is a Far more capable design than its sibling Model
A+. Released in July 2014, the Pi 1 Model B+ boasts built-in 100Mb

Ethernet and Four USB 2.0 ports. It does, however, still feature the
same lacklustre processor as the Pi 1 Model A+, but its
extra USB and Ethernet ports help make up for

any lack in available hardware.

The First generation models are decent
enough, providing you're undertaking
arelatively low-level project.
Fundamentally, although you can pick
them up from a variety of online

stores slightly cheaper than the
current models, they probably

aren't worth the savings.
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SECOND GENERATION:

There are two, Pi 2, second generation models available: the
Model B and the Model B version 1.2. Although you may be hard
pressed to find an original Pi 2 Model B (without the 1.2 version),
so we will be referring solely to the Pi 2 Model B as the 1.2
version that was released mid-2016.

The Pi 2 Model B offered the user a more powerful Pi experience.
With 1GB of memory, an upgraded 900MHz quad-core ARM
Cortex-A7 processor, and an improved HDMI port. As with the
previous first generation Model B, this version also comes with a
built-in 100Mb Ethernet port and four 2.0 USB port hub.

Overall, this is a superior choice of Raspberry Pi over the first
generation models. The extra processing power, even thoughit's
only 200MHz, does make a difference, alongside the extra 512MB
of memory. If you find one that's significantly cheaper than a
more recent Pi, then it's worth considering.

‘ Made in the UK
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THIRD GENERATION:

The third generation Pi models are
significantly more capable than the previous,
but they may cost slightly more than the
second generation model. However, you do
get more Pi for your money.

The first third generation model to be released
was the Pi 3 Model B, in February 2016. A
newer quad core 1.2GHz Broadcom BCM2837
64-Bit processor, 1GB of memory, and a 4-pole
stereo output and composite video port meant
that this was the power-Pi to have. It's still a
very good model to use, and can accomplish
most of the tasks its younger sibling, the Pi 3
Model B+, can do.

The second of the third generation models
released was the upgrade to the Model B, the
Pi 3 Model B+, released in March 2018. With an
impressive 1.4GHz quad core processor, 1GB
of faster LPDDR2 memory, dual frequency
built-in Wi-Fi and a gigabit Ethernet port, the Pi
3 Model B+ is the most powerful Raspberry Pi
to date, and is therefore capable of running all
your projects without any problems.

The newest member of the third generation
Pi models is the replacement for the second
generation A+. Released in November 2018,
the Pi 3 Model A+ enjoys the same processor
as the more powerful Pi 3 Model B+, but has
half the available memory, at 512MB. It also
loses the Ethernet port and three of the USB
ports, but it does boast dual band Wi-Fi and a
fFar smaller footprint than previous models.

Out of the third generation models, the ones
to look out for are the Model B+ and Model
A+. The B+ will give you a more powerful Pi
experience, but it costs slightly more, whereas

\ Which Pi is Right For Me? -

FOURTH GENERATION:

Introduced on 24th June 2019, the
Raspberry Pi 4 Model B is a significant
leap in terms of Pi performance and

hardware specifications. It was also one

of the quickest models, aside from the
original Pi, to sell out.

With a new 1.5GHz, 64-bit, quad-core
ARM Cortex-A72 processor, and a
choice of 1GB, 2GB, or 4GB memory
versions, the Pi 4 is one-step closer to
becoming a true desktop computer.
In addition, the Pi 4 was launched
with the startling decision to include
dual-monitor support, in the form of
two micro-HDMI ports. You'll also find
a pair of USB 3.0 ports, Bluetooth 5.0,
and a GPU that's capable of handing
4K resolutions and OpenGL ES

3.0 graphics.

In short, the Pi 4 is the most powerful
of the current Raspberry Pi models.
However, the different memory
versions have an increased cost. The
1GB version costs £34, 2GB is £44, and
the 4GB version will set you back £54.
Remember to also factor in one or two
micro-HDMI cables with your order.

The Pi 3 Model A+
was released in
November 2018 and
greatly improves over
the previous Model A.

ZEROS:

In between the first and second generation
Raspberry Pi models, the foundation launched
the PiZero and Zero W.

The Raspberry Pi Zero was a significant
release, as the extremely popular Pi was now
even smaller. Measuring at just 65 x 30 x 5mm,
the Zero still managed to packin a single

core 1GHz processor, 512MB of memory, a
mini-HDMI port, micro USB port, 40-pin GPIO
and a micro-SD card slot. However, it lacked
wireless and other networking capabilities,

so you would need to factorin a USB hub and
network hardware.

The Raspberry Pi Zero W, on the other hand, is
a far better choice. The processor and memory
are the same, as are the other hardware items,
but, as the W indicates, this model comes with
wireless networking built-in. With a 2.4GHz
single-band Wi-Fi module, as well as Bluetooth
4.1, the Pi Zero W is an impressive, slim bit

of hardware.

While the Pi Zeros may sound like a logical
choice, considering their far smaller footprint,
they do lack the performance power of

the newer third generation models. We'd
recommend you opt for a Pi Zero W over the
older Pi Zero, as networking is available out of
the box.

In conclusion, the Pi 4 Model B is the main
Raspberry Pi worth considering if you want

the Full Pi experience; use it for programming,
gaming, projects, connectivity and so on. The
Pi 3 Model A+ can be used for projects that
require more power, but where a smaller size is
needed, and the Pi Zero W for projects where

a much smaller Footprint and lower power

the Model A+ is much smaller, but lacks the
extra memory and additional USB ports.

draw are needed, and CPU performance isn’t
too important.
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Of the Pi models available,
we'd recommend the Pi 4
Model B, Pi 3 Model B+
and Pi Zero W.
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The Raspberry Pi 3 Model
B+ is one of the best Pi
models available.
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The Raspberry Pi Zero W, with

built-in Wi-Fi and Bluetooth, is
a great project Pu.
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Raspberry P11n Numbers

The Raspberry P1 1s one of the most successfully
Launched computers 1n decades. With the perfect mix
of hardware, cost, connectivity, and development,
pLus a8 good,; stablLe Linux 03 te baek 1t up, the P
has proved 1tself to be a near—-perfect educational
platform. Here's some facts and figures for our
favourite flavour of P1.

3.14159265358979. ..

.5: I.-I" -41.1. ,',1_ y . "'I' -.'..I.q.- +-|I _..-..‘;:v h'\-'- er_-'- 11‘.14'-. "ul':"""l.""':rr-'-h;.\_
St o e e S o E

ﬁ There are
over

2,500

= | . Raspberry
= | t § P1 Certified
AIIEHEFSEFFEFFEEF . Educators |
Itls e$t1mat9d ﬁ ﬁ%?ﬂmJMMmMmmmﬁ
T LT that over ; ;

There'sa | | 250,000
. Raspberry in | | 4
Mterotien, | | _70%ne pessle }. |
| where it's | | CVErYy wecC k are L. g
I__Zizzt: (}__Zif;l::) ; E 1:|C) (:1:'(leE hd 1 1t:r1 ia AT Rr Sy T s S st

ot "
LA e

_.

I.

e e e, S T b i gt S T g il s

g b | Tl S il | S e T Rt e, o o e ) el
B T Lt
I e e el g,

P Pl s L Iy
By e o ol

< i

ST
B ]

A e
g bl sl i

o L i Y —iAE WL ey e e L2 L
A ] M Lo e g o iy e i iy e e T it

il + e o0 i
T e, S P

L
i
i
{
;
b
!

IEFINETNTRENNS

A

[y L
T S e
A
Sy .
s bty -
Lah o

L Ny S T - T
g e e ey S e R e g
R T e

ik PR, e i A e T

st EHE
L
i
I
I
[}
H
i
[ |
[ |
[ ]
[ ]
[
i
i
[
i
[
i
Al
% -]
El

s

T T e e G L T W A i el Ty \,-"\.-.-:J'\-
b e & bl s L P WL Fia A4
LT o e g T e il

w P ol 0 ] e el e ) e e A e A=
B o o R

H'i"\h"#‘llr—lp'i'l‘”"f'l.."'-q'l--'-'.'r_.'\'.ll-l-'p" e e iy gt it 1-'-*--".- -"rr-rc- -..,-..u.. vr-.'n+"gf'.u.---.1-,v- -‘ah-.:.-_‘--_--u'hr.qln'e-r H o By A Al '.."\-'lt,‘-
oy e o et T e T w o o Tk e o e o 2y ater 3

The Pi 4 is between | | It is est1mated that
three to four times | | there are over 50,000 |
more powerful than code clubs across
. the Pi 3 Model B+ the world using the ‘s’
R —m———raanar SN Raspberry P1 ? 4

£ .
Ff ilﬂ'_-"w- iz G il g 1 T Py -l.ﬂ'ﬂ-l-'- q,—hh—'ul—- '-nl-".. -ﬂ-“-.ﬁ'\i -I'In -r\l-..\_ "'I‘-m-u-lr‘\;l- -i.- :-"-'ﬂ--q--i. _n-'l‘l- -'“||-|- hl g 1-|'-|'—' -n.r I-\,.., |_--H\..- :-.-,-l"\-l-n-. v, b e q.inf-p-\-.ﬂf".r

ol =l bl el
Pyt o b A T
g

H

il L 8 e
BT P i

o Pyl P i 204 1
e, Ta- LR
W il i e Ty e iy, el
T o e e, ey
e

A Ay SR S T
'F"-. R R )

s B o Ty e el Y T - i T T L T s T g L el b amg e = L gpe TS RS e O i U e D AT e P g fp e o O o % md =g . e i Moy T, il , -l
A s Lpapen. Y e e e ol ey e i R e et B B, Wi e o g gl e i ol g R TN P T P 5 ot e i, B et gy Ty B i e ey Y ey e R |!"|.-r|."|'|.“-_!.-\h_'._l.h" ooy, 7, el i g

Bt T e R ] e R Bt e s g 1 ] g S L
Ty b

. -, iy =, A T e et G L e e g e N L E el T SR R R L T P b el e ST i i T ey B T B R T e L Al S T i o ]
e Sl R, g b Tl W S i e, R = -.‘r'\—""l—'. Foph e Fr g he - -:'r s R e .;1'7".'\—"\-'-: gkt LU = ST T B T T 'i‘:\,-'l—-;:u.-' e s A i ey A .--";-n: Al i B e ey, bl s - e T e h.-'.dﬂ"-.-:‘-i'bl'l\.t', '-I J i, WA e T 6 et T LT A i L el W g ;'.!.- T PP ERLAT, Pt B R, T P, ! i B
L] L L NELY, L Eat Rl ] el L T 2 R x - T R

the Kilauea i § | It was originally |
volcano 1in ... | going to be called |
Hawaii in 201 8_, Raspberry Py, ,:_:
Raspberry P1 as it was only |

— ' 5
mmsmmmmummm ”221 ';;gmeiz ram des anyetdh Otno run

P T e i I T A T o T b e R .:.u:-'-um. W mﬂw

Sources: The Raspberry Pi Foundatlon The Guardlan readwrlte com, Popular Mec anics, CNN, BBC.

L EFVNVEERIN S

| 3333 111
i Lttt it

s s g
b R
ol

Wi e
g ey L

i
L

Y L Tk T N

G R . s - R e s
Fr el L TS F g R e L PRl i e
R % e ey b g T T

R B, T =
Ay

i
B'.‘:....-\.: Ml el g T e I .- ke A -,-.-...-\..........-a-\.- ke e e BT I e M e LR T ﬁ--.:-\.-.—...-.-.-.:-‘.-.-.'_ 4_ L .
AL T e e el b ||.. oy B AR Lt ey ik [ R r..l. I|' L I'\-.'.r-l.. SR DR B TR YL R PR s L) .-'l| ...I...! + i = 1 . | I|

i-l--l-

18 www.bdmpublications.com



\

Raspberry Piin Numbers

bl L RN g Tl D el BT e 'l' L el il Ll e s R e e R Lt R + - Hh ™ T A gy T e _'l""l'.?F-..-l"'\-"ll" |
AT

. wp
e e R i - LT P e LT PRt o, i e B L A e S = I el J.-vu"rlw-r B e T T s Tl s i i) S e L T P i e WA R Sl o iy Iy i, A Pl S T 8 R o o AT, o

[ it re

333333530 Y P-i Zeros are used

'I‘I‘I'l"llllll.fl'_lllllIllllll- as small cameras, :
e placed on the
backs of Green

-l.-_.-ll

i
-

W | s

- .'r

'

Al
L

"'l-ﬂ::k'\l

i

.H:H..\,f
etk

',

i 4
|.

Y
.-"".:

It was _
originally N
designed

3
'

e S ]
« B g
i o iy T s ) T
=3 o el e e e S S R e o e T 1
% iy

.--.
Pl P i B st

il e

T | il s g e 2 el ol i e e, U T e g -

for school | | | ;

Sea Turtles,
to monitor

rl‘fﬂ-.l:hﬁl;—ﬂ_ﬂﬂh‘i‘frﬁ..-s-‘ T e T S M MY el T e TR o e SR
-
i

e ET

i e L

children

o 1

28 et T Tl i Py et W L
e T

35103838
ALLLELLL)

} rEE

1 et i A B i U oy e P ey

EEEEEEEEEREEREEREEEERE

Fn'-i--nt-np-nu-.---—---

PR ARRALD

‘L i'.*'- rI o e \,---n'.'-:l_-. a—ﬂ'-h.l. i... ";ﬂill.'l.nfﬂ-t—'\-q ul-.u.r -l-:-n.. .il- r-..l:m,nj’"‘.il r-_—r--r---.:.. rl-uln ‘l.._:‘"-q_ .-\.l.-:ﬂpl.-.n ..].H“-ﬁ'l-_ ‘.:—w ﬂw-lrrtw-u..--ﬂ-ﬁ-.rqﬂ'\-sw_.-d" i & e _J-ql..-....'-'l.'h.im .[..I....H"l-l- i.-:'r'lm-r-—-pr\-.rhlﬂl i Ll u-q.;—-.u-'h.l.. Ju‘l'h!'.n.. i -u.r".iH Ll'r_;r:li'
i s i i Pgtola S w0 B T i
|_'

I R R R BREBRE R EE R ERBRERRERES

u-r-i-----hlll-ll-li--ll---lll'lll!

?5 to learn ~ 7T i el et fon %
electronics | w2 |  INNNSSIUIIR
g and coding | ; J

Ii-

S oo g ] S -rl|r_'\.|.-|| ke et 2 -.-1-' ol b e g P g 7, B L o il ST o i A e T 8 ifrpreaba I L ey i e e e e e E
"""-- S SRR AL e L T N g Y hirg e A 1--"r i P e Y T e g B Al e, TRl il il T e P P iy T Tk Fre e a0 T W ey el ke el " ot D S e Begr it e el i ol o el T A .-u"-'j'lh.‘l-lh' Bt I 0 A W B S e M T T L e M O I-\.l g LT B L l--h—...---. Wi -\.I-T dv...-_;-'-\-'\-hl-hr-'.- J-ll.l.—h"l' -
-'\‘-'\-rl'.-l'.-\.‘i-hl i Ni-.'\- Ml i g ._.-'i-..d-l-.-\.- lomp P T g il ] g Pl Tl e i i g, PR [T -ty M T ey | S AT R e e -_-‘J-aﬁ._ = g by o P ey L =
k) sk
¥ AT
] _I_"_-\.'
4 &
T e
- p
L .
, 1
'
14 IE.-'?
[T ol
i o
i g | pra e WP s ) e 7 i il e il S sl A T il F il g g 1 d e | il S TU A il AT I i A Tl _Fﬂ"ﬁ'-ﬂ'l'hﬁﬁ-"-"r"-‘ - -.-.l"r.-;l-ll'-' 'u-ﬁ-"F'E 'h.'l-.-a-l-‘-l-lﬂ “ l.--r\l-ll'lll-l-ll.'l.-'! i.'l?-l- Iﬂ"il-'l--l-"-h "'\q'q.'l—- -F"I-.l.l.'.,l‘
=K i s -I--m."\-u:':-l- s BN | BB S e e TP e P du:q R T L P o o i P T T, e 1l 0 e [P T N R I R e S 3 - o
T o e ] ] ing, ™}
"F i L bt B Wi
- - B ¥ ol A
i ' Eh ' | 'k
¥ wh TAR | M
P 3% A 5
, ; Wk
i g4 E - L &Y 15
F il 1 by ol r ‘I.!
J-'._' .k I.?‘ |, o z-l
o 3 i b i : T
S Bk Py 44 . £2
oo - :
e 41 T rf i
i ' o3 1 ar 1
e i
el }J ¥ ¥ F- L
o ¥

ERESL R R R,

v . | marked the point | | i

i I

i g [ E-Sp
:__.'q ey o R T R e g

T ol e g

: where the

o ey gt

]
1

i

y = L L]
.-'... LR i S d B AT SR e Al A T T R .i'._ ..'=:
g T s gy e g gy B g e T, v ey WL -.\_-.-\.-" e g v L B PRt e P ¥
4
al

]

EETTOT s Bl s o ek

AR R T 8 T e A D ol Pl W e
i

%5
i

smxmummu M

|
|
$
3
4
¥
H
£
3
-
i
%
T ¥ » . .
1% G [ %) = £
P o R W i 5L a8 S L T BT g SR ALY TR '\.]-Hu- '\.-n' 1-#‘:1- p.'!-.-hﬂ-'.; N =, l.-.g.-. (Y ] . ...q. i : - - .:.
_"_:-, L i, B . Ty e e = g g P = - e e Pl =, v T .! ¢ == - :._-
" b aS err 1 # T %
4 1] L o y— i
[ i = . - L)
ﬁ was so i | = -
] ir g 4
:I'-I -:;..-'.I E;' ,F- "r::
o b G . : - E‘:.
1 ¥ . H:
r'EL ¥ & VT L5
! L A L) . i e s I o Rl 3 e 2
iy JI.'i:'h:-'n’l-p'n‘l-_ AT u;‘\- ln-‘. .n-_."'\-_-:u-. A edn :l,l.l'!'h. ..-hl"-__r"' I :-'\-5.-' Tkl huﬁﬂ;ﬂn—r l|lq. . l-lr.-.l-h. "iﬂ:? ¥ u-:.-: -._..:.?u- ':I-\-.-.n--q.l..qu-: aaf T E : _ i i"
R 4
¥ v E
% o ?':‘
- B 1 |
i Pl .-r_.u L] T, | -_'-' 3 -v-:i:lr. ! -'\.'\-_I\.lnli;r'.lu' l_--'.{i_."‘-':..:' -“.-r_b.-lg' '-'_-.l,_..I:L'..' l-'-;.-'-"..l-d_ T IrrJ J.-rh"'u.i AL T | - _ e :,. bu ,ara. ". [T Sy F T -I':;'I.'L..-v = N o [ i i Pida 5, &'I a
o b o s =, . S g : L i A O AP iy S S £ g Bty Fim TEE i i L e = ; I
1_i_ el e T T -:.— i._-c 5 I-t\- 1 -.' 1,.- l"\-\..| I l'....-r e "L'- B -E'_{:. kT e SR - i phr = L el o a2 - e - T gt 3L, '-I 1".- B Lo o Rho 3 s w B L Py -I.," 1’ _.I ERRENERNEERR R {:l
v Py F
i ""-s sl u.--—----u-l-u--i---lhl--l-lui s_l
|+ 2‘5 3 g3
- 3 LK) -
1 v . ’F !' L} -t ;E
51 3333303338304 1% n HO -
i SERTREETRTENaNsiiing s [
o 1% [+ : - i
i o { H 3 i
L5 " M - I &
& _— :| B L 4!
8 - ;. 3
* L] - H b}
? L [ | - .*_d. % i - 9
I B n
= e |
:' - e ¥ H
¥ g-= Ts B 2z
2 = 'I]:II E!' L
i 2 - £l
;. "= ] 1 Wy ' .'.;'
e i n rneo S !
'l - i3 L] i-
il iy iyl | ¥4
p = vV P . | Rainforests,
k) i " | ] ! (3
= j=m 3 :: 1_::- E-'E
1 — _?é i - - "
g SCNOO :
-Ii_-' i - } = E N p- !
r ah
1 - . - i . 5
+ ; ; i . - i i [ ] i | L1
% - : -4 . £ [ 53
cnilaren i | Todiversit |
i i 3 H
‘3 | 5 [l
LR \ | 3t b * |
£ 5 1 it
Bt A Ex |-
® Y 2 i
i b I i
§ 5 H b
*\;‘—‘._-L-u-.:- il -,.'-3:-_-&...:. b= IR = A s S g A i T, o L ',-\:'\.;.-.u-_ b TR ..'._-.-\.' g e i T < e ..|_.-¢'|r\-o-:-\.t|_ T ol - e e . L T e N .' e e PR T S DL iy "Fa s e g L e L o R e R i '__l * L 1
b D e L L Pl T TR L B L T A e ) S il L e b et ey il 9 L D e S T e o Tl e i o I bl ~ TR NP S NSy LA R AT e kT S L ...'-u.ui Lattr ey TLE P -«.l';t'\- 1‘..._'.-_.'_.".“3: o B e B il_‘_‘\-f.h._-hhnmr-_l_\% J’..\_-\_L.“._\h\.hwa_k_h“.‘—q ‘] mﬁ:.‘h“_,_w‘.{-
5, : ey poan _ E ,
4 ?."'. 14 ]
L i L IIL
‘L'*;- o] n-ffﬂr l-.u.-- ¥ |.'-.-h-\-..---r= -.|m-'.:-=u b Bt A r.iru...ﬁ- 5 S 10 P N Sl R P gt PR L Tt S R Tl WP o Ty T i P e Y P R W e T TR s rh-..--l‘rﬂ._ YL n - i'I- GO H-\.'.Hl.rr?.ll'hﬁ-'ﬂﬁ .--w-r - -:n:'n-.-' .w.--:ul. | n-‘- yk
s, i "",J. ol - e, M ‘f_-\.-,.---..-..-.--_-.h.-ﬁ-..-. e i Tl o Wt s T et il P S P e TR T s PP L gy v oyt A o i g e o |, P - P LT |, e L s 7 ol Vil
=k | 3 B
U, r
k- % S l_,.l‘.'n‘
- =
-"T""\-!. 'J'r::;. |"I-r' ﬂ,."ﬂ '\-'b—-..'l r.li '-'-d;r-—-'-'\-l.-l—' {""-“’I.r'\" .|.1- '\-.'. '\-I-'\g_-!\l'.a-'-LH_l, L u'_.l'ﬁ-\.l i.i.l;p-r.,.,‘ lq.I:-'i:l -i.-a--. '\l.b:wi' Palfy i _,J-l'\'l‘-‘_ltﬂth l"!-_ﬂ-u#' e ;......,. bl e W T T ll-\.:\- a-nr.-n-- - g PR v F:pl. g u.-" '-n-.-'ll'l.l;rH Ki .n--.—.ﬂ i-.-ln. w1 -rl.-i.."
e, | A B et - SR e et Y i [ TS et e i T gl R S - e ok e o "1'
Py S g & 14
Tau® 4 _,5_'-:"' i
,:-t" _.-'- __,rh‘l;rn--in-..'ﬁm“m -|-r'r1 .'ll;n ul.-'-r-.r- w.-'m:rn "y ‘“I: T S R el T B e Sy T e L TR g AT I--n..h
J:;; P & S | B e e s
OF o e 8. =
¥ & s | 4
= P
.'.i;.'!' ,l_‘_..l"' ir-|l'-.-'-.-=i|--h--r'.,-*l=':'|||~l-ll' P W T e tﬁ-u I--J'r l-l"""\-h'rlii'l-'l“l-"\-l -I.ll-l-- l.'i-l‘"l-l-l'-EM-h." | )
3 .-'.:_1'| s — e =y Pl Bl b ey

The two most used
Pi projects are
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and as a media
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- A Slice of Raspberry Pi )

Kit You'll Need
and How to Set it Up

The Raspberry Pi is as bare bones as a computer can get. You get a motherboard, but not

much else. So you'll need a few extras to get it up and running but they're things you're likely
to have or at least find it easy to get your hands on.

ASK AROUND

The kit list required to set up a Raspberry Pi is pretty basic: keyboard, mouse, HDMI monitor, SD Card and an optional case. Many of these
items you’ll already have, but don't rush out and buy those you don’t. Ask around to see if anybody you know has spares.

STEP 1 The most important thing you need is an SD Card. STEP 3 You'll need a HDMI cable to connect your
These are the storage cards commonly found in digital Raspberry Pi to a monitor or television set; these
cameras. All modern Raspberry Pi boards, including the Raspberry Pi3  cables are used with modern televisions and video game

and Pi Zero, use Micro SD cards but the older boards may use a larger consoles, so you shouldn’t find it too hard to pick up a spare. If

SD Card. you own a Pi Zero, or you've got a Pi 4, you'll need a micro-HDMI
cable in order to connect to a monitor or TV.

STEP 2 The SD Card plugs into the SD Card socket. On the STEP 4 You'll want to connect your Raspberry Pi to the
Raspberry Pi 4, 3, and Pi Zero, you push the card in Internet. The Raspberry Pi 4 and Pi 3 Model B+, have

and pull it out. On some older models, you push the SD Card in again  built in wireless networking and Ethernet. The Model A+ and

to eject it. All SD Cards have a notch on one corner that ensures it Raspberry Pi 2 include an Ethernet socket, but the Pi Zero and older
only goes in one way round. Unless you bought a card with NOOBS boards will require either an Ethernet adaptor or a Wi-Fi dongle to
preinstalled, you'll need to install the software on it first. get online.

20  www.bdmpublications.com




Kit You'll Need and How to Set it Up

STEP 5 Both the Pi 4 and 3 come with Four USB sockets but if
you own a Pi Zero, you may need to purchase a USB GETT| NG EVERYTH'NG CONNECTED
Hub. These connect into the USB socket, and provide four (or more)
USB connections. Typically, you need to connect a keyboard and a
mouse, so at least two USB ports are required.

Now that you've got all the basics you'll need to get everything
set up. If you haven't installed the NOOBS Files on your SD Card,
then it's best to do that first (see the next few pages).

Connect your Raspberry Pi to the monitor using the

HDMI cable. Now attach the keyboard and mouse
to separate USB ports. If your Raspberry Pi only has one USB port,
connect the mouse and keyboard to the USB hub and attach it.

Tl .

r o

Now, if required, connect the Ethernet cable to the
Raspberry Pi. Connect the other end of the cable
directly into your modem/router or into a network socket.

STEP 6 Two things that should be easy to find are a USB v X

Keyboard and USB Mouse. We routinely prefer USB
devices that plug directly into the Raspberry Pi, but devices with
wireless dongles generally work just as well. Only the Raspberry Pi 4
and 3 Model B+ come with Bluetooth as standard, so you're best bet
IS to opt for USB, if possible.

Finally connect a Micro USB cable to the power

supply and attach the other end to a 5V USB power
adapter. This is the type used to power most modern smartphones,
so you should be able to source a spare. Press the On button to
power up your Raspberry Pi.

You can also choose to house your
Raspberry Pi in one of many enclosures
like the official one pictured here.

Consider a case to hold your Raspberry Pi

together. Raspberry now makes an official case
that you can use to hold all the components and protect it from
knocks and drops.
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Set Up Raspberry Pi

Using a Mac

You should install NOOBS (New Out Of Box Software) on your SD Card before you go

any further. This feature looks at how to format an SD Card and copy the software

using an Apple Mac computer.

GETTING TO KNOW NOOBS

The easiest way to get up and running is to use NOOBS, a software program created by the Raspberry Pi Foundation. You can buy a NOOBS
SD Card from Raspberry Pi but it's easy to make your own with an old unused SD Card (8GB recommended).

STEP 1 We're going to use a utility called SD Card Formatter 5
to erase the SD Card with correct formatting. You can
download this app from https://www.sdcard.org/downloads/
formatter_4/. Click Download SD Formatter for Mac and Accept. Click
the SDFormatter.pkg file in your Downloads folder and follow the

instructions to install the app.

@ Safarl File Edit View History Bookmarks Window Help

B O T M EOG 0 =4 5mr & Mon 2B Jan 163
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Member Login
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SD Memory Card Formatter for Mac Download

HOME » Downloads » 50 Memory Card Formatter » 50 Memory Card Formatter for Mac Download

SD Memory Card Formatter END USER LICENSE AGREEMENT
¥ Downloads
NOTICE:
» SD Association Whitepapers BY DOWNLOADING, INSTALLING OR USING THE PRODUCT, THE ENTITY OR

INDIVIDUAL ENTERING INTO THIS AGREEMENT AGREES TO BE BOUND BY THE
FOLLOWING TERMS. IF YOU DO NOT AGREE WITH ANY OF THESE TERMS, DO NOT
DOWNLOAD, INSTALL, OR USE THE PRODUCT; PROMPTLY RETURN (IF APPLICABLE)
THE PRODUCT TO THE SDA OR YOUR 5DA DISTRIBUTOR. IF YOU REJECT THIS
AGREEMENT, YOU WILL NOT ACQUIRE ANY LICENSE TO USE THE PRODUCT.

» Simplified Specifications

¥ 50 Memory Card Formatter

SD Memory Card Formatter for
Windows Download This Agreement (“Agreement”) is between the entity or individual entering into this
Agreement (“You") and the SD Card Association, a California Mutual Benefit
Corporation ("SDA"). “You" includes you and your employees and Affiliates. “Affiliate”
is defined as an entity which controls, is controlled by, or shares common control
with a party where such contral may exist through ownership of securities or by
contract. In addition to the restrictions imposed under this Agreement, any other
usage restrictions contained in the Product installation instructions or release notes

shall apply to Your use of the Product.

FAQ

5D Association Brochure
Download

Use an SD Card of at least 8GB capacity to install the
operating system on your Raspberry Pi. The card

needs to be formatted, which will erase all the data on it, so make
sure you have copied any Files from it you want to save. Insert the

SD Card into your Mac, either directly into the SD Card slot or with
an SD Card adaptor.
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| ® @

Select card

SD Card Formatter

disk2: APPLE SD Card Reader Media

Card information

Type SDHC g.

Capacity 15.93 GB

Formatting options

© Quick format
Overwrite format

Volume label

MicroSD

Format

S0 Loge, SOHC Logo, and SDXC Logo are trademarks of 50-3C, LLE.

www.bdmpublications.com

Make sure the card is present in the Select Card areg;
you should only have one SD Card inserted into your

Mac. Open SDFormatter and choose the Overwrite Format option to
ensure that all the old data is removed from the card. Enter a name for
the card in the Name field to help you identify it; although this isn't

necessary for the installation process.
"‘w-m ~

N i

N eoe SD Card Formatter

Select card

disk2: APPLE SD Card Reader Media

Card information

Type SDHC %
Capacity 15.93 GB

Formatting options

Quick format
© Overwrite format

Volume label

MicroSD

Format

5D Logo, SDHC Logo, and SDNC Logo are trademarks of SD-3C, LLC

Click the Format button when you are ready to wipe
the card. There are other ways to format SD Cards in

macOS (in particular Disk Utility) but the advantage of SD Card
formatter is that it wipes SD Cards with the correct FAT32 format and
doesn't affect the protected partition. It can take a while to format the
SD Card, but the progress bar will show you how the process is going.
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SD Card Formatter

Format SD card

Formatting will erase all data on this card.
Do you want to continue?

Note: As formatting can take some time (especially
when overwrite option is selected), please make sure
that your computer is connected to a power supply
and that sleep mode s disabled.

Continue

Volume label
MICROSD

50 Logn, SDHC Logs, and SOXEC Logs are rsdemarks of S0-3C, LLC




STEP S When SD Card formatter has finished Formatting the
SD Card it will be mounted so you can access it. By
default mounted volumes appear as an icon on the desktop. If not
open a new Finder window and check for it under Devices. Check that
the SD Card is accessible and click Close in SDFormatter.

T ———] ——
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==

1 @ @ SD Card Formatter

Select card

disk2: APPLE SD Card Reader Media

Card information
Type SDHC
1693 GB

i

Capacity

Formatting options

Quick format
© Overwrite format

Volume label

MICROSD

Format

S0 Logo, SDHC Lago, and SDXC Loge are trademarks of S0-3C, LLC

COPY THE SOFTWARE

Transfer the NOOBS files to your SD Card to continue the setup process.

fFinished copying open the SD Card and check that all of the Files are in
the root. You should see “bootcode.bin” and “BUILD-DATA’ files, and a
"defaults” folder among other files.

STEP 1 Open the Downloads folder and click on the NOOBS
zip File to unzip it. ANOOBS folder should appearin
your downloads; it will be marked with the version number you
downloaded from the Raspberry Pi Downloads page. Click on the
Folder to open it and view all the Files contained inside.

B O MB D T4 wosBl 3 Mn28Jan1745 L Q O = |

. @ Finder File Edit View Go Window Help

NCOBS v3_0.0
m- 8-

bom2T08-rpi-0- bom2708-rpi-b- bom2T08-1pi- bem2 F08-rps- bem 2 P09-rpi-2-
w.ollb plus.dih b.dtb cm.dit b.dth

[
o

M2 T 10-rpi-3 B2 7 I0-rpi-3 Bernd F10-rps Baateode Ban
b=phes.dib bbb cmidib

B D-WATA

INSTRUCTIOMS-
README tut

RECOWERY_FRLES
DO _MNOT_EDIT

Press Command-A to select all the Files inside the

NOOBS folder. Now drag and drop all the Files from
the NOOBS folder to the SD Card. This will copy all of these Ffiles to the
root (the base) of the SD Card. Make sure you copy the files and not
the NOOBS folder containing them.

RO MEBO D %= 4 0B = Mn28Jn1745 L Q O

NOOBS v3 0.0
d W

bem2708-rpi-0- | bem2708-rpi-b- Jll bem2708-rpi-
w.dth plus dib b.dth
bem? F08-rpe-0- | bem? PO8-rpd-b-
plus.atb

[+ ’
bam2710-rpi-3- il bom2710-rpi-3- ki 1 e W renn
b-plus.dtb budth

INSTRUCTIONS- E
README txt

INSTRUCTIONS- o8
README . xt

m:l RECOWVH ES

_DO_Ne

RECUVERY_FILES
B NOT_EENT

rocovery condiine il rocovery.cit Il rocovary img)

o ] ecoren7img
RIS

21 of 21 selected, 16.74 GB

! Set Up Raspberry Pi Using a Mac

Now it's time to download the NOOBS software from
the Raspberry Pi website. Open Safari and enter

www.raspberrypi.org/downloads/ into the Smart Search Field. Scroll
down to find the NOOBS section (not NOOBS LITE) and click
Download Zip. A zip file containing the NOOBS Files will be placed in
your Downloads folder.

| @ Safari File Edt View Mistory Bookmarks Window Help B o MEOe O T %G E Mn28lan 1707 L Q Q= |

® ® ®© o

Eaiaharry M Downiodas - Soltwans for the Hadpbarry P +

:_ :E o raspieetrypeLang

L o
L v
Downloads

Raspbian is our official operating system for all models of the Raspberry Pi
Download it here, or use NOOBS, our easy instalier for Raspbian and more

Wait for all of the Files to be copied from your
Downloads folder to the SD Card. After the Files have

Finder File Edit View Go Window MHelp L O MR e 9D 3 T 0 E Mn280en 1751 L Q Q= |

E

L] MICROSD

El=uoc - -

bomd TOE-rpi=0- bomIT08-rpi=b- bem2T08-rpi- e PO == bemi2 T0E=rpi=2-

b P i | B.ab cm.dth 4]
Bem2T10=rpi=-3= bBemITI0-rpi=3-

e T 0 = boolcode. bin BUSLD-DATA
b-plus.ath b.atb cml.dib

H nvovies bem2708-rpi=0-  bem2708-1p

e w,.dib i dth Cloud

(& Recents

f-'h-.- _.'._,I cation L ﬂl.'."l.l'ﬂ Drr'l'!
|$.,

i Documents B gefaults INSTRUC TIONS- o3 crverilng s AECOVERY FILES
© Downicads 1 an's MacBook Pro README txt _DO_NOT_EDIT
o ’ bem2 110-rpi-3 bem2T0-g
Saakinn b-plus dib bditb e Macintosh HD
'...I. WMICROSD £ - -
I:' Remote Dise
@ . recovely Smdline ey el ROy T necan ey 7. mg
dalauits INSTRUCTIC =

README.L

Make sure you eject the SD Card properly. Do not just
remove it from the Mac. Instead, drag the SD Card
icon to the Trash to eject it from your system. Or open a new Finder
window and locate the SD Card under Devices, click the small Eject
icon next to it. Now remove the SD Card from your Mac. It is ready to
be inserted into your Raspberry Pi.

MICROSD

MICROSD
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A Slice of Raspberry Pi )

Set Up Raspberry Pi Using
a Windows PC

It's easy to set up your Raspberry Pi with a Windows PC by downloading and copying

NOOBS. This installs a selection of OS’s onto the Raspberry Pi. So let's format your SD Card

and install NOOBS using a Windows PC.

SETTING UP WITHNOOBS

NOOBS (New Out Of Box Software) is a program used to make setting up a Raspberry Pi simple. You can buy SD Cards with NOOBS
preinstalled, but here we'll look at how to format your SD Card and install NOOBS using a Windows computer.

STEP 1 We're going to use a utility called SD Card Formatter
to erase the SD Card with correct formatting. You can
download this app from https://www.sdcard.org/downloads/
formatter/eula_windows/index.html. Click the Accept button to start

the download of the latest version of the software. Extract the
software, and double-click the executable to install and run the app.

either party from seeking inunctive or other equitable rehet from any court having
jurisdiction over the parties and the subject matter of the dispute as necessary 1o protect
either party's confidential information, ownership, or any other proprietary nghts

13. MISCELLANEOUS TERMS. The partins horoto are indopondoent confractors  You
shall abnde by all local, slale, lederal, and mlermabonal laws, rules, regulabions, and oiders
appiying to Your use of the Products. 1his Agreement will be governed and construed in
accordance with the laws of the State of Galifornia without regard to any conflict of laws
principles thal would require the application of the laws of another junsdiction. The Uniled
Nations on Contracts tor the International Hale of Goods and anv laws hasad on the
Uniform Computer Information Transactions Act shall not apply to Opening S0CardFormeatienv_WinEN.op b 4

Agreement constitutes the ontire agreement between You and SDA
pnor or contemporaneous negotiations or agreements, whether oral
electronically, concerning the Product and related subject matier. No
of any provision hercof will be effective unless madae in @ writing Sig
You. You may nol assign or bansler his Agreemenl or a License I
SDA's prior wntten consent Should any provision of this AQre  wwmat should Firefox do with this file?
uncnforceable, the remainder of the provisions will remain in offg
agreed lhal this Agreemenl and the documents elaled therelo be di
lanquage. Les parties exigent que la présente convention ainsi que

rattachent soient rédigés en anglais.

e ¢ hsen i L=

B sDCardFormattervs WinEN.zip

which i WinRAR ZIP archive (6.0 MEB)
from: hitps//www.cdcard.org

() Open with | WinRAR archiver (default) "
(@) S File

L__J s b ‘ulurn.qliﬂ .rIH:'- e File= like 1. Cromees recmer 1

YOU ACKNOWLLDGL AND AGRLL THAI YOU HAVL RLAD 11N3

INTEND TO BE BOUND AS IF YOU HAD SIGNED THIS ACGREEMI

YOU ARE ACTING ON BEHALF OF AN ENTITY, YOU WARRANT THAT YOU HAVE THE
AUTHORITY TO ENTER INTO THIS AGREEMENT ON BEHALF OF SUCH ENTITY AND
DIND SUCH CNTITY TO THE TERMS OF THIS AGRCCMENT.

L] 4 Lancel

STEP 2 We're going to use an 8GB SD Card to install the
operating system on our Raspberry Pi. The card needs to
be formatted, which will erase all the data on it, so make sure you have

copied any files from it you want to save. Insert the SD Card into your PC,
either directly into the SD Card slot or using an SD Card adaptor.

L L= !"\-.I".l

Select card
E:\ - boot v
Refresh

Card information

Type SDHC

7.29GB

Capacity

Formatting options
(®) Quick format

() Overwrite format

CHS format size adjustment

Volume label
l boot
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STEP 3 The Drive letter will be automatically assigned
depending on the drive(s) in your PC. Click Refresh if it
can't find your SD Card. Ensure the Quick Format option is selected.

Enter a name in the Volume Label field to make it easier to identify the
card (we used “SD Card").

E:\ - boot v
Refresh

Card information

Type SDHC

Capaaty 7.29 GB

Formatting options
(® Quick format

() Overwrite format

|| CHS format size adjustment

Volume label
\ SD Card|

STEP 4 Click the Format button and Yes when you are ready to
wipe the card. There are other ways to format SD
Cards in Windows, but the advantage of SD Card formatter is that it

wipes SD Cards with the correct FAT32 format, and doesn't affect the
protected partition. Click OK again, when the format is complete.

Select card
E:\ - boot v

SD Card Formatter ‘

Formatting will erase all data on this card.
! Do you want to continue?

Note: As formatting can take some time (especially when
overwrite option is selected), please make sure that your
computer i1s connected to a power supply and that sleep
mode is disabled.

Yes No

| SD Card } '




! Set Up Raspberry Pi Using a Windows PC

STEP S Click Exit to close down the SDFormatter program.
Click Start > File Explorer and choose the SD Card
in the sidebar. The drive should be empty, but we will copy the

Files to it in the next steps. For now just make sure that you can
access the empty root of the SD Card.

1

Share Wi Drove Toods

v 4+ 2% 5 This PC * SD CARD (E)

# Quick access
& OneDrive

v B This PC
» 3D Objects
m Deskiop
¢ Documents
* 4 Downloads
> Music
» &= Pictures
B Videos
> 2 Local Disk (C)
* e New Volume (D)
> 5D CARD (E)

“ 5D CARD (E)

il Network

COPY THE SOFTWARE

Continue making your SD card by copying the files across.

Now it's time to download the NOOBS software from the

Raspberry Pi website. Open a web browser and enter
https://www.raspberrypi.org/downloads/noobs/ into the URL field.
Scroll down to find the NOOBS section (hot NOOBS LITE) and click
Download Zip and Save. A zip file containing the NOOBS files is copied to
your Downloads folder. Click Open Folder when it is done.

' Products Blog Downloads Community Help  Forums  Education  Projects Q

NOOBS

Baginners should start with NOOBS - New Out Of the Box Software. You can
purchase a pre-installed NOOBS SD card from many retailers, such as Fumnoroni,
Adafruit and The Pi Hut, or downioad NOOBS below and follow the software setup
guide and NOOBS setup guide videg n our help pages

MNOOBS is an easy operating system installer which contains Raspbian and
LibreELEC . It also provides a selection of alternative operating systems which are
then downloaded from the intermet and installed

NOOBS Lite contains the same operating system installer without Raspbian pre-
loaded It provides the same operating system selection menu allowing Raspbian
and other mages 1o be downioaded and nstalled

A NOOBS folder should appear in your downloads. It Wait for all of the Files to be copied from your

will be marked with the version number that you
downloaded from the Raspberry Pi Downloads web site. Double-
click the NOOBS zip File in your Downloads folder to view the

contents. These are the files you need to copy to the root (base) of

your SD Card.

Compiéiied Falger Foall

Extragn

| » ThisPC » Downloads » NOOBS V1 8.J

LM esen HOE

defaults

Downloads folder to the SD Card. The files that are
copied will install an operating system of your choice on the Raspberry
Pi when you First boot it up. It is important that the Files are copied to
the root (base) of the SD Card and are not inside another folder such
as the NOOBS folder.

Campretred Fobaer Toslt

Cotract

i 2+ | » ThisPC » Downloads » NOOBS VI 9.3 » .
| "= 1% complete
i

# Cuick sqoess e o i Copying 51 ems from NOORS +1_9_3 18 NOOES (F
- File Boighe
a Fecycle Bin + = ’ e 1% complete

::trtr,'i o | Select a destination

bomd TOR-rpa-b.dilhy TE File T am * NOOBSIE)
| e TOB-rpi=be=plug.dth I
| hemI 70N epi- 2 Bt
| bemdT10 rpi-3- b.oib OTE File L Decumants & = Marre
| bootoodeben M Fie = Pictures
| BULD-DATA i e & 0_Acton
| INSTRUC TIONS- README
| TeCovery
| iegevery.omdiine
| recovery o
| recorcery. RFS File 13 Oropbex
| RECOVERY_RLES_DO_NOT _EDIT F
o TRTOVETY T

| ngces-boot b BIM Fide B The #C

Drganne = Hew folder

evierlays
g Hreenshots
& Setup Python W

i Oreliree
- HOORS (E)

P Network — NOOBS (E)

¥ Metwork W

—— ' X | Estra
¥ Down " overliyd File liolded I

bem2 T04-rpi-b.dtb DB File

| eI T08- rpi-b-plus.dtb OTE File oelect More detarks
bemd 705 pl-2-b.dth CTE F

| Bt TI0-rpl- 3 budls
Baplsade B

| BUSLD-D&TA
BSTRUCTIONS-README P T —— D“H wilracted files when complete

Falet wall e evtractsd ta that falder

& Serup Python_Wine

| mecovery

g Drﬂphﬂu

dam Crellreg

& Thas PC RECOVERY FILES DO _NOT_EDIT
| recovery T

== MODRS (E) racos=bool bm

g Metanrk

Felden

Click Extract All to expand the zipped File and extract
its contents. Click Browse in the Select a Destination
and Extract Files Folder and choose “SD Card(F:)" in the Select a

Destination window. Click Select Folder and Extract. The files willmow  your Raspberry Pi. Check that you can see a Defaults folder, bootcode

be copied directly from the zip File to your SD Card.

i 5 ThisPC » Downloads » HOOBS v 9.3
Fazsword
defauits

! Fatrart Compressed (Tipped) Falders
overhys

| e T0E=rpaebodtl DTE File
bem2708- rpi-b-plus. dth 018 Fde Select a Destination and Extract Files
| Bem TS rpi=2: k.0t

- Fele will by extracied to thi olde
bemd T10-rpa-3-b.dth

B

booteode ben
| B D-DATA
HSTRUC TIONS-READRE Tewt Do virr sl D Shiow wmld FIJH wien w‘tl

| recovery

| recovery condiine
| reeBEny i
| recovery.s
EECOVERY FILES DO MNOT_EDIT
| recoveryT
| mscei-boatbm

Click Start > File Explorer and choose “SD CARD (F:)" in
the sidebar to display the contents. It should now
contain all the files NOOBS needs to setup an operating system on

and BUILD-DATA Files along with the other files shown here. Remove
the SD Card from your Windows PC. It's now ready to be inserted into
the Raspberry Pi.

Diwve fasls  NOOBS(E)

- « B = » HOCBSIE) »

w o Quick scons
ﬂ H‘H:,-rlf Bin detaults
‘.lp Downlosds :1.1.}1
Il Desktop d bernd 70B-rpe-b. dith
% Docoments of | bemT08 rpi-b- plus.dtb
o Dictures ¥ bemd T08-rpe-2-b.dib
oA | B2 T10xrme= J-b.dith
| bectcodebin
| BULD-DATA
: IS TRUL TIOMS-READRE

=
overlays

= Lereenshobs

& Setup Python 'Wing

E't Drepbex | recowery.elf

_ | recovery
fil Onelrrve ] roe o

__ This PC RECOVERY _FILES_DO_MOT_EDMT
| et ove 7T

| recovery.omdline
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The Raspberry Pi Desktop:
What You Will Need

Did you know that there is a way in which you can run the full Raspbian OS desktop without

even needing a Raspberry Pi? The Raspberry Pi Desktop edition is a fully working, Debian-
based installation of Raspbian that can run on a standard PC.

In 2016, the Raspberry Pi Foundation started work on an x86
version of its popular Raspbian operating system. By the end of
the following year, there was a link on the Downloads page and
non-Pi owners could now install and use Raspbian in almost the
exact same way as if they were in front of a Raspberry Pi.

Since then, the Raspberry Pi Desktop, or as it's correctly called:
Debian Stretch with Raspberry Pi Desktop, has followed the same
release path as its Pi-based sibling. However, there are some
differences you need to be aware of prior to throwing your Pi
away and opting For this version instead.

The Raspberry Pi Desktop (x86 version) allows you to view the
same desktop and pre-installed software as the Full Desktop
version available for the Raspberry Pi. You can install it on any
decent PC, or laptop, one that’s at least six or seven years old
would be perfect and as a PC that age usually struggles with
the latest version of Windows 10, you can now install Raspbian
instead of boxing that old kit and resigning it to a life of
gathering dust in the loft.

The major difference is that this version has been compiled to run
on x86 processors, that's Intel and AMD PC processors. Whereas,
the version of Raspbian that you will find on a Raspberry Pi has been
compiled and created exclusively for ARM processors; the type of
CPU a Raspberry Pi uses. These CPUs use a different architecture
to that of an Intel or AMD CPU, so the software required to run on
one won't run on the other unless the developer has specifically
made either an x86 or ARM version. In short, if you've found a piece
of software that you enjoy using on your Raspberry Pi, you won't
be able to use it on the Raspberry Pi Desktop x86 version — UNLESS,
there's a dedicated x86 version of the software.
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Another caveat worth mentioning is that you won't have access to
the 40-pin GPIO that the Raspberry Pi features, as this isn’t a standard
piece of hardware on a normal PC. There is, however, a way around
this. If you own a Raspberry Pi Zero (either with or without the W),
then you're able to connect the Zero to a spare USB port on the PC,
via the Zero's micro USB port and the Raspberry Pi Desktop OS will
recognise the Zero as extended hardware and allow you access to the
Zero's 40-pin GPIO, which, you have to admit, is pretty clever stuff.




) The Raspberry Pi Desktop: What You Will Need -

WHAT YOU WILL NEED

Here's a list of items needed if you want to test out the latest version of the Debian Stretch with Raspberry Pi Desktop OS on your PC.

THE OS Naturally you'll need the Raspberry Pi Desktop OS, just USB STICK The best method of transferring the ISO to a PC for

as you would with Raspbian or the Pi. Open a browser installation is to use a combination of a tool such as

and download the ISO Ffile that contains the OS from: https://www. Rufus (Found at: https://rufus.ie/en_IE.html), which is a piece of
raspberrypi.org/downloads/raspberry-pi-desktop/. software that can create a bootable USB driver from an ISO File and, at

RASPBERRY Pl DESKTOP

least, an 8GB USB stick.

Debian with Raspberry Pi Desktop is the Foundation's operating system for PC
and Mac. You can create a live disc, run it in a virtual machine, or even install it on
your computer.

Raspberry Pi Deskiop comes pre-installed with plenty of software for education,
programming and general use; including Python, Scratch, Sonic Pi, Java, and more.

DEBIAN STRETCH WITH

RASPBERRY Pl DESKTOP
The Raspberry Pi Desktop OS for PC and Mac - based

( ;" , on Debian Stretch
Version: NHovember 2018

Helease date: 2018-11-13

e — Kernel version: 4.9

[¥ Download Torrent | B Download I1SO

A COMPUTER An older desktop PC or laptop is an ideal RASPBERRY Pl ZERO Although not strictly a necessity, a
candidate for running the Raspberry Pi Desktop spare Raspberry Pi Zero will allow you
OS. While you can easily use the latest PC/laptop, it's a bit overkill for to access the 40-pin GPIO from within the Raspberry Pi Desktop OS. If,

this particular operating system. however, you don't have a spare Zero, it's not a problem as there's still
plenty you can do with Raspbian on a PC.

HOW TO SET UP THE T

RASPBERRY PI DESKTOP

Setting up the Raspberry Pi Desktop version on a PC or
laptop is very simple, and fFollows roughly the same method PRk e p R

YOur COmpUter

as the previous Mac and Windows setups for the Pi. Begin by e
downloading the ISO image from https://www.raspberrypi. el
org/downloads/raspberry-pi-desktop/, then download Rufus | TR s o R

From https://rufus.ie/en IE.html. Insert an 8GB USB stick CHEE =

and run Rufus, then Follow the on-screen instructions to

locate the downloaded Desktop ISO. Once the image has

transferred to the USB stick, remove it from the computer

and insert it in the spare laptop/PC. Select Boot from USB

From your system’s BIOS/UEFI then follow the instructions to

use and install the Raspberry Pi Desktop OS.
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Debian Stretch with

Raspberry Pi Desktop

You can be forgiven for thinking that a version of Raspbian that isn't on a Raspberry Pi is

somehow lacking and therefore a bit pointless in its use. However, there's a lot that you can
do with the Debian Stretch with Raspberry Pi Desktop version.

T0 THINGS TO DO WITH X86 RASPBIAN

You can do just as much with this version of Raspbian as with the dedicated Pi version and to demonstrate here's ten great projects to do

with Debian Stretch with Raspberry Pi Desktop.
CODING This version of Raspbian apes the Full Desktop version

fFor the Raspberry Pi, meaning it comes with all the
necessary programming languages out of the box. Learn Python, C++,
use the HAT emulator and even learn JAVA. It's all there under the
Programming menu option.

AED

& & ‘ A Python 3.5.3 Shell

d Education » gt ) Geany Programmer's Editor

® o q

vy Office » 1 Greenf A

ey .ﬂl a NIM T

ﬂ;}; Intermet 5 Pvthon 2 (IDLE) [GCC 6.3.0 20170516] on linux
- - 'u-

Type "copyraight”, "credits" or "license(
o

l:l Sound & Viden

HARDWARE Hook up a Pi Zero without an SD installed, select

GPIO Expansion Board from the options and you

will be able to talk to the Zero's 40-pin GPIO via the likes of Python or
Scratch. By doing so, you'll have all the benefits of a Raspberry Pi, with

the power of your laptop.
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FULL DESKTOP K& the x86 version of Raspbian follows the Full
Desktop Pi version, there's an entire office
suite pre-installed, allowing you to use that old laptop or PC as a fully

functional desktop replacement for Windows or macOS. LibreOffice is
also Microsoft Office compatible.

! 8 @& (B [[=)untived 1 - Libreoffic.

Untitled 1 - LibreQffice Writer

Fdit View Insert Foimal  Slyles Table Tools Window Help
Ab¢ === - E

Lv1 T-HO:

2 |v/aaa-aaba &

|
7

]

E
s i N

LibreOfflce Wrlter. A fantastic word processor that’s Microsoft Office compatible!

WEB BROWSING As with most modern operating systems,

you can browse the Internet exactly as you
would with Windows 10, the latest macOS or similar and because this
is a Linux-based OS, there's an added element of security, as it won't
be affected by Windows-targeted viruses.

‘ $ @& (B I som publications- 1.
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! Debian Stretch with Raspberry Pi Desktop

LINUX X86-BASED SOFTWARE As this is a Debian based MINECRAFT Neither the Raspberry Pi 4 or the Pi 3 Model B+
version of Linux, you can are the most powerful computing devices
naturally install any of the tens of millions of Linux x86-based software available. Your older laptop is probably significantly more powerful
currently available. Remember though, only software that has bothan  but even so, you will be able to play games like Minecraft without too

ARM and an x86 version will work on both the Pi version and this much trouble at all.
version of Raspbian.

& ’1_;3 H E{,—:.:E:rnﬁphm}r ~/Min ﬁMmEﬂ'aﬂl 121 TL o0 | s 6 1515

S

$ @ B Bowsony-

Minecraft 1.12.1

ATHER AT VR
_"gﬂtﬁ WL "

s 5

aingleplayuer
Multiplawer

Mimecraftt FHeslms

() | Options., Ouft Game

Hinecr-aft 1.12.1 Copuriaht Hodana AG. Do not distribute!

RECOMMENDED SOFTWARE The Recommended RETRO GAMING If retro gaming is more to your taste, then
Software option is also Debian has a huge number of retro
available with this version of Raspbian. This tool allows you to pickand  emulators available, covering both consoles and home computers. You

choose which of the Pi-favoured software you add or remove. Simply will need legal ROMs, however, to play the games, but these are
tick the box next to the name of the app. widely available from reputable sites.

i_gemrmnendeﬁsafm..: 1l o [d (@ ~in [ [Downioads]

-

pprox. size
LibreOffice
® LibreOffice 15 @ complete office suite

AT IRRRRAAAARARRERARRARARRTAS

Python Games

Scratch

@ It's easy to use SSH from within the Raspberry Pi GAMING Of course, there's an equally large selection of modern

Configuration tool. Select the Enabled option and then use a gaming available for Debian; most of which will run
client, such as PUTTY, to SSH into the OS. Here we've enabled SSHand  perfectly well under Raspbian in an x86 environment. You will need to
connected from another Windows PC, using PuTTY as the SSH client. Google what's available and try out a few examples as the list is simply
too big to mention.

:’ ¥ @ B Bocor— v [FPromors
- g _—— g

e

b -
SSH ®) Enabled — SN S5 S—

oy

D!

I' Raspbery Pi Configu.. | SSMl(pi@raspberry: ~]

B R
B -

-
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Pingus 0.7.6
Raspbermy Pi Configuration

System Interfaces | | Localisation k
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Debian Stretch —
Virtual Desktop

Don't have a spare PC handy for Debian Stretch with the Pi Desktop? Then consider a virtual

machine. Within a virtual machine, you can run the Pi desktop without ever affecting your
Windows or Mac setup. Here's a quick how to.

GOING VIRTUAL

You'll need a copy of VirtualBox to download and install, which you can find at https://www.irtualbox.org/wiki/Downloads. Windows
users click on Windows Hosts, macOS click OS X Hosts.

STEP 1 Install the downloaded VirtualBox for your system by STEP 3 When asked “Install the GRYB boot loader to the
following the on-screen instructions. Next, download master boot record?” Select Yes, and choose /dev/sda;

the Raspberry Pi Desktop ISO from https://www.raspberrypi.org/ after a brief time select yes to installing a GRUB boot loader followed
downloads/raspberry-pi-desktop/. Start VirtualBox and, from the by the sda drive identification (not the Manual option). Once installed,
menu, click Machine — New. Edit the Type to Linux, version to Debian click Continue to reboot and you'll see the Raspbian desktop load up.

(64-bit), and name it Raspbian. Click Next and follow the default options.

Name and operating system Cdebian

" ) ; ? I i
Please choose a descriptive name and destination folder for the new virtual UBLeLE SRURSRLBRAEE N, & ALY clbk

machine and select the type of operating system you intend to install onit, It seems that this new installation is the only operating system on this computer. If so, it should be safe
TI"IE name you IEI"IIEII:IEE Wi" IZIE LIEEI:I H"ITEII..IEII"IIEILIt 'u'irh_lalElm-c o idEﬂﬁﬁl‘ ﬂ"liE to install the GRUB boot loader to the master boot record of your first hard drive.
machine. Warning: If the installer failed to detect another operating system that is present on your computer,
modifying the master boot record will make that operating system temporarily unbootable, though GRUB
can be manually configured later to boot it.
Mame: ‘E_EIEHIZII ari DEEl'itﬂl:ll Install the GRUB boot loader to the master boot record?
() No
Machine Folder: ‘ C:\Users\david\VirtualBox VMs o ® Yes
Type: | Linux -

Version: | Debian (§4-bit) - | STEP 4 Drop into a Terminal, click the fourth icon along the top

menu bar, and enter:
sudo apt install build-essential module-assistant dkms

sudo m-a prepare

STEP 2 Start the newly created machine and then locate the Answer yes to install packages. Click on Devices in VirtualBox,
downloaded Raspberry Pi Desktop ISO. In the menu followed by Insert Guest Additions CD. In the Terminal, enter:
titles ‘Debian GNU/Linux Installer Boot Menu’, use the arrow keys and sudo sh /media/cdrom/VBoxLinuxAdditions.run

select Graphical Install. Press Enter and follow the on-screen installation sudo reboot
instructions. Use the Guided - Entire Disk option when asked, then Write You can now adjust resolution via Menu > Preferences >

Changes to Disk. Screen Configuration.
: | : , | $ @ P T sereen Layout Edite
@
. * @ o
(Jdebian -
. @ - -
Install the system [i] : .
= Gap :
2 Gan .
i E . " Scroen Layout Editor
_ Installing the system... o= Yy | caifliicy
Copying data to disk... » T
" 1 Virtuall

Bl G o e T e e O |
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Z Discovering Raspbian INDEX ”-

Discovering
Raspblan

The Raspblan operating system
IS a Linux distribution that comes
pre-packed with a fantastic
collection of programs and apps
toh p_lp you get the most from
your Pi. Raspblan enables the
Raspberry Pi to become a fully
functioning desktop computer
and with it, you can code in the
latest version of Python, Scratch
and more.




- Discovering Raspbian )
Take a Tour of PIXEL

PIXEL is the desktop environment for your Raspberry Pi. It's built on top of Raspbian, the core

OS, which is itself designed around the Linux distribution - Debian, specifically, Debian Buster.

PIXEL is fine-tuned to run on the Raspberry Pi, taking advantage of its unique hardware.

PIXEL

PIXEL stands for “Pi Improved Xwindow Environment, Lightweight”. It's a lightning fast and energy saving desktop that looks good too. It

contains almost everything you'll ever need to work with the Pi 4.

The PIXEL interface is a module that'’s installed

on top of the core OS. It has seen some
improvements over the years, and with the release of the Pi 4 and
Raspbian Buster, it now looks like this.

¢ @M=
* L]
. F'r-::gramr'ﬂir".-g

é Education

*_2 Office

@ intermed

IH sound & Video
F Graphics
Haanﬂes

' | ACCESS0Nes

THE PROGRAMS The programs that come pre-installed with
Raspbian are easily located by clicking on
the Raspberry Pilogo in the upper left corner of the desktop. Once

there, you can select from the sub-menu categories, followed by the
program name.

PRODUCTIVITY You'll notice that within the Main menu,
there's a category named Office. In here,
you'll find a pre-installed suite of programs called LibreOffice, that are

Microsoft Office compatible; there’s a word processor, database,
drawing, presentation and spreadsheet program.

 LibreOffice Base | A%~ - XA ] - E

-fag&ababg.

|
LibreOffice Calc

|
LibreQffice Draw

-

LibreOffice Impress

vx| LibreOffice Math

LibreOffice Writer //Main Header

Take a Tour of Pixel
/ntro PIXEL is the desktop environ
0S, which is itself designed around
is fine-tuned to run on the Raspberry
PIXELs
/Mntro PIXEL stands for Pi Improve
energy saving desktop that looks go(
Pid.
/img webappsl The Dekstop The F
has seen some improvements over th
now looks like this.

/fimg webapps2 The Programs The
by clicking on the Raspberry Pi logc

To view the files stored on your Raspbian OS,
click on the File Managericon in the

Application Launch Bar (the one that is shaped like a pair of files). This

opens a window displaying all the Files in your home directory. The

Directory Tree gives quick access to common folders, such as Desktop
and Documents.

File Manager

| Ju
-

Tools

File Edit View Sort Go

Y | BS eS8 EE =S | (o] 4P  /home/pi
wr |_‘_|J|r ¥ i 9 = __h: - 7
b []bin .. = "
Desklop Documents Dow
. .:.:i]:l I | _u
Public Templates V

b (@] Desktop
b | §| Documents

b [w]|Downloads

b (@] Pictures
» '] Public




\ Take a Tour of PIXEL

MENU EDITOR It is possible to remove and add items to the SHUTDOWN It's important that you switch off your Raspberry
Application Menu using the Main Menu Editor. Pi safely. When you are finished with your
Choose Menu > Preferences > Main Menu Editor, then add or remove Raspberry Pi session click Menu > Shutdown. Three options appear:

ticks next to programs and sections you want to include\exclude. Use Shutdown, Reboot, and Logout. Click Shutdown. Always wait for the
Move Up and Move Down to rearrange items in the Menu. screen to go blank before removing the USB power.

@ Help

= | Preferences

<

¢ Shutdown...
Lt

&) Help

p— ...

Main Menu Editor v A X :FB 4"—'3! 'Shmm
rogramming y
, Programming v , Programming Naw ftorn ® ofice ;
@ Education v @ Education .
% office v W Office GE s :
s Internat ) @ Internel 1};[ Sound & Video » |
EI Sound & Video . [H Sound & Video W Graphics >
¥ Craphics v ¥ Graphics Bl Games >
&% Games v &l Games ﬁ‘ AcoEsoniae : Shutdown options
il Other v [l Other - : Shutdown
& System lools v &b System Tools & ek } T
“i » Accessones v i Accessornes =T | agout
& Universal Access | o 2 Universal Access

CUSTOMISE THE DESKTOP

As with any other operating system desktop, you're able to customise the Raspberry Pi's PIXEL interface, making it more personal and more you.

YOUR PIXEL Choose Menu > Preferences > Appearance MENU BAR The second tab in the Appearance Settings window
Settings to open the Appearance Settings allows you to adjust the menu bar that runs along
window. There are Four sections: Desktop, Menu Bar, System, and the top of the desktop. You can change its size, colour, and even its

Defaults. You can use these to adjust the various options for your location from the top to the bottom of the screen.
system, such as colours, layout, and so on. -~

1 Vv

Appearance Settings

Appearance Settings

Desktop | Menu Bar‘ System ‘ Defaults

Desktop | Menu Bar | System | Defaults | o
. | | .. Layout Fill screen with image

Layout Fill screen with image ~

Picture w| temple pg (=

Colour

Colour Text Colour

Documents v Wastebasket 1 Mounted Disks

Text Colour

Cancel OK

Documents v Wastebasket ' Mounted Disks

Cancel OK

-l_.

DESKTOP WALLPAPER The most common change is that of FONTS The System tab in the Appearance Settings window will
the desktop wallpaper, or desktop enable you to change the core system font, as well as the

background. The default is called ‘Temple’, however, by clicking on mouse cursor size. There are numerous fonts to choose from and, if
temple.jpg in the Picture section of the Appearance Settings, you you want, you can even install your own.
have other images available. Naturally, you can opt for your own. L B,

e ——

Appearance Settings
Appearance Setlings

Desktop | Menu Bar‘ System | Defaults

Desktop | Menu Bar | System | Defaults
Size Large (32x32) Font ~ Pibotolt = 12

Position e Top Bottom Highlight Colour

Colour Highlight Text Colour

Mouse Cursor
Text Colour

Cancel
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Exploring the
Command Line

USING TERMINAL

Despite its graphical PIXEL interface, Raspbian is a Linux operating system and this means you'll spend a lot of time working with text
commands. Using the command line is an important part of learning to use a Raspberry Pi computer.

By default the Raspberry Pi boots directly into the Another way to switch to a command line environment
PIXEL interface. Here you use a visual metaphor, files, is to press Control+Alt and F2. This gets rid of the
buttons and so on, to make changes to your computer. The command desktop completely and you see just a black screen with text. This is
line is where you control a computer by entering text commands. Click  known as a virtual environment and you're now in tty2 (“tty” is a
Terminal in the Menu bar to view the console. throwback to teletext writers). You'll need to enter your login name

& @ 3% O [Foeaspbenypi - (“pi” by default) and password (“raspberry” by default).

Raspbian GNU/Linux 8 raspberrypi ttuycs

raspberrypi login: pi

Passuword:

Last login: Sun Oct 2 18:11:47 UTC 2016 on ttuyl

Linux raspberrypi 4.4.21-uv7+ #911 SMP Thu Sep 15 14:2Z2:38 BST 2016 armu?l

The programs Included with the Debian GNU-/Linux system are free software:
the exact distribution terms for each program are described in the
individual files 1n /usr/sharesdoc/»/copyright.

Debian GNU-/Linux comes with ABSUOLUTELY NO WARRANTY, to the extent
permitted by applicable law.
pilPraspberrypi:

You can enter commands into the Terminal to make m There are six different virtual environments

¥ changes to the computer. This works alongside the available. Press Control-Alt-F3 to switch to the third,
PIXEL interface. Enter: mkdir Desktop/testfolder and press and Control-Alt-F4 to go to the fourth, and so on. You'll need to log
return. Notice a new folder appears below the Trash on the desktop. on to each one in the First instance but can then jump back and forth
Drag it to trash to get rid of it. You can use the Terminal and PIXEL between them.

environments alongside each other.

$ =B % (3 Bl pi@raspberrypi: ~

ﬁm_

Raspbian GMU-Linux 8 raspberrypi ttyb

raspberrypl login:
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Press Control-Alt-F1 to return to the PIXEL interface.
One thing to realise is that PIXEL is just a program
running on top of the tty1 session. Open Terminal and enter: pkill
1xsession. Ouch, there goes your desktop. Don't worry, enter:
startx to get it back again. Most of the time you just enter
commands into the Terminal window on top of the PIXEL environment.

%D

Z pi@raspberrypi: ~

| Some users prefer to use just the command line.

- Open Menu > Preferences > Raspberry Pi
configuration and choose To CLI and click OK and Yes. The
Raspberry Pi will now boot into the command line interface. Enter:
startx to get back to PIXEL, open Raspberry Pi Configuration and
choose To Desktop to go back to normal.

z pi@raspberrypi: ~

pil@raspberrypi:

We Trust you

Administrator.

#1) Respe
#2) Think
#33 With

[ 'E_-I_J-J-;l ] passWwo

pi@raspberrypi:

= B 2% G B pi@raspberrypi: ~ \_x ]

pi€raspberrypi: sudo -V

We trust you have received the usual

lecture from the local System
Administrator. It usually boils down to

We trust
these three things:

#1) Respect the privacy of others.
#2) Think before you type.

#2) Think
#3) With great power '

comes great responsibility.

[sudo] password for pi: | [sudo] passwoi

you have received the usual lecture from the local
Administrator.

#3) With great power

pi@raspberrypi

root@raspberry

have received the usual lecture from the local System

It usually boils down to these three things:

ct the privacy of otl
before you type

great pows

rd for pi:

Em@raspberwpr ~

D18 rl"":[ElEl.‘-!: rypi:

System
It usually boils down to these three things:

#1) Respect the privacy of others.

before you type.

comes great
a Tor pl.:

- Sudo -1

pi:~# efj
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Setting Up a Static

IP Address

While this may sound complex, it's pretty easy if you follow these steps. A static IP

ensures other computers can always find your Raspberry Pi. You don't have to do this,

but it often comes in handy.

DHCP RESERVATION

Now that you've set up your Raspberry Pi and connected it to the network, you should take time to Fix its IP address. This will make it a lot
easier for you to connect to the Raspberry Pi from a Mac or Windows computer and share Files.

STEP 1 When you
connect

your Raspberry Pito a
network, the router (or
modem/router) assigns it a
number, known as its IP
(Internet Protocol) address.
This is a block of Four digits
and the first three are
usually 192.168.0. After
that is a digit for each
electronic device.

STEP 2 The router typically takes the First address, so it is
usually found at 192.168.0.1. That number is reserved
For the router. Often you'll Find this number on your router marked
“web address”. The router then assigns similar IP address numbers to
the other devices you own as they are added to the network, so

192.168.0.2 might be your computer, 192.168.0.3 your smartphone and
SO on.

PiN. BIREGBSAMNA . A1
HW Ver.: A1 FAN Ver.: 100NA

SIN.
EOE I w00

n
-

MAC 1D:0022BOFOCCTA

To fFind out what number your Raspberry Pi is using
click on the Terminal icon and enter: i fconfig and
press Return. You should Find it next to “inet addr:”. The challenge is
that the router assigns this number using DHCP (Dynamic Host
Configuration Protocol). When the Raspberry Piis unplugged it

reuses the number and your Raspberry Pi may get a different number
next time.

® © FE % @ Beeaspberpi~ |

pi@raspberrypi: ~

Filo Edit Tabs Help

STEP 4 It's better all-round if you can get the Raspberry Pi to
use the same IP address every time you connect it to
the network. You do this using DHCP Reservation. This is where you
tell your router to remember the Raspberry Pi address, and only use
that address from now on. Start by opening the Chromium Browser

and entering 192.168.0.1 to connect to your router’'s web interface.
§ O 3B % O € sweribiou-on.

uls | GLA - Chetmiaam

y SuperHub |GLN =

& 1 192 V6E .00 I

{,rf‘*/‘ Super Hub

Welcome to your Virgin Media Super Hub




STEP 5 We're using a Virgin Broadband router but the
process is similar on most routers. Google the name
of your router and “DHCP Reservation” to find the router you're
looking for. Enter your admin password (our default password was
listed on the back of the router). Click Advanced Settings > DHCP
Reservation. In the DHCP Settings section you will Find all of the

devices connected to your network. Scroll down and find the one with
the same IP Address listed in Step 3.

» OCE %O € o =

Super Hub | GLI - Chromsem
§ Sisper Huby | GUI

r'&f/‘ Super Hub

DHCP Reservation

MANAGING YOUR DHCP DEVICES

| Setting Up a Static IP Address ‘

STEP 6 Select the device using the check box on the right and
scroll down to the Add Reservation section. It should
have filled in the Device Name, MAC Address and IP Address fields. If
the Device name is “unknown” change it to “raspberry-pi”. Click Add
Reservation to ensure it always uses that IP Address. Click Apply to
enforce the changes.

$ @ 3% O |E swerbion-on % T

Sumer Hub | GLI

'éf/“ Super Hub

DHCP Reservation

Now that you have set up a DHCP Reservation, you need to understand how to manage the different devices that may need to use it and

connect to the IP.

STEP 1 Now that you have set up your Raspberry Pi with a
DHCP Reservation it will always connect to the router
using that IP Address. You can check this at any time by entering:
i fconfig into terminal. The router always knows that it is your

Raspberry Pi by checking its MAC address. This is the set of six
nexadecimal numbers next to "HWaddr” in ifconfig.

s OCH O W

2

pi@mspbenypr’ ~

IF you decide to free up that IP Address so other
STEP 2 _ _ .

devices can use it, you can remove it from the router.
Open the router web interface (192.178.0.1) and click Advanced
Settings > DHCP Reservation. Scroll down to the IP Lease Table to Find

the Raspberry Pi. Select the check-box next to it and click Apply
and Yes.

$ @ %O |6 superucul-che

y Super Hub | GLUI :

Super Hub | GUI - Chromium

=

B Wi e B e P e L]

00:c o fpa 07 :dd: Od 152 188.0.4 03.0ct-2018 13,55
iFad 15 esbatdy 1921600112 03-00t-201612:34

Retamarytifhone Zhel:Ac94eab0 191168.0.13 03-0ct-2006 14:34

Lucys-Mac -Pro 00:1 o 46 48 b= 08 1521 688.0.27 03-0ct-2018 18:31
SomaslP 00: 0% 58:78: 2854 192 168.0.24 030E-2015 1 7:14
Appie S5 Ca0R: 2812 180168018 03-0ct-2006 14:35
Pyt bar LAADDY 80: 38 chk b8 580 1620 8R.0.11 03-Dct 2018 2035

SonosZB 00-0e-38:44:b4:00 19216809 03-0¢t-2016 17:13
: Q

Lucys-Phare e

@ Are you sure you wish to apply the changes?

SonosZP o0
tads
Fas pbsestrypi bR

Your Raspberry Pi will still have the same IP Address
STEP 3 o ,
but it isn’t guaranteed to keep it. Restart your
Raspberry Pi by entering: sudo shutdown -r now into a Terminal
window. When it has restarted enter: i fconfig and you'll find you still
use the same IP Address. Over time the router will use other slots for

new devices until it reaches its maximum (255 by default). Then it will
recycle disconnected devices.

Hetds M
e adadr : 1% Gt .0, 1/8 HBrast: 192 . 168 .09 ..5% i JRE FEE FES [
I BROADCAST RUNNING MULTICAST MTU:1500 Metric:
‘X kete'4/H erpore 0 .!|-|_|‘-||::i-.| ) ousrrine "D r
[X packets 6B errors:0 dropped: 9 overruns: g
1ons 0 1-|||||1.¢'|.- i 2 1000
D (40,7 KiB) TX buytes: /036 (6.H KiB)

L0 = '1F:|"" 1 |.'-ul}||l|'-- k

inet addr:1£7.0.0,.1 RMAazk:L5H5.0.0.0

" LAHIPHACK HIINNING RATUHIRYS36 FAetreic ]

{X packets:0 errors:0 dropped: 0 overruns:0 frame:0
: I ,

11 thernet Hladder /4 :da tH S H g
* BROADCAST AULTICAST HATU: 1500 HAetric:]
I acketzs !0 erro HL B ||i_||||-|n d:1l overruns 10 [Mrame Q)
rrors - ||.J'l|'|l|l"-'|'|| OUEBETTIU I CAal 18 - L)
| uEneE e - TR
' (1.2 KiB) TX byles:1044 (1.0 KiB)

STEP 4 Setting up DHCP Reservation is good practice because
it ensures you Raspberry Pi is always going to use the
same |P Address. It's also a good idea to write it down or use a label
printer to create a label for the Raspberry Pi. You will need this

number to connect to the Raspberry Pi via SSH, VPN or FPT
(techniques we will use throughout this book).

cal site:  /Users/lucyhattersley/Deskiop/
Documenis
Dowrlgads
Urogoax 2 @ Site Manager
Select Entry: T
w Advanced  Transler Sellngs  Charsel
My Sites
Host: 192.168.0.5 Hort:
Pudiic Protocol; SETP - SSH File Transfer Protoco K
<P
it
home A F Filetyp Logon Type: Norma 2 Files
Liser: pi
DS_Stoe 8,148 F
lncalired 0 Fila Password: wssssssass Ny ey
Background color. = None [ |
COmMments:
MNew Site M id
! DyTes
M RBnoxmark Rename
Direct R
Delate Duphcat
Ponnect oK
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Pi Remotely

Connecting to the

VNC (Virtual Network Computing) is a connection protocol technology that's used
to remotely control one computer from another. With VNC set up, you can use your

Raspberry Pi from your Mac or PC.

REMOTE CONTROL

The Raspberry Pi is easy to set up and use in projects around the home and, surprisingly, many of these projects don't need a keyboard,
mouse or a monitor; these are known as Headless devices. VNC lets you control a Headless Pi from another computer.

STEP 1 You will First need to ensure that your Pi is connected
to a keyboard, mouse and monitor, and is connected
to your Wi-Fi router, before you attempt to connect to it remotely.

Start by clicking on the Raspberry Pi menu, then scroll down to
Preferences > Raspberry Pi Configuration.

m
T Graphics

H-l“z Accessones

ﬁ Add / Remove Software

k- Appearance Settings
T
J2 Audio Device Settings

1 Main Menu Editor

£ Mouse and Keyboard Settings
|

e e s aT= as T ™ B alalilall a=teTala
: \dSPDEmY i LONTIQuration N
L

With the Raspberry Pi Configuration window open,
click on the Interfaces tab, and ensure that the VNC

option is Enabled. Click on the radio button next to Enabled to
activate, then click on the OK button to close the window.

=

X

Raspberry Pi Configuration -

Performance
() Enabled

Localisation
(®) Disabled

System

Camera:

SSH: (®) Enabled (O Disabled

VNC: (») Enabled ( Disabled

SPI: (_ Enabled (®) Disabled

12C: () Enabled (@ Disabled

Serial Port: ) Enabled (®) Disabled

Senal Console; ®) F

1-Wire: (_ Enabled () Disabled

Remote GPIO: _) Enabled (®) Disabled

Cancel

OK

In the upper right corner of the menu bar you'll notice
a VNCicon (next to the Bluetooth icon). This is the

built-in VNC server, click the icon in the menu bar once to open the
VNC Server window.

§ @ H %O [Viacsen

Connectivity Security

o 182.188.1.2%

CE-:‘H!‘E"F-I: UEEr1 AR omer thin aodress In YL

T Identity check

Wi prtmglig, SornSChng uies Lhi il chiek e
maRCFeng OFtae

Higivatirs
A B P 2% F o] ol Bt

Calchplarada
Lagtop mpiin Vienna Gregory tpaech e
% Authentication

‘Wripn promgied, cordeLling uwer
HC pliveord Changs padimd

i il

Make a note of the IP Address of the Raspberry Pi as
detailed in the left-hand section of the VNC Server
window; our example is 192.168.1.244. Now click on the three
horizontal lines in the top right of the VNC Server window. From the
sub-menu that appears, click on the Options entry. This will open a
new window pop-up.

VIR sy s
VNC Serve

vNcC COﬁﬁGCT by RealVNC ' Raspberry Pi Edition - Service Mode

X

_Information Center...
| Optons.. |
 About..

Disconnect VNC Viewers

Connectivity Security

Chat...

(o) |dE1“Iﬁl‘y check Flle Transfer..
. Connect to Listening VNC Viewer...

o, 192.168.1.249

Connecting users can enter this address in YNC

When prompted,

e matching details Licensing...
Check for updates...
Sign in to enable cloud connectivity or leaim more Signature
about the benefits 95-67-05-77- Bl ol YIC DRIVOY
Hide

Catchphrase

» Other ways to connect Laptop aspirin Vienna Gregory speech fire

5 Authentication

When prompled, connecting users should enter the

VNC password, Change password

Non-commercial use only. Download YNC Viewer and gel connecled.




STEPS With the Security option highlighted on the left,
ensure that the Encryption option, to the right, is set
to Prefer On, and that Authentication is VNC Password. This may ask

you to enter a password, which you will use when connecting
remotely From another computer. Enter a password you'll remember.

a =]

IWVINC .' Haspberry FI Edlion = Service Mode

VNC CONNECT

VINU Server - Uptions

Encryplion: Frefer on -

A, Users & Permissions
u:; e Aithanhicalinn | VNC passwnnd -

. heck for
& Privac

s VHNC password
# Troubleshooting lisrrs must nter & passward spacific in VNG Sarver
< Updetes
8, Printing You can manage this password on the Useis & Peimissions page.

4 Expent

miaer the

Apply Cancel

REMOTE VIEWING

! Connecting to the Pi Remotely

STEP 6 While still in the Options window, click on
Connections in the left hand pane. In the right hand
pane, ensure that the Allow Direct VNC Connections Over TCP is

ticked, and that the Port is set to 5900. It usually is, but sometimes it
can be unticked if an update to software has been applied.

VNC Server - Options .
& Security Connectivity |
|,O* Users & Pemissions v Allow direct VNC connections over TCP Port 5300
@ Privacy ~ Filter direct connections heck. for
22 Troubleshooling Action IP address/subnet
& Updates G Accept Any other IPvdAPvE address 4+
&} Printing
& Expenr +

Add rle.. | | Remove rule| | Edit rule___ |

nier the
Add rules to filter particular IP addresses, For each direct connection, the
first malching rule is applied.

— Filter connecting users
Show accept/relect prompt for each connection

Only show prompt if user account is logged on

Proxy
* Use Ine syslem proxy semngs (recommenaced)

Do not use a proxy
' Use these proxy settings:

Server

Apply Cancel

The Pi-side of things has now been set up. Just remember the Pi's IP address, and get to your PC or Mac for this next part.

STEP 1 Reboot the Pi, then disconnect the keyboard, mouse
and monitor; but keep the power connected. From
your PC or Mac, open a browser and navigate to: https://www.realvnc.

com/en/connect/download/viewer/. Choose your operating system
and click the Download VNC Viewer app.

Products w

Coimpdrmy Contact us

VNC® Connect consists of VNC® Viewer and VNC® Server

Download VNC® Viewer to the device you want to control from, below. Make sure you've inst /NC® Server on the

COMPUTer you want to control

||||||||

Download VMNC Viewos

SHA-256: ef0THIABETI2alC9a0Bac 541230 d T de 2ddSddea | edBaBc 92539948 1 b2SBBECIT

EXF sBA/ B

Follow the on-screen instruction to install VNC Viewer
STEP 2 e
on your system, when it's finished, launch the app and
choose whether you want to send anonymous data. In the main VNC

Viewer window, enter the IP Address of the Raspberry Pi; ours was
192.168.1.244. Hit Enter when you've typed in the IP address.

File View Help

Theie aie pe compubens in your addiess bouvk al presenl.
Sign in to your RealVNC account to automatically discover team computers

Alternats vely, enter the VNC Server IP address or hostname in the Search bar to connect dire cthy.

In the new pop-up window, enter the password you
created through the Raspberry Pi's VNC Server

options page. You can choose to Remember Password if you want, but
if the computer you're using is shared, you can always opt to leave the
option unticked. Click OK when ready.

_.

Authenticate to VNC Server
& 192,168.1.244::5900 (TCP)

Enter VNC Server credentials
(Hint: NOT your RealVNC account details)

Password:

LA AL AL L L &

Remember password

Forgot password?

Catchphrase: Laptop aspirin Vienna. Gregory speech fire.

Signature:  9a-67-c5-77-8d-1c-0d-d5

OK Cancel

STEP 4 You may be asked to confirm connection to a remote
computer, click Continue to make the connection. You

are now connected remotely to your Raspberry Pi. As long as the Pi is
powered up, and has access to the Wi-Fi signal of the router, then you

can place it anywhere and get access without using a mouse,
keyboard, or monitor.

[}
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Using APT to Install
and Remove Programs

ADVANCED PACKAGING TOOL

Add / Remove Software is great for finding and installing software but most of the time you manage apps on a Raspberry Pi using a program
called APT (Advanced Packaging Tool) using the apt command.

STEP 1 To manage the apps on your Raspberry Pi you'll need STEP 3 The command used to add new software to your

to use a tool included with Raspbian called APT Raspberry Piis apt install followed by the name
(Advanced Packaging Tool). APT is a command line tool soyou needto  of the package you want. However, because apt adds (or removes)

either start your Raspberry Pi in the command line or click on the Files outside of your home directory you need to preface apt with the
Terminal icon. word sudo. Almost all of the time you will need to type sudo apt
® @ =M % O Mrossoenpi- when using this tool.
\Uig » |

o e e
= ey D Tl ey, b - b
Rl
L e W W T T R e
=] & =117 | ans [
W LA L | ' e ] ws | ¥
=
. _— -
il L W
L]

“

STEP 2 The command used to control packages in Raspbian is STEP 4 Beginning a command with “sudo” runs the command

apt Type apt into the terminal and press Return to as a super user, “super”’ meaning the one above your
get a description of what the app does. The instructions tell us that Pi account, rather than one with super-hero properties. However, if it
the “most frequently used commands are update and install”. You may  helps you to think of it that way that's fine. So to install a new program
also hear about “apt-get” which is an older version of the same tool.It  youtype: sudo apt install followed by the name of the app

works in much the same way. you want.

pi@raspbenyp't: ~
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\ Using APT to Install and Remove Programs %

STEP 5 You're going to install a chess game called
Dreamchess. Enter: sudo apt install
dreamchess and press Return. Descriptive text will run up the screen.
You may see “Do you want to continue [Y/n]?” Enter: v and press

Return to install the application. You'll find it by choosing:
Menu > Games > Dreamchess.

& C* @ E ”’ @ Epi@raspberrypi:m

STEP 6 You can use apt-cache to search for apps you can
¥ install and remove. Enter: apt-cache pkgnames to
view all the packages available. Typing apt-cache pkgnames |
less enables you to view a page at a time (press any key to scroll).

You can use apt-cache search to find packages, enter: apt-cache
search pong to view a list of Pong games you can install.

& © FHEA & O BWri@raspbemypi ~

MORE APT COMMANDS

The apt command is also used to list, and delete, any apps you have installed.

STEP 1 Sometimes you will try to install an app only to get an
error that the File cannot be found. In this case you
need to update apt so it has the latest links. Enter: sudo apt
update. This doesn't update the apps you've installed, it just gets a
newer listing of apps. To update your apps to the latest versions enter:

sudo apt upgrade. You'll often find both commands rolled into
one: sudo apt update && sudo apt upgrade.

& @ @ E )j @ Epi@raspberrypi:ru |

To view the packages you've installed you use a

different command called dpkg. Enter: dpkg
--get-selections | grep -v deinstall toview all of the
packages on your Raspberry Pi. Place | less after it to view one
page at a time. Or dpkg --get-selections | grep -v

deinstall > ~/Desktop/packages.txt to save the list asa
text File on your desktop.

‘. 1@ @ E i} @ ‘Epi@rasgberrypr:w i

File Edit Tabs Help

STEP 3 Packages are uninstalled from your Raspberry Pi
using the remove command. Enter: sudo apt
remove dreamchess to start deleting the chess game that you

installed. An alert saying “Do you want to continue [Y/n]?| appears,
enter: y and press Return to delete the program.

‘ C} rfj_:“] ’} @ Epi@raspberrypizw

le Edit Tabs Help
(8 : L sudo apt remove dreamchess

Uninstalled packages using apt doesn’t remove all
of the files. Some are left in case you decide to
reinstall the program later. To completely remove a package from
your Raspberry Pi use the purge command. Enter: sudo apt
purge dreamchess toremove all of the supporting Files. You

can also use sudo apt clean to tidy up your packages and free
up some drive space.

Y D @ )} @ Epi@mspbarrypi:~

File Edit Tabs Help
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Get More from the
Terminal App

CUSTOM TERMINAL

The Terminal, or command line, is a powerful environment for accessing the system. Careful, here be dragons.

STEP 1 Start Terminal by clicking the Terminal icon in the STEP 3 Naming tabs makes them much easier to recognise.
Application Launch Bar. You can also start Terminal ' Choose Tabs > Name Tab and enter a name for the tab

by pressing Control-Alt-T or choosing Menu > Accessories > such as “Home" or “Downloads”. Click OK to set the name. You can
Terminal. Terminal emulates the old style video terminals from quickly switch between tabs using Control-Page Up and Control-Page
before desktop interfaces; so by default it displays bright (mostly Down and rearrange them using the Tabs Move Tab Left / Move Tab
green) on a black background. Right options.

File Eait

pi@raspberr..

STEP 2 The first thing most people overlook is the ability STEP 4 Choose Edit > Preferences to personalise the look and
¥ torun multiple terminals at once in different tabs. feel of LXTerminal. One of the best tricks is to click

Choose File > New Tab (Shift-Control-T) to create a new tab. Background and drag the Opacity slider to the half~way point. This
Navigating multiple directories simultaneously can be a challenge  enables you to view through the terminal background and see the
in Terminal and tabs makes it that much easier. windows below. You can also personalise the colour of the background.

File Edit =

T .
Style | Display | Advanced | Shortcuts

File Edit Tabs Help : e .
= LRAlL ata = lawras b? — v 1
<3 iz L Terminal Font Vionospace U
Shitt+Ctri+N ni@rasopbe
Background ST
Foreground

Allow bold font &

] = S 4
Cursor Blinks
& 5 Nk
Cursor style

Underline
Audiblepde

42  www.bdmpublications.com



STEP 5 While still in Preferences click the Display tab. Here you
can adjust the Tab panel positions, placing them on the
Left makes them more prominent. You can also adjust the scroll-back

line count. This is the number of lines you can scroll up with using the
mouse, not the history accessed by the Up and Down arrows.

w

Hie Eait i 11 .
Style | Display: | Advanced | Shortcuts

T-\- S il B aTalslbaglal s T i
12D pahnel positol op v

pi@raspbe

C ] .-.-\. # F s I &
Scroll-back hines: | 11
Hide scroll bar
A Hide menu bar
Hide Close button

Hide mouse pointer

I S—
CONNECT USING SSH

Use a different computer to control your Raspberry Pi.

STEP 1 If you have your Raspberry Pi on the same network
as a Mac or Linux-based computer, you can control it
using the Terminal program on that computer. We're going to use

Terminal in macOS here but the process is the same on a Linux
machine. Open the Terminal app on your computer.

® Terminal Shell Edit View Window Help

® D Lucy — pi@raspberrypi: ~ — bash — B0x24

Enter: i fconfig into the Terminal app on your
Raspberry Pi. This will let you know which IP address
it is using. Look for the four blocks of digits following “inet addr:'.
They should begin with 192.168.0 followed by a three-digit number.
Ours is 192.168.0.179. You need to use that number in Terminal on

your Mac to connect.

\ Get More from the Terminal App %

STEP 6 If you prefer a more minimalist approach try moving the
¥ Tabs to the bottom and selecting the Hide scroll bar,
Hide menu bar and Hide Close button options. When combined with a

low opacity background this makes for a subtle terminal window. You
can still access menu settings using a right-click on the mouse.

Switch back to Terminal on your Mac or Linux

machine and enter: ssh piR192.168.0.178
(using your own IP address). The “pi” bit is the name of the default
user account, so if you have changed that it needs to match your
user account on the Raspberry Pi. You'll be asked for a password.
This is the password that you use to log in to the Raspberry Pi (not
your Mac or Linux computer).

@ Terminal Shell Edit View Window Help 3

Lucy — pi@raspberrypi: ~ — ssh — 80x24

. @

You are now logged in to your Raspberry Pi and
can enter commands directly into the Terminal on
your Mac or Linux computer. Unlike remote networking you
don’'t see the commands being entered on the screen of the
Raspberry Pi, you are accessing the computer from behind the
scenes. Many people prefer to set up the Raspberry Pi so they
can control it from a more powerful computer. Enter: exit to

close the connection.

® Terminal Shell Edit View Window Help

- @ Lucy — pi@raspbarrypi: ~ — 88h — BlxZ4
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Using the File Manager

Because you'll be creating programs on your Raspberry Pi, you'll need to know more about

the file system than you would on other computers. One vital tool to become familiar with is
the File Manager. This is used to find, move and remove files from your Raspberry Pi.

VIEWING AND MOVING FILES

You can move, manage and delete Files using the Command Line but like all modern operating systems Raspbian has a program to help you

manage your files. Discover how to use the File Manager app.
Raspbian includes a great file management program
STEP 1 =+ n . = "
called “File Manager PCManFM" or just “File Manager

for short. Click on the FileManager PCManFM icon in the Launch Bar or
choose Menu > Accessories > File Manager.

®OEHXEOQ ]
. Programming »
»

——

\ . M-Accessones : SR File Edit View Bookmarks Go Tools Help
m Sound & Vigeo » u Calculator - -h EI | home/pi
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+ [ Templates
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# 3/

11 items (25 hidden)

STEP 2 File Manager displays the folders in your Home Folder
(this should match your user name, ‘Pi’ by default). By
default you should have Desktop, Documents, Downloads, Music,
Pictures, Public, python_games, Scratch and folders. Double-click any
folder to open it and view its contents. Click the Parent Folder icon or
press Alt-Up Arrow to head back up.
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10 itemns (25 hidden) Free space. 1.6 GiB (Total. 6.0 GiB)

In the left-hand part of the File Manager sits the Side
Pane. By default this displays the Directory Tree,

which is another way of navigating the folders on your hard drive.
Alternatively click the Side Pane menu and choose Places. Now the
Side Pane displays common locations such as Home Folder, Desktop,
Rubbish Bin (also known as the Wastebasket), Applications and your

SD Card.
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STEP 4 You can create a new folder in the current location by
choosing File > Create New > Folder or press
Shift-Control-N. Enter a name for the folder and click OK. Files and
folders can be dragged on top of one another to move them around.

You can also drag files to the folders in the Side Pane, which is an easy
way to move them back up the folder tree.

——

—

_u-.

File Edit View Bookmarks Go lools Heip

fo w 0= I‘ﬂifhﬂlmﬂ'}'pl

g B (& (v] (a]

Desktop Documents Downloads Music

Directory Tree @ @

Pictures Public

* (=) Desklop

« [@ Documents ‘ ‘ ‘ =
* @ Downloads python_gam Scratch  Templates  Videos
Music By
+ [ Pictures
+ @ Public Fnter a name for the newly created folder
* (1 python_games
Programs
v O Scratch
- @& Templates Cancel 0K

<MNo sublolders>
+ @ Videos
« [/

10 items (25 hidden) Free space’ 1 6 (i (Total' 6.0 GiIB)




Double-click a file in File Manager to open it with the
STEP5 R .
default app. You can also right-click a file to view
compatible applications in Raspbian. Pick an application from the list
provided to openit. Click Properties and use the Open with menu to
automatically open that type of file with that app in future.

o * ol
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“testfile’ (0 bytes) plain text document Free space. 1.6 GiB (Total 6.0 GiB)

ADVANCED FILE MANAGER TRICKS

These handy tricks and tips make File Manager more powerful.

As you start to move Ffiles around you will find

navigating between the same folders tiresome. It is
possible to open locations in File Manager as tabs, so you can quickly
jump back and forth. Click the Create new tab for this Folder icon, just
below the File menu, and the current folder opens as a tab. Click the
tabs to jump between locations.

= [# Documents
+ [ BlueJ Projects
¢ ) Greenfoot Projects
» O Scratch Projects
¢ O Wolfram Mathematica
§ * ®Downloads
¢ (@ Music

<No subfolders>
+ O Programs
+ @8 Public
' O python_games
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To view the properties of a File right-click and choose

Properties. Here you can view information about the
File Type and the Open With application. More importantly, if you
click Permissions you can view the permissions associated with that
file. The concept of file permissions, especially the ‘Execute’ setting,
becomes increasingly important as you become more advanced in
using your Raspberry Pi.

+ [ Desktop
Documents
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+ [ Wolfram Mathematica
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+ (@ Music
- [ Pictures
«No subfolders
+ (J Programs
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View content: Anyone
Change content:  Only owner

Execute: Nobody

i Using File the Manager

Drag items you no longer want to the Wastebasket
STEP 6 o

to delete them or right-click and choose Move to
Trash. To empty the wastebasket and permanently delete the
unwanted files double click Wastebasket to open it. Now right-click

the black space in File Manager and choose Empty Rubbish Bin. Click
Yes in the alert window and the files will be removed.
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It's worth taking time to explore the View menu in File

Manager. Here you'll Find a Show Hidden option, which
enables you to view hidden files, as well as Sort Files. You can also
adjust the Folder View Mode as well as Toolbar, Path Bar, Side Pane
and Status Bar.
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There are times when you will want to move files but

find you can't because you don't have root (sudo)
access in File Manager. If you want to open File Manager with root
mode choose Menu > Run and enter: gksu pcmanfm. File Manager
will open and display root and boot() folders. Be careful when running
File Manager in root mode, and close it when you are finished.
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Edit Images with GIMP

The name may be funny, but this image editing app is incredibly serious. The Raspberry Pi is

perfectly adept at photo editing, and you can use GIMP to create icons, images and works of
art for your programs.

GET TO KNOW GIMP

Your Raspberry Pi can display images with its built-in Image View app but for any image editing you'll need GIMP (GNU Image Manipulation
Program). GIMP is a powerful software package for photo editing and is a great tool to install on your Raspberry Pi.

STEP 1 Openterminal and enter: sudo apt install gimp  Fy=ule! Images can be opened in GIMP using File > Open or by
to download and install the CIMP package. An alert right-clicking on files in File Manager and choosing

will appear saying: “after this operation, 117 MB of additional disk GNU Image Manipulation Program. You can open multiple images at
space will be used. Do you want to continue [Y/n]?" Enter: v and press once in GIMP but each opens inside a different window. Choose
Return. GIMP will now be installed in Raspbian. GIMP is a lot larger Window > Single Window Mode to gather them together. Click on the
than most programs you'll install, so the installation takes longer. rabs at the top of the screen to switch from one image to another.

ey
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When the installation has completed you will find You can perform powerful edits in GIMP but we

GIMP under Menu > Graphics > GNU Image don’t have space to go over them all. Probably the
Manipulation Program. It has a more detailed interface than many most useful you'll find is Colours > Levels. This window enables you
Linux programs with two boxes, Tool Options and Brushes offering a to adjust the tonal range and colour balance of an image. Drag the
range of image editing options. Users of software like Adobe left and right handles in slightly and slide the centre handle to the
Photoshop will feel right at home and it’s ideal for image editing. right to improve the contrast of an image.
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STEP S To crop an image click the Rectangle Select Tool and
drag a square on the image. Choose Image > Crop
To Selection to remove the unwanted parts of the image. Use the
Image > Scale Image and Image > Canvas Size options to adjust the

image to specific sizes. Cropping and resizing images is a vital
technique to know when working on websites.
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EXPORTING IMAGES

Save your images for use in a website.

STEP 1

Images are saved using File > Save As in the xcf format
(Experimental Computing Facility). This is GIMP’s
native format so should only be used to save files you want to view
and work on in GIMP.
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IF you want to save files for use in projects, such as

websites, use File > Export. Click the File Type option
and choose a file type; typically you will use JPEG for web images.
Choose a Name and location and click Export.
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! Edit Images with GIMP

STEP 6 There are a huge range of image effects and filters
you can add to images using GIMP. Far more than

we have room to cover here. Try Filters > Artistic > Cartoon to give

your image a black outline or Filters > Artistic > Oilify to simulate a

painted artwork. Take a look at www.gimp.org/tutorials for
creative inspiration.
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STEP 3 The Export Image as JPEG window appears, displaying
a Quality slider. The Quality range is from 0 (very

poor) to 100 (perfect). While you might be tempted to set the quality
at 100, reducing it slightly will create much smaller Files. Smaller Files
ensure that your web page loads much more quickly. You can typically
reduce the Quality to 80 and get a much smaller File with little
discernible difference.
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: export |..as JPEG - x ;
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File size: unknown
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¥ S R

_I Show preview in image window

+ Advanced Options

Load Defaults | Save Defaults

Help Cancel Export

Right-click a JPEG image in the File Manager and
choose Open With. Expand Internet and choose
Chromium Web Browser and OK. This enables you to see how it will
appear when you add it to your website. You can also view images
more quickly by right clicking and choosing Image Viewer. You can use
Save File As in Image Viewer to quickly change the image format.
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iViore Apps

While installing apps, or rather packages, is perfectly fine through the Terminal and the Apt
command, there is an easier, graphical way. For most users, the Add/Remove software
feature is better than the command line and here’'s how it works.

ADD/REMOVE

You can use the Add/Remove Software feature both on the Pi version of Raspbian as well as the Raspberry Pi Desktop version —whether it's

installed on a PC orin a virtual machine.

Begin by powering up Raspbian and getting to the

desktop. From the menu, select Preferences > Add/
Remove Software. This will open a new window with various
categories down the side of the screen.
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These categories down the side of the Add/
Remove Software window denote the type of

software package through which you want to search. For example,

click on the Games category, then scroll down the list of available

packages and tick the box next to ‘Side-scrolling game named
Abe’s Amazing Adventure'.
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STEP 3 Now click on the OK button, located to the bottom
right of the Add/Remove Software window. This will
begin the installation of the selected package — note, it'll also

auto-select any other required packages in order to make the
software work.
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Once the packages have been installed, you can find

the software within the Pi Menu items. In this case,
Abe’'s Amazing Adventure is in the Games section of the menu. Click
on the icon for the game, and it'll load. To remove the newly

installed software, simply re-open Add/Remove Software, un-tick
the box and click OK again.




Learning
LINUX

In this section you will discover how the
OS works, how the filesystem is built,
and how you can list, move, create and
delete files and folders. To truly be able
to hack and master the Raspberry Pi,
you will need to be familiar with the OS
and its inner workings.

 Learning Linux INDEX o
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What is Linux?

The Raspberry Pi operating system is Raspbian, which is a Linux operating system; but what
exactly is Linux? Where did it come from and what does it do? In a world where Windows

and macOS have supremacy of the desktop, it's easy to overlook it, but there's more to Linux
than you might imagine.

50

Linux is a surprisingly powerful, fast, secure and capable
operating system. It's used as the OS of choice for the
Raspberry Pi, in the form of Raspbian OS, as well as in some
of the most unlikely places.

Despite only enjoying a 1.96% share (according to
netmarketshare.com) of the total desktop operating system
market, Linux has a dedicated following of enthusiasts,
users and contributors. It was created in 1991 by University
of Helsinki student, Linus Torvalds, who had become
Frustrated with the limitations and licensing of the popular
educational system Minix, a miniature version of the Unix
operating system, in use at the time.

Jnix itself was released in the early ‘70s, as a multi-tasking,
modular-designed operating system originally developed
"or programmers who needed a stable platform to code
on. However, its performance, power and portability meant

BOOTLOADER

The bootloader is the software that initialises and boots
up your computer. It loads up the various modules the OS
uses to begin to access the hardware in the system.

KERNEL

The kernel is the core of the system and the single
element that is actually called Linux. The Linux kernel
manages the computer processor, memory, storage and
any peripherals you have attached to your computer.

DAEMONS

Daemons are background services that start as the
operating system is booting. These can enable printing,
sound, networking and so on.

GRAPHICAL SERVER

This is @ module within Linux that provides a graphical
output to your monitor. It's referred to as the X server or
simply X.

www.bdmpublications.com

that it soon became the system of choice for companies
and universities where high-end computing tasks
were needed.

Torvalds needed a system that could mirror Unix'’s
performance and features, without the licensing cost. Thus
was born Linux, the Unix-like operating system which used
freely available code from the GNU project. This enabled
users around the world to utilise the power of the Unix-like
system, completely free of charge, an ethos that still holds
today: Linux is free to download, install and use.

Linux is much like any other operating system, such as
Windows or macOS in that it manages the computer
hardware, provides an interface for the user to access

that hardware and comes with programs for productivity,
communications, gaming, science, education and more. Linux
can be broken up into a number of significant elements:

SHELL

The Linux shell isa command line interface environment,
which a Linux user can use to enter commands to the OS
that directly affect it. Within the shell you can add new
users, reboot the system, create and delete files and
folders plus much more. BASH (Bourne-Again Shell) is
the most popular shell used in Linux, although others are
available. The shell is also known as the Terminal and it’s
where we're going to work from through this section of

the book.

DESKTOP ENVIRONMENT

The Desktop Environment, or DE, is the main Graphical
User Interface (GUI) that users interact with. It's the
desktop and includes Internet browsers, productivity,
games and whatever program or app you're using. There
are countless DEs available, however Raspbian uses PIXEL.

PROGRAMS/APPLICATIONS

As Linux is a free, open source operating system, it

also makes good use of the tens of thousands of freely
available applications. The likes of LibreOffice, GIMP and
Python are just the tip of the iceberg.
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Linus Torvalds, the creator
of the Linux kernel.

Linux is used throughout the world, in a number of basic and
quite unique uses. While it may look radically different from one
environment to the next, the actual Linux kernel, can be found
in modern smart TVs, in-car entertainment systems and GPS,
supercomputers, loT devices and the Raspberry Pi. It's used by
NASA, both in the command centre and on-board the ISS. Linux
servers power the backbone of the Internet, along with most
of the websites you visit daily. Android utilises components
of the Linux kernel, as do set top boxes, games consoles and
even your fridge, freezer, oven and washing machine.

_ Linux isn't just a free to use operating system. It's stable, powerful and

Tux, thl‘?k'—'“ux mascot fast, easily customised and requires very little maintenance. However, it's

LinUs likas penguins). more than just performance stats; Linux means freedom from the walled
garden approach of other operating systems. It's a lively community of
like-minded individuals who want more from their computers without the
shackles of price or conformity. Linux means choice.

Raspbian on the
Raspberry Pij, is the
Linux distribution
of choice.

A Desktop Environment can be as
complex or as simple as the user desires.
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Using the Filesystem

To master Linux, it's important to understand how the filesystem works. What's more,

it's also important to become familiar with the Terminal, or shell. This command line
environment may appear daunting at first, but with practise, it soon becomes easy to use.

GETTING AROUND

To drop into the Terminal, click on the fourth icon from the left along the top of the Raspberry Pi desktop, the one with a right-facing arrow
and an underscore. This is the shell, or Terminal.

First, you're going to look at directories and the Enter: 1s to view the contents of the current
STEP 1 _ _ . . STEP 3 .
directory path. A directory is the same thing as a directory. You should see Desktop, Documents, and

folder, however in Linux it's always called a directory. These are Downloads and Scratch in Blue. You may also see other items

placed inside each other using a “/" character. So when you see / depending on how much you have used your Raspberry Pi. The colour
home/pi it means the pi directory is inside the home directory. code is worth knowing: directories are blue while most files are white.
Enter: clear and press return to clean the screen. Now enter: pwd.  Asyou go on you'll see other colours: executable files (programs) are
This stands for Print Working Directory and displays /home/pi. bright green, archived files are red and so on. Blue and white are the

two you need to know to get started.

L i "-"1“--':--‘.;I]'h‘:;"|" JL i
/home/p1l
pil@raspberrupl

pi@raspberrypi

STEP 2 When you log in to your Raspberry Pi, you don’t STEP 4 Now you're going to move from the pi directory into
start at the base of the hard drive, known as the the Documents directory. Enter: cd Documents.
‘root’ (also known as the topmost directory). Instead you begin Note the capital “D". Linux is case sensitive, which means you have to
inside your user directory, which is named ‘pi’ by default and is enter the exact name including correct capitalisation. The cd
itself in a directory called ‘home’. Directories are indicated by the /'  command stands for change directory. Now enter: pwd again to view
symbol. So, “/home/pi’” tells you that in the root is a directory the directory path. It will display /home/pi/ Documents. Enter: 1s to

called home, and the next “/"" says that inside “home” is a directory  view the files inside the Documents directory.
called “pi”. That's where you start.

[ 1 @ "as llh';l"r' L i ]lll.ll‘"'.
/home/pi

P I "‘I"-‘:~'1Ii‘-'fl“i“'I}I 1 shomespisDocuments
= i@ ',‘-"ll'i':l"F' l'li s
CryptolOl.pdf dog_jump euro fizzbang backup.py fi1zzbang.py

—_—
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How do you get back up to the pi directory? By using The “Is” and “cd” commands can also be used with
STEP5S 2 e o STEP6
a command “cd..”. In Linux two dots means the more complex paths. Enter: 1s Documents/

directory above, also known as the parent directory. Incidentally, a Pictures to view the contents of a Pictures directory inside your
single dot “." is used for the same directory. You never use “cd.” to Documents directory. You can switch to this directory using cd
switch to the same directory but it's worth knowing because some Documents/Pictures;usecd ../..tomove back uptwo
commands need you to specify the current directory. parent directories.

plPraspberrypl ls Documents/Pictures

1 Areacnbe e e i 2 4 = . - " - : "
pi@raspberryp] pi@raspberrypi cd Documents/Pictures

shome/pisDocuments

pilPraspberrypil pud
shome/pisDocuments/Pictures
piPraspberrypi Bl aadas

pi@raspberruypi
pilPraspberrypl pud
shome/pi

_ _ pi@Praspberrypi pud
pliPras |II'I‘.'I‘I‘ Ip i

shomne/pi
pi@raspberrypi

ABSOLUTE VS RELATIVE PATHS

It is important to know the difference between the working directory, root directory and home. There are also two types of path: Absolute
and Relative. These are easier to understand than they sound. Let’s take a look...

STEP 1 By default, commands like “ls” use the working m The second command (“ls /Documents/Pictures”)
directory. This is the current directory that you're attempts to list the content of Pictures in a directory
looking at and is set to your home directory by default (/users/pi). called Documents inside the root directory (because the path started
Using “pwd” (Print Working Directory) lets you know what the working  with '/', which is root). There is typically no Documents directory in
directory is, and using “cd” changes the working directory. root, so you will get a “No such File or directory” error. Starting a path

with /" is known as an “absolute path”, while starting without the /' is
known as a “relative path” because it is relative to your
working directory.

1 i'r‘lfn'_j- !lh’;r'r' JL | ].'II.;.H.'.I
/home/pl
pl@raspberruypl

piPraspberrupi 1S /

pi@raspberrypl s /Documents/FPictures
1s:! canmmot access ZDocuments/FPictures: No such fi1le or directory
pil@raspberrypl

STEP 2 The root directory is always ‘/'. Entering: 1s / lists the m There is also an absolute path shortcut to your user
contents of root, and entering: cd / switches to the directory, and that is the tilde “~" character. Entering:

root directory. This is important because there is a difference between 1s ~ always lists the contents of your home directory, while “cd ~"

“ls Documents/Pictures” and “ls /Documents/Pictures”. The first moves straight to your home directory, no matter what your working
command lists the contents of the Pictures directory in Documents directory is. You can also use this shortcut wherever you are: enter: 1s
inside the working directory (which, if you are in the home directory, ~/Documents/Pictures to display the contents of the Pictures.

will work).
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Listing and Moving Files

Admittedly, using the desktop GUI to list and move files is much easier than using the
Terminal and keyboard. However, it's an important skill that you will appreciate as you
advance with the Raspberry Pi and Linux.

LOOKING AT FILES

Operating systems are built on files and folders, or directories if you prefer. While you're used to viewing your own files, most operating
systems keep other Files out of sight. In Raspbian, you have access to every file in the system.

We've already looked at “Is”, which lists the files in After the permission letters come a single number.

the working directory, but you are more likely to use This is the number of files in the item. If it's a File then
a command like “ls -l". The bit after the command (the *-lah’) is it'll be 1, butifit's a directory it'll be at least 2. This is because each
known as the argument. This is an option that modifies the directory contains two hidden files; one with a single dot (.) and one

behaviour of the command. with two dots (..). Directories containing files or other directories will
have a higher number.

L 1Pras !lh‘.‘r'[' Illi'

!ri'-"r'f':-:;:I‘r:r-r* !}li s 1
total 24
ruw-r--r 1 pi U May 11 £0:5b articles.txt
druxr=xr-=x 4 pil 4096 Apr £1 1755
druxr=xr=x H pl 4096 Apr £1 14:50
drwx & pi 4096 Apr 21 15:£3
druxr-xr-x 3 pi 4096 Apr 1/ 18:486
ry—-r——ror P i 0 May 11 20:5b6
Aruxruxr-x & pil 1096 Jan 1 1970
druxr-xr-x < pi 1096 Apr 17 1£2:53
piPraspberrypi

The “-" argument lists files and directories in long Next you'll see the word “pi” listed twice on each
format. Each file and directory is now on a single line, line. This refers to the user rather than the name of
and before each file is a lot of text. First you'll see lots of letters and your computer (your default username is “pi”). The first is the owner
dashes, like ‘drwxr-xr-x’. Don’t worry about these for now; they are of the File, and the second is the group. Typically these will both be
known as ‘permissions’ and we'll come to those later. the same and you'll see either ‘pi’ or ‘root’. You can enter:1s -1 /
to view the Files and directories in the root directory that belong to
the root account.

piPraspberrupi T =]
total Z£o
ru-r--r 1 p1 pi May 11 Z0:56 articles. tx
Aruxr=xr-=x < pi pi1 * Apr £1 17:50
druxr-xr-x 5 pi pi * Apr 21 14:50
drwx s piopl e Apr 21 15:23
druxr-xr-x 3 pi pi Apr 17 18:48
ru—r—r pl1 pl May 11 20:56 names.txt
druxruxr-x < pl pil Jan 1 1970
druxr-xr-x < pi pil “ Apr 17 1£:53
druxr-xr-x 3 pi1 pi1 “* May 11 £1:15
piPraspberrypi S |
total 74
AruwxXr—xr—x /. root root 4096 1970
druxr—=xr—x root root Z048 1970
Adruxr—-xr—x . root root 3200 0 I 0 06
drwxr—xr—x root root 4096 09:03
druxr-=xr-: 4 root root 4096 1970
druxr—=xr-x 2 root root 4096 1970
drwx 2 root root 16384 5 11:21
druxr—-xr—x 3 root root 4096 07 :4/

piPraspberrupi
total <4

rw-r--r 1 pi | U May 11 20:5b articles.txt
druxr=xr-=x < pi 1090 Apr 21 1/7:55
Aruxr=xr=x o pl 4096 Apr 21 14:50
Arwx s pl 4096 Apr 21 1523
druxr-xr—-x 3 pi 4096 Apr 1/ 18:40

ru—r—rur 1 pl 0 May 11 Z20:56 names.txt
druxruxr-x < pl 4096 Jan 1 1970
Aruxr-=xr-x & pil 1096 Apr 17 12:53
plPraspberrypi

Aruxr—=xr—Xx s root root 4096 0100 0 M
Aruwxr—xr-—x root root 4090 1970
Ar—xr—xr-x root root © . 1970
drwx 9 root root 1096 U736
Aruxr=xr-x root root 460 Y03
Aruxr=xr—-x 2 root root 4096 | 1970
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The next number relates to the size of the file, in bytes.
In Linux each text file is made up of letters and each
letter takes up a byte, so our names.txt file has 37 bytes and 37

characters in the document. Files and directories can be extremely
large and hard to determine, so use “ls—h". The “h" argument
humanises the number, making it easier to read.

piPraspberrupi
total o<
ru-r--r L pl
druxr-xr-x < pi
druxr-xr D pi
Arwx Z Pl
druxr-xr-x 3 pi 17 18:48
ru-r—r 1 pi ' 11 21: 27
druxruxr-x & pl ‘ 1970
druxr-xr-x < pl . ¢ 12:53
druxr-xr-x 3 pi ‘ &1:19
D i'ﬂiu_...I“].‘r.r.-TI]i
total JzK
ru-r--r 1 pi 20:56 articles.txt
Aruxr—-xr-x < |Ii - Z. 17:95
druxr-xr-x o pl 1. 1 14:50
Aruwx & pl % . Z1l 1923
druxr-xr-x J pi 1. ¢ 1810
rW=r-=- 1 pl ( 147 names . txi

SOME COMMON DIRECTORIES

/

- Listing and Moving Files Z

Finally, you should be aware that there are many
hidden Files in Linux. These are listed using the “-a"
argument. Hidden files and directories begin with a dot (.), so you

should never start a File or directory with a dot, unless you want to
hide it. Typically, you can combine all three arguments together into
the command "'s —lah".

piPraspberruypi 1S
total HZUK

druxr-xr-x 33 pi p1i
druxr-xr-x J root root
dAruwx & Pl p i

1 pi P articles.txt

1 pi pi . .bash_history
1 pi p1 l. ! 4:00 .bash_ logout
|

ru-r—-r
on
U ————
"w=I" |
druxr-xr-x 10 pi Pl
druxr-=xr-x 20 pi pi
Arux Pl pi
Aruxr-xr-: Z pi pi
P ——— P —— pi pi
drwxr—-xr - pl

p1 pl & A 14: .bashrc

Arwx i p1
Aruxr—xr—>x Z pl
APURP—XP—% 7 pi
Aruxr=xr-x 2 pi

Now that you know how to view the contents of your hard drive you'll start to notice a lot of directories with names like bin, sbin, var and
dev. These are the Files and directories that you are kept away from on a Mac, and won't encounter on a Windows PC.

Enter:1s -1ah /toview all of the files and
STEP 1 . o . . . :
directories, including the hidden items, in the root
directory of your hard drive. Here you will see all the items that make

up your Raspbian OS (which is a version of Linux). It's worth taking the
time to know some of them.

plPraspberrupl s —lah ~
total BZK

druxr-xr-x 2 root root 4.0k May 11 Z21:23
druxr-xr-x 22 root root 4.0K May 11 Z21:23
Aruxr=xr-x 2z root root 4.0 Jan 1 1970
Adruxr—xr—x 34 root root Z2.0K Jan 1 1970
druxr-xr-x 12 root root 3.3K May 11 09:03
druxr-xr-x 109 root root 4.0K May 11 09:03
Aruxr—xr-x 3 root root 4.0k Jan 1 19570
druxr—xr—x 12 root root 4.0K Jan 1 1970
drwx Zz root root 1bK Feb 15 11:21
Arwuxr—=xr—x } root root 4.0K May 11 07:42
Aruxr—=xr—x Z root root 4.0K Jan 11 0002
druxr—xr—x 6 root root 4.0 Jan 1 1970
dr—xr—xr—-x obH root root 0 Jan 1 1970
drwx 9 root root 4.0K May 11 07:36
druxr-xr-x 10 root root 460 May 11 09:03
druxr-xi s root root 4.0 Jan 1 1970
druxr-=xr-x 2 root root 4.0K Jun 20 2012
druxr—-xr-x 2z root root 4.0K Feb 15 11:23
dr—xx r-x 12 root root 0 Mauy 11 21:00
A s ey v 4 oot root 4 (K Mawg 11 71 ° 144

STEP 2 Bin is a directory that stores binaries. This is the Linux
way of saying programs or applications. Sbin is for
system binaries, which are the programs that make up your system.

Dev contains references to your devices: hard drive, keyboard, mouse
and so on. Etc contains your system configuration Files.

pllPraspberrupl s Zb1n

bash [JEZ;‘;'I'EEIJ shagrp dash dOoma 1nname flé console
bunzip i'.i-'_"l"'!l ~hmod o ' '._--“l'f. ' e qrep

| - Il,II,'-: _]ll'll A .ii.l “-ilr'- lll..
bzcmp bz ipdrecover chu

bzdiff bz less onczfbmap dir egrep fusermount
bzegrep bzmore 1 dmesq False gqrep

| cplo Ansdoma i nname hset aqunzip

pl@raspberrypl

Entering: 1s /home displays the contents of your
home directory, which contains pi; the directory
that you start in. So, entering: 1s/home /p1i is the same as just “ls”
from the default home directory. This is where you are expected
to place most of the documents you create. Don’t confuse home

with “usr”; the /usr directory is where find you find program tools
and libraries.

.rli."l"":'-'li'l','l"l" Illi l"1

articles. txt nanes .txt
pi@raspberrupi ls 7home/pi

articles. txt names ., txit
pilPraspberrupi

Lib is a directory that contains libraries of code that
STEP4 :
are referred to by other programs (different programs
share Files in Lib). “Var” is short for various, which is mostly files used
by the system, but you may need to work with items here. Finally there
is a directory called “tmp”, which is for temporary Files; files placed

here are on your system for the short term and can be deleted from
the system.

plFraspberrupl s svar
locK run swap

pliErasnnerruanld
L i s
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Creating and Deleting Files

Being able to create and delete a file is an everyday computing skill. However, when using the
Linux Terminal, there's an element of care required, chiefly because any deleted files aren't
placed in the system recycle bin.

CREATING FILES

Once you learn to recognise the fFiles and directories that make up Raspbian OS, it's time to discover how to make your own. Knowing how to
make, edit and delete files and directories is essential if you want to make your own projects.

We're going to create a file using a command called IF you try to touch a File that doesn't exist, you create a
Touch. Touch is an interesting command that reaches blank file with that name. Try it now. Type touch
out to a File, or directory, and updates it (this changes the system time  testfileand 1s -1 to view the files. You'll now have a new file in
as if you'd just opened the file). You can see Touch in access using “ls your home directory called “testfile”. Notice that the size of the File is
—|" and checking the time next to a directory (such as Scratch). 0, because it has nothingin it.

piPraspberrupi touch testtile
pilPraspberrupi s -1 pi@Praspberrypl 1Z =—)
total £4 total 24
druxr-xr-x < pl1 pl 4090 Apr £1 1/7:55 druxr-xr-x 2 pi pi 4096 Apr 21 17:55
druxr-xr-=x o pi p1 4096 May 13 10:57¢ druxr-xr-x 5 pi pi 4096 May 13 10:57
drux ¢ pi pi 4096 May 13 11:01 drux 2 pi pi 4096 May 13 11:01
druxr-xr-x 3 pi pi 4096 Apr 17 18:48 druxr—-xr-x 3 p1 pi1 4096 Apr 17 18:48
druxruxr-x < p1 pl 4096 Jan 1 1970 druxruxr-x 2 pi pi 4096 Jan 1 1970
druxr-xr-x < pl pl 4096 Apr 1/ 1£:53 druxr-xr-x 2 pi pi 4096 May 13 11:05
pi@raspberrypl ru-r-—r 1 pi pi U May 13 11:10 testiile

pilPraspberrypi

Now enter: touch Scratchand ls -1 againand A quick word about file names: remember that Linux is
notice that the time has changed. It now matches the case sensitive, so if you now enter: touch Testfile
current time. You might be wondering what this has to do with (with a capital T), it doesn’t update ‘testfile”; instead, it creates a
creating files or directories. Touch has a second, more popular, use, second file called ‘Testfile'. Enter: 1s -1 to see both files. This is
which is to create files. confusing, so most people stick with using lowercase letters at
all times.

_ | pi@Praspberrupi touch testfile
pi@raspberrypi Is -1 pil@raspberrypl 1S —1

total Z4 total 24
druxr-xr-x & pil pil 4096 Apr 21 17:99 druxr-xr-x 2 pi 1096 Apr 21 17:55
druxr-xr-x 5 pi pi 4096 May 13 10:57 druxe—xr-x 5 pl pi 4696 May 13 10:57
drux ¢ piopi 4096 May 13 11:01 drux 2 pi 4096 May 13 11:01
druxr-xr-x J pi1 p1 4096 Apr 17 16:40 druxr-xr-x 3 pi 4096 Apr 17 18:40
druxruxr-x <& pi pi 4096 Jan 1 1370 Aruxruxr-x < pl 4096 Jan 1 19/0
flr_"u:-:r-—m:r-—x l. I.ji pl1 4096 Apr 17 12:53 druxr-xr-x 2 pi 4096 May 13 11:05
'p'{l-JL"-_'._:,'|JL-_?‘."~1‘4'|31I touch Scratch rPU——— pi 0 May 13 11:08
pi@raspberryp] s —1 pi@raspberrypi touch Testfile
total 24 pilPraspberruypi s I
druxr-xr-x 2 pi Apr 21 17:55 tatal 24 )
drwxr-xr-x r" lli May lj 10:57 druxr-xr-x 2 pi pi 4096 Apr 21 17:55
drux—————— 2 pi May 13 11:01 druxr-xr-x 5 pi pi 4096 May 13 10:57
drwxr-xr-x J Pl ﬁ]i[‘ ir 1bB:499 Adrwx 2 l}i lji 4096 Hl'”.J 13 11:01

druxruxr-x < pl Jan 1 13570 drwxr-xr 3 pi pi 4096 Apr 17 18:48

A
druxr-xr-x < pi May 13 11:05 druxruxr-x 2 pi pi 4096 Jan 1 1970
X 2 pi pi 4096 May 13 11:05
ru-r—--r 1 p1 pil 0 May 15 11:00 testtile
]

I"-lll‘ : "l'l. -4 il i II""' {IIItL.II[‘ H-.]h

rW-r—r pi pi 0 May 13 11:10 Testfile

pil@Praspberrupl
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STEP 5 Another important thing to know is never to use a STEP 6 Here are some other fFiles names to avoid:
space in your file names. If you try to enter: touch #%&{N\<>*?/S!"": @+ |=. The full stop (.) is used to

test file, you create a document called “test” and another called create an extension to a file; usually used to indicate a file type, such
“File”. Technically there are ways to create Files containing a space but  as textFfile.txt or compressedfile.zip, and starting a file with a full stop
you should always use an underscore character (*_") instead of a makes it invisible. Don't use a full stop in place of a space though; stick
space, such as “touch test File". to underscores.

pi@raspberrup i touch test file
piPraspberrypi s -1

total 24

druxr-xr-x < pi pi1 4096 Apr 21 17:55

- 3 10:57

druxr-xr-x 5 pi pi 4096 May

pifraspberrupi touch don’ t.uselioddisymbols&in<filenames>or=you’ 11 conf

Z pi pi 4096 May

1

13 11:01

ru-r——r 1 pi pi 0 May 13 11:15
druxr-xr-x 3 pi pi 4096 Apr 1/ 168:406
druxruxr-x < pl p1 4096 Jan 1 1970
druxr-xr-x < pl pil 4096 May 13 11:05

ru-=r--r 1 p1 pi U May 13 11:15 test
ru-r--r 1 p1 pi U May 13 11:10 testtiile
-ru-r——r 1 pi pi 0 May 13 11:12 Testfile
pi@raspberrypi

drwx

REMOVING FILES

We've created some Files that we don’t want, so how do we go about removing them? It turns out that deleting Files in your Raspberry Pi is
really easy, which may be a problem, so be careful.

STEP 1 Enter: 1s -1 to view the files in your home directory. STEP 3 We're going to use a wildcard (*) to delete our next
IF you've fFollowed the steps before then you should two files, but again this is something you really need
have three files: “test”, “testfile”, and “Testfile”. We're goingtogetrid  to do with care. First use “ls” to list the files and make sure it's the one
of these items because they were created as an example. you want to delete. Enter: 1s test* to view files that match the
word “test” and any other characters. The “*" character is called a
“wildcard” and it means any characters here.
pifPraspberrupi

total Z4

druxr-xr—-x 4 pl 4096

piPraspberrypi 1S

total 24

druxr-xr-x < pi p1 4096 Jul 9 UB:3b
druxr-xr-x Z pl 1096 Jul 08 :36

druxr-xr-x o pl 10906
druwx 2 pi 1096
ru-r--r 1 pi 0
druxr—-xr—-x J pl 4096
druxruxr-x < pl 41096
druxr-xr-x < pl 40906
" o e o 1 pi 0
ru-r-=—r 1 pi 0
o ) o 1 pi 0

druxr-xr-x 2 pi 4096 Jul 9 08:36

ru-r--r 1 pi 0 Jul 9 08:37
Adruxr—-xr—-x < pi 4096 Jul 08 :36
Aruxruxr-x < pi 4096 Jan 1970
druxr-xr-x < pl 14096 Jul 9 UB:3b

ruw-r--r 1 pi O Jul 9 08:37 test

o i o 1 pi 0 Jul 08:3/ testfile
piPraspberruypi s test«

test testfile

piPraspberrypi

yiPraspberrupi
{ ' ¢

STEP 2 To get rid of files you use the “rm” command. Enter: STEP 4 We see that “Is test*” matches two files: “test” and
rm Testfile to delete the File called “Testfile” (with “testfile”, but not the File called “file”. That's because

the uppercase “t”). Enter: 1s -1 and you'll find it's gone. Where is it didn’t match the “test” part of “test*”. Check carefully over groups
it? It's not in the Trash or Recycle Bin, like on a Mac or Windows PC. of files you want to remove (remember you can’t recover them) and
It's deleted completely and cannot be recovered. Bear this in mind replace the “Is” with “rm". Enter: rm test* to remove both Files.
and always think before deleting files. Finally enter: rm file to getrid of the confusing Ffile.

pilPraspberrypl rm Iestiile I!i“r"l"-_‘_}-:!l-i'*:'_:r'r' l!li
pl@raspberrypl s -1 pi@raspberrupi
total 24 total Z4
druxr-xr-x & pl * Apr 21 17:55 druxr-xr-x < pi1 pi1 *
druxr-xr-x 5 pi May 13 10:57 druxr-xr-x < pi pi 4096 Jul
druwx & pi . May 13 11:01 druxr-xr-x Z pi pi 4096 Jul
-r'v-r—r-— 1 pl ) May 13 11:15 ~“rN-r-—r— 1 P P 0 Jul
druxr-xr-x 3 pl : Apr 1/ 10:40 druxr-xr—-x Z pl pl 4096 Jul
druxruxr—-x < pl 4 Jan 1 1970 druxruxr-x < pil pl1 4U96 Jan
druxr-xr-x £ pl * May 13 11:00 druxr-xr-x < pi1 p1 4090 Jul
TR i o 1 pi J May 13 11:15 test pilPraspberrypi rm file
rw=r--r 1 pi D May 13 11:10 testfile pi@raspberrypi

pifraspberrupi
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Create and Remove
Directories

Creating, moving and deleting directories isn't as easy in the Terminal as it is within a

desktop interface. You need to tell Linux to move the directories inside other directories, a
process known as recursion. Sounds complex but you should quickly get the hang of it.

MANAGING FILES AND DIRECTORIES

Now that you know how to create files, you'll want to learn how to make directories, which are the same thing as folders, as well as move
items around. If you are more used to working with a desktop interface, this can take a bit of getting used to.

Enter: 1s to quickly view all the directories currently in Like touch, you can create multiple directories at once
STEP 1 . ey ) , STEP 3 | . . .
in the home location. Directories are created using the with the mkdir command. Enter:mkdir testdir?
“mkdir” command (make directory). Enter:mkdir testdirtocreate  testdir3andenter: 1s.You'll now find several directories called
a new directory in your home directory. Enter: 1s again to seeit. testdir. Also, like Files, you should know this means you can’t (and

really shouldn't) create directories with spaces. As with Files, use an
underscore (") character instead of a space.

Is
.

piPraspberrupi mkdilr testdirs testdird
piEraspberrypl s

mkdir testdir
18

|ri"‘l‘ -.;II: rryp i

STEP 2 The “mkdir” command is different to touch, in that it STEP 4 You can create directories inside of each other using
doesn’t update the timestamp if you use it with a the directory path. Enter:mkdir Documents/

directory that already exists. Enter:mkdir testdir againand you'll photos to create a new directory called “photos” inside your

get the error “mkdir: cannot create directory ‘testdir: File exists”. documents directory. The directory has to already exist, though, try to

enter:mkdir articles/reports andyou'll get an error because
there is no articles directory.

piPraspberruypl mkdir testdir
mkdir: canmmot create directory testdir @ File exists

= " 1 [ '*'1‘—'”"‘1‘.‘:‘%‘ lgli I'H.
pill@Praspberrupl

Praspberrypi mkdir Documents/photos

raspberrypi mkdir articles/reportis
mkdir: cammot create directory articles/reports’ ! No sucl
D 1Pras III]’.'!I'I' Ip /
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To create a directory path you need to pass in the “p”
STEP 5 . . . i n =
option to mkdir (which stands for “parents”). Options,
if you remember, come after the command and start witha *~'. So

enter:mkdir -p articles/reports. Enter: 1s to view the articles
directory, or “ls articles” to view the reports directory sitting inside.

pilPraspberrupl

mkdir —p articles/reports

GETTING RID OF DIRECTORIES

Create and Remove Directories :
\

STEP 6 Now you're starting to get a bit more advanced, we're
¥ going to just reiterate something. In Linux the
command structure is always: command, option and argument, in that
order. The command is the function, next are the options (typically

single letters starting with “-") and finally the argument (often a file, or
directory structure). It's always command, option then argument.

-1 articles

I'ri'r‘l"-‘_}a'!l.i'l‘_:l"l" _”li l?'-.:
total 4
druxr-xr-x < pi pi1 4090 May 13 1£:3b

piPraspberrypi

Deleting directories is pretty easy in Linux, along with files, and this can be a problem. It's too easy to delete entire directories containing
Files and these are instantly removed, not sent to a trash directory. Tread carefully.

We're going to remove one of the directories we
STEP1 " . i - _ I
created earlier using the “rmdir” command. Enter: 1s
to view the Files and directories in the current directory. We'll start by

getting rid of one of the test directories. Enter: rmdir testdir3and
1s again to confirm the directory has been removed.

!li*T‘I'""_f*-'ll.i"l’_Il"r'_llli 1S

pi@raspberrupi rmdir testd i[‘ﬁi_

Now we'll try to get rid of the articles directory
STEP 2 - . |
(containing the reports directory). Enter: rmdir
articles and press return. You'll get an error saying “rmndir: failed to
remove ‘articles’: Directory not empty”. This is a puzzler; the rmndir

command only removes directories that having nothing in them (no
Files or other directories).

piPraspberrupi rmdlr articles
rmdir: failed to remove articles :
pi@raspberrypi

Directory not empty

To delete a directory containing files or other
ﬂEP 3 . . i n
directories, you return to the “rm"” command used to
remove files, only now we need to use the “-R" option (which stands
For “recursive”.) Using “rm —R"” removes all the Files and directories to

whatever you point it at. Enter: rm -R articles to remove the
articles directory.

aspberrupi 1S

‘aspberrupi rm —H articles
‘aspberrypi s

"aAS |lh‘:l"l" ip |

As with multiple files, you can delete multiple
STEP4 . S . . .
¥ directories inside the same directory using the “rm
command with the wildcard character (*). This should be done with
care though so use the -I option (which stands for “interactive”). This
will prompt you before each deletion. Enter: rm -Ri test* and

press Y and return to each prompt. It's a good idea to use the -1
option whenever using the rm command.

Rl test>
“testdir 7 y
“testdird 7 u
“testdird 7 y_

||i’r‘r'a‘_:‘u!lt‘:':r*l" I!Ii "m
rm: remove directory
rm: remove directory
rm: remove directory
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Copying, Moving and
Renaming Files

Taking command of the Terminal is essential when learning how your Raspberry Pi's
operating system works. The copying, moving and renaming of files is equally important, as
you'll be doing a lot of this throughout your Pi projects.

USING THE MOVE COMMAND

In Linux, renaming a file is simply moving it from one name to another and copying a file is moving it without deleting the original. Don’t
panic, it's quite easy to master.

Before we can move anything around, we need to Enter:mv testfile testdirand pressreturnto
STEP 1 o . STEP 3 . . o
have a few test items in our home directory. Enter: move the testfile document into the testdir directory.
touch testfileandmkdir testdir to create atest File and test Enter: 1s to see thatit's no longerin the home directory, and 1s
directory in your home directory. Enter: 1s to check that they are testdir to see the testfile now sitting in the testdir directory. Now
both present. enter:mkdir newparent to create a new directory.

touch testfile piPraspberr | <

mkdir testdir % g _
1 [l 1 9T A S lll.-'l' 4 & I"'_ mou l.[‘.”'-'. l I i llh '.[‘.”.'-: I I.'I o

|ri iraspberry 1s

gri"-"'l'-":-|ilm‘:|"1' Is
testfile

!ri*f"r'f‘."--'lli‘u*:f'r'

STEP 2 Files and directories are moved using the mv STEP 4 Directories with files are moved in the same way.
command. This is different to the commands we've Enter:mv testdir newparent to move the testdir

looked at so far because it has two arguments (remember Linux directory inside the newparent directory. Let's move into the directory
command line is command, option, argument). The first argument is to Find the file. Enter: cd /newparent/testdir andenter: 1s to
the source (the file or directory to be moved) and the second is view the testfile sitting inside the directory.

the destination.

piPraspberrupi 1S pi@raspberrypi |S

pi@raspberrupi nu testfile testdir pif@raspberrypl mkdir newparent
yifPraspberrupi nu testdir newparent
| g ]
piPraspberrupi cd newparent/testdir
pil@raspberruypl s
testfile
L i 'r"r'-':'-.!l]"n' U i
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Files and directories can be moved up using the
double dot (“..") asan argument. Enter: 1s —1lato
view your testfile and the single and double dot files. The single dot is

the current directory and the double dot is the parent directory. Enter:

to move the testfile up into the newparent
. . to move up to the parent directory.

mv testiile
directory. Enter: cd

piPraspberr cd newparent/testdir
pDlPraspberri 1S
testiile

pi@raspberr mu testfile ..

pifraspberrt cd

RENAMING FILES AND DIRECTORIES

You can also move files using longer paths. Enter:

cd ~ toreturn to the home directory and
mv newparent/testfile newparent/testdir/testfileto
move the testfile from its current location back inside the testdir
directory. Enter: 1s newparent/testdir to view the file backinits
current directory.

DI1Fras gli‘:‘:l"f' N |

pil@raspberrypi K

nu newparent/testiile newparent/testdir
newparent/testdir

|Ii 4 o .'-llll_-'l':l'-ll.li
!1 _l r'\r"- ,I-..!.'I..q_-tuln.ll]i I.,,I
testfile

piPraspberrupi

The mv command isn’t used just to move files; it also serves the purpose of renaming files (effectively it moves it from its old name to a new

name). Let’'s see how to use mv to rename items.

STEP 1 Let's start by making a new test File called “names”.
Enter: touch testfile and then 1s to make sure the
testFile is present. We're going to turn this into a File that contains the

names of some people. So let’s call it something more appropriate,
like “names”.

plPraspberrupl 1S
L 1 '="r'-'_:-'lli'|':a"t"'”li nu testfiile names
pilPraspb .'1'1‘1;.li 1S
names
p]'”r”_-u]ffrl'lui

STEP 2 Enter:mv testfile names and 1s. Now we can see
the new “names” file in our directory. The mv
command can also be used to rename directories. We should still have

our newparent directory in our home directory. Enter: mv newparent
people to rename the newparent directory. Enter: 1s to view it.

touch testtile
pbherrypil 1S

pil@Praspberrupl

pilPras

mu newparent people
piPraspberruypi 1S

p1er -.u[: rrupl

piPraspberrypi

STEP 3 You can rename directories inside other directories
using paths. Let's rename the testdir directory, which
is now inside the people directory. Enter:mv names/testdir

names/friends. Now enter:mv names people/friends to move
the names file inside the friends directory.

!li-'*["*'f'llli'll.'f‘f' IF'i 1S
Hames

pi@raspberrupi mu peoplestestdir peoplesfriends

It is easy to overwrite Files using the mv command,
STEP4 : o
so if you have files with the same name use the
“-n” option, which stands for “no overwrite”. Enter: touch
testfile to create anew fileandmv -n testfile people/

friends. There's no error report though, enter: 1s and you'll find
testFile still there.

plPraspberrupl touch testfile

plEraspberrypl mu -n testiille peoplestriends
!lI’I"i'“':-'.lli‘u':1"|“'1E|i 1S

!.Ii-:n,.i.hr. .I.lil.'.hrtr‘.l.[.li | <

pi@raspberrupi s peoplesfriends

names testfile

pl@raspberrypl
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sing the Man Pages

Linux comes with man (manual) pages that explain each command and show you all the
options you can use. Once you get the hang of reading the man pages, you'll be able to find
and do just about anything in Linux.

HEY, MAN!

The man pages are one of the best features of Linux, and as a built-in tool it's invaluable for both beginner and senior level Linux

administrators. Let's see how it works
Linux has a built-in manual, known as man for short. Most commands are pretty easy to figure out how to
STEP 1 . o . STEP 3 >
Using the man command you can obtain information use, so what you spend most of the time in the man
on all the Linux commands we've talked about. Simply enter: man and pages is looking under the Description. Here you will see all the
the name of the command you want to learn more about. Start by options and the letters used to activate them. Most man pages are
entering: man 1s in the command line. longer than a single page, so press any key, such as the space bar, to

move to the next page of content.

=1 like -1, but do not list owner

pifraspberrypi man 1s i R (A
i’y group directories beftore f1les.

augment with a -sort option, but any use of --sort (-U) disables grouping

-G, ——no-group
in a long listing, don't print group names

h, =--human-readable

with =1, print sizes in human readable format (e.g., 1K 231H 2G)
STEP 2 The man pages are a bit more detailed than you might | likewise, but use powers of 1000 not 1024

be used to. First you have a name, which tells you “H, —dereference-comand-1ine

follow symbolic links listed on the command |ine

what the command is called; in this case “list directory contents” and et arance-conxani-Elns-aunithiictosdis
then the 5yn0p5|5 Shgws you how |t wgrks_ |n this case: "[5 [OPTION]" . follow each command line symbolic link that points to a directory
[FILE"]". SO you enter: lS Followed by Options (Such as _la) and the do not list implied entries matching shell PATTERN (overridden by —a or -A)

-indicator-style

File or direCtory to liSt' append indicator with style WORD to entry names: none (default), slash (-p), file-type |

-1, —Iinode
print the index number of each file

L5(1) -1, ==ignore

STEP 4 Press the H key while looking at a man page to view
the commands you can use to control the view. This is
VT LISt information about the FILEs (the current direc tory by default). Sort entries alph called the Summary of Less Commands (the less command is
Mandatory argunents to long options are mandatory for short options too. something we'll come to when we look at editing text). For now

e tartin with realise that you can move back and forward with Z and W. Press Q to
A; —almost-all quit this help screen and return to the man page.

do not list implied . and ..

NAME

s list directory contents

SYNOPSIS
Is | b Faiita

——author
with -1, print the author of each file

SUMMARY OF LESS COMMANDS

Commands marked with = may be preceded by a number,

-b, ——escape Notes in parentheses indicate the behavior if 15 gluen.
print C-style escapes for nongraphic characters
Display this help.
-~block-size Exit.
scale sizes by SIZE before printing them E.gq., —hlock-size=M" prints sizes i

-bB, —ignore-backups
do not list implied entries ending with

HOVING

5 § "N CR = Forward one line (or lines).
K P = Backward one line (or lines).
|

o > with =-1lt: sort by, and show, ctime (time of last modification of file status inf '
“"F "V SPACE = Forward one window (or lines).
y "B ESC—vu # Hackwar<d one winvwlow (or 1ines)

-C list entries by columns .
# Forward one window Cand set window to [

——color| l
colorize the output. UWHEN defaults to always® or can be ‘never’ or auto’. Mo

#w Hackward one window Cand set window to ).
ol-aPACE « Forward one window, but don’t stop at end-of-file.
“D % Forward one half-window (and set half-window to HN).
y U % Backward one half-window (and set half—-window to MH).
al—)  RightArrow = Letft one hallt screen width Lor positions),
ol-0( LeftArrow = Hight one half screen width (or positions).
Forward forever; like "tail e
‘R "L Repaint screen.
Hepaint screen, discarding buffered input.

‘d , directory
list directory entries instead of contents, and do not dereference symbolic link

-D, —dired

generate output designed for Emacs’ dired mode

f do not sort, enable -al, disable -ls color
Default “"window"'" is the screen height.
Default "half-window” is half of the screen height.

| classify
append indicator (one of ==>@1) to entries

—f1le-type

likewlse, except do not append

SEARCHING
search forward for (N-th) matching line.
» Search backward for (N-th) matching line.
# Repeat previous search (for N—th occurrencel.
» Hepeat previous search in reverse direction.

==format
across =-x, commas -m, horizontal =-x, long =1, single-column =1, verbose

——full-time

» Repeatl previous search, spanming f1les.,
like -1 —time-style=

#* Repeat previous search, reverse dir. & spanming fi1les.,
Undo (toggle) search highlighting.

Manual page 1s(1) line 1 (press h for help or g to gquit)

= Display only matching 1lines

aearch patterns may be modified by one or more of':

"N or * Search for NOMN-matching lines.

"E or # Search multiple files (pass thru END OF FILE).

“F or @ Start search at FIRST file (for ~) or last file (for 7).
& Highlight matches, but don’t moue (KEEP position).
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STEP 5 Scroll to the bottom of the man page to discover more STEP 6 The man command can be used for just about every
information. Typically you will find the author’s name ¥ command you use in Linux. You can even enter: man
and information on reporting bugs, including web links that can be man to get information on using the man tool. From now on,
useful For more information. Press Q to exit the man page and return whenever you come across a new command in this book, such as
to the command line. “nano” or “chmod”, take time to enter:man nano orman chmod and
read the instructions.

assume tab stops at each CULS instead of ©

HANC1)

with =1t: sort by, and show, access time with -1: show access time and sort by name otl

do not sort: list entries in directory order NAME

man an interface to the on=line reference manuals
natural sort of (version) numbers within text
SYNOPS IS

man [-C | [=d] [-D] [——warningsl- 11 [-R ] [-L

i } I=¢) [-E | [——no-hyphenation] [--—no—justification] [-p

man -k | | e

man =K [-wl-W] [-5 | [-11-11 1| - | | ]

man -f | I T

man -1 [~C | [=d] [-D] [-—warningsl

man -wl-W [-C ] [-d] [-D]

man —-c [-C =1 [-d] [-D]

man [—hU]

, ——width

assume screen width instead of current value
list entries by lines instead of by columns
sort alphabetically by entry extension

.» ——cCcontext
pr*inl any Sl 1N :--:1'11!.]'*il.1__: context ot each fi1le

DESCRIFTION
man is the system's manual pager. Each argument given to man is normal ly the name «
if provided, will direct man to look only in that
found, even 1t > ex1sts 1n several

-1 list one file per line

—help display this help and exit of the manual.

——UEersion

output version information and exit The table below shows the numbers of the manual followed by the types of pages t

SIZE may be (or may be an integer optionally followed by) one of following: KB 1000, K 1024,

USING MAN OPTIONS

Because man doesn’t change anything, like mv or mkdir, it is tempting not to see it as a command. But it is, and like all other commands it has

options. These can be very handy to learn.

Entering: man man enables you to view some of the STEP 3 One of the most powerful man options is the -k option,
options, but sometimes you'll just want a quick which is for “apropos”. This enables you to search a

wider range of man pages than the exact command. Enter:man -k

overview. Fortunately man has a built-in help option that quickly lists
the options. Press Q if you're in a man page and enter: man -h at the directory to view all of the man pages relating to directories “(man
-k directory | less” to view one page at a time). Here you'll find

command line.
commands like “ls”, “mkdir” and “cd” along with their description.

1 Executable programs or shell commands

print physical location of cat ftilel(s)

fchdir (2) change working directory

fchmodat (£) change permissions of a file relative to a directory file descriptor
fchounat (£) change ounership of a file relative to a directory file descriptor
fdopendir (3) open a directory

: catman used by catman to reformat out of date cat pages
s recode=ENCUD TNG output source page encoded in ERCUDING

Finding manual pages:
s loca le=LUOCALE define the locale for this particular man search
m, systems=SYSTEHM use manual pages from other systems
", manpath=PATH et search path for manual pages to PATH

find (1) search for files in a directory hierarchy

fztatat (2) — get file status relative to a directory file descriptor

fstatatbd (2) — get tile status relative to a directory ftile descriptor

futimesat (2) - change timestamps of a file relative to a directory file descriptor
get_current_dir_name () get current working directory

get_current_dir_name (3) get current working directory

getcud (2) get current working directory

sections=L1al use colon :--:l‘lmr':lll'd section list

extens1on=EXTENSIUON limit search to extension type EXTENSIUN e . ;
getcud (3) get current working directory

getdents (2) - get directory entries

l1gnore-case look for pages case—-insensitively (default) _ St _ _
getdentsbd (2) - get directory entries

match-case look for pages case-sensitively . " P . . : : .
getdirentries (3) - get directory entries in a file system—independent format

e ex

show all pages matching regex

wi ldcard show all pages matching wildcard

Names

11.11

update

no-subpages

Lontrolling f«
P, pager=PFAGER

I* s I]I'lll"l]:ll.

ascii

only make reqgex and wildcard match page names only,

not descriptions

find all matching manunal pages
force a cache consistency check

don' t try subpages, e.g. "man foo bar’ => "man
foo—bar’

wrmatted output:

use program PAGER to display output

STRING provide the "less’ pager with a prompt

display ASCI] translation of certain latinl chars

L, encod ing=ENCOD ING use selected output encoding
no—hyphenation, nh turn of'tf hyphenation
no— justification, n.| turn off jJustification

P PIEC P

i grap, r

troff

essor=aTRING STRING indicates which preprocessors to run:
Inlegn, p pic, t thl,

refer, o ugr 1 1l

use groft to format pages

troff-devicel=DEVICE] use groff with selected device

hitml [ =BROWSER ]

use www-browser or BROWSER to display HTHL output

gxditview[=RESOLUTION] use groff and display through gxdituview

(X11):
A = A D, A100 = -TA100, ¥100-172 = -TX100-17

ditroft use grott and force it to produce ditroff

help

glue this help list

getwd (3)
git-clone (1)
git-mu (1)
git-stash (1)
helpztags (1)
linkat (2)
lookup_dcookie (£)
s (1)

mkdir (£)
mkdirat (2)
mkdtemp (3)
nkfifoat (3)
mkfontdir (1)
mklost+found (8)
mknodat (£)
mktemp (1)
modprobe .d (5)
mountpoint (1)
oldfind (1)
openat ()
opendir (3)
pamn_mnkhomedir (g)
pud (1)

pudx (1)
readdir (2)
readdir (3)
readdir r (3)
readl inkat (2)
remove L(3)
renanegat (£)
rewinddir (3)
rmndir (2)
run-parts (8)
scandir (3)
scandirat (3)

get current working directory

Clone a repository into a new directory

Mouve or rename a file, a directory, or a syml ink
Stash the changes in a dirty working directory away

—- generate the help tags file for directory

create a ti1le link relative to directory ti1le descriptors

- return a directory entry’s path

list directory contents

create a directory

create a directory relative to a directory file descriptor
create a unique temporary directory

- make a FIFO (named pipe) relative to a directory file descriptor

create an index of X font ti1les 1n a directory

— create a lost+found directory on a mounted Linux second extended ftile s

create a speclial or ordinary file relative to a directory f1le descrip
create a temporary file or directory

Configuration directory for modprobe

see il a directory is a mountpoint

- search for files in a directory hierarchy
open a file relative to a directory file de

open a directory

FAM module to create users home directory

print name of currentsworking directory

report current working directory of a process

read directory entry

read a directory

read a directory

read value of a symbolic link relative to a directory file descriptor
remove a file or directory

rename a file relative to directory file descriptors
reset directory stream

delete a directory

- run scripts or programs in a directory

scan a directory for matching entries
scan a directory relative to a directory file descriptor

LS Ly e give a short usage message

STEP 2 IFf you're fast you may have noticed the start of the m Entering the man page for all the commands you
text flew up off the page. This is because the “man -h" come across can be a little long-winded, although
option doesn’t use the less command by default (less is what enables ultimately productive. If you simply want to know what a command
you to move down text one screen at a time). We'll look into pipes (“|”)  does you can read just the description using the “whatis” command.

later on, but for now just use “man -h | less” to read long text one page  Enter: whatis pwd to read the description of the “pwd” command
at a time. (“print name of current/working directory”).

pilPraspberrypi whatis pud

print name of current/working directory

L i 'l"|"v'_:--'!l-i‘|':l"‘l"‘ ”Ii man —h | less I"“‘":I" (1)
tni W‘r'=i}'!1iW“:l“i“f|il ]
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Editing Text Files

A text file in Linux can be anything from a simple set of instructions on how to use an app, to
some complex Python, C++ or other programming language code. Text files can be used for

scripting, automated executable files, as well as configuration files too.

THE JOY OF TEXT

To be able to edit or create a text file, you need a good text editor. Linux has many but here are some in action on the Raspberry Pi.

STEP 1 The First text editor for the Raspberry Pi is the default
desktop environment app: Leafpad. To use, you can
either double-click an existing text file or click the Raspberry Pi menu

icon (in the top left of the desktop) and from the Accessories menu,
choose Text Editor.

& H_:' ﬂ @ [psjﬁ&:aapbewp ~] ;-*_?Thetim"nenanlﬁ-aem
rogramming ’

A S

™ , Fle Edit Search Options Help

‘{ I remember

e88l Inleme » The dark woods, masking slopes of sombre hills
b5 The grey clouds® leaden everlasting arch,

£l Ga ) The dusky streams that flowed without a sound,
- And the lone winds that whispered down the pas

Vista on vista marching, hills on hills,

Slope beyond slope. each dark with sullen tree
Our gaunt land lay. 50 when a man climbed up
A rugged peak and gazed, his shaded eye

Saw but the endless vista - hill on hill,
Slope beyond slope. each hooded like 1ts broth

It was a gloomy land that secemed to hold

All winds and clouds and dreams that shun the
With bare boughs rattling 1n the lonesom® wlind
And the dark woodlands brooding over all,

Not even lightened by the rare dim sun

Which made squat shadows out of men: they call
Cimmeria, land of Darkness and deep Night

It was so long ago and far away

I have fru'grur the VEery name men called me

The axe and flint-tipped spear are like a drea
And hunts and wars are shadows. I recall

Only the stillness of that sombre land;

The clouds that piled forever on the hills,
The dimness of the everlasting woods.
Cimmeria. land of Darkness and the Night.

Oh, soul of mine, born out of shadowed hills,
To clouds and winds and ghosts that shun the s
8 How many deaths shall serve to break at last
& This her 1 tage which wraps me 1n the grey
Apparel of ghosts? I search my heart and find
Cimmeria. land of Darkness and the Night.

STEP 2 From the Terminal there are even more options,
although using the correct command, you can launch
any of the desktop apps via the Terminal. One of the simplest, and a

classic text editor that's carried over from the Unix days, is vi. In the
Terminal, enter: vi.

Fille Edit Tabs
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STEP 3 Vi is the original Unix command but in this case it
' launches VIM, the new Linux version of Vi. Although

simple looking, Vi is considered, even by today's standards, to be one
of the most widely used text editors, There's a lot you can do with it,
so check out the man pages for more Vi information.

STEP 4 Nano is another Favourite, and simple, text editor
available for Linux. Enter: nano into the Terminal to

launch it. You can use Nano for editing code, creating scripts or writing

your own help Files. To exit Nano, press Ctrl + X, followed by Y to save

the File or N to exit without saving.

pi@raspberrypi: ~

File Edit Tabs Help

GNU nano 2.2.6 New Buffer




STEP S Emacs, or GNU Emacs, is an extensible and
customisable, self-documenting, real-time display
editor. It's a fantastic text editor and one that's worth getting used to
as soon as you can. Sadly, it’s not installed on the Pi by default, so

you'll need to install it. In the Terminal, enter:
sudo apt-get install emacs

pi@raspbemrypi: ~

File Edit Tabs Help

STEP6 The previous command contacts the Debian (Raspbian
is based on a Debian Linux distribution) repositories

and pulls down the information needed to install Emacs. When the Pi
asks to continue with the installation, press Y. This installs the latest
version and when it's done, you'll be back to the command prompt.

emacs@raspberrypi

File Edit Options Buffers Tools Help

| & &

2L

vwelcome to GNU Emacs, one component of the GNU/Linux operating syster

emacs I utoria
Emacs Guided Tour
View Emacs Manual

Learn basic keystroke commands

Overview of Emacs features at gnu.org

View the Emacs manual using Info

GNU Emacs comes with ABSQLUTELY NQ WARBANTY
Conditions for redistributing and changing Emacs

Furchasing printed copies of manuals

Absence of Warranty
Copying Conditions
QOrdering Manuals

Tostart.. OpenaFile OpenHome Directory Customize Startup
To quit a partially entered command, type Control-g.

This is GNU Emacs 24.4.1 aFnLﬂ|PclﬁhﬁL -gnueabihf,
of 2U01/7-03-12 on mb-ixe-U1, moaified by | “tlrl

GTK+ Version 3.14.5)

STEP 7 Once the installation is complete, enter: emacs into
the Terminal. The Emacs splash screen opens in a new

window, offering a tutorial (which we recommend you run through)
and a guided tour amongst other information.

emacs@raspberrypi =L
File Edit Options Buffers Tools Text Help

- X

—

I remember

The dark woods, masking slopes of sombre hills;
The grey clouds® leaden everlasting arch;

The dusky streams that flowed without a sound,

And the lone winds that whispered down the passes.

Vista on vista marching, hills on hills,

Slope beyond slope, each dark with sullen trees,
Our gaunt land lay. So when a man climbed up

A rugged peak and gazed, his shaded eye

Saw but the endless vista - hill on hill,

Slope beyond slope, each hooded like its brothers.

It was a gloomy land that seemed to hold

All winds and clouds and dreams that shun the sun,
With bare boughs rattling in the lonesome winds,
And the dark woodlands brooding over all,

Not even lightened by the rare dim sun

Which made squat shadows out of men; they called 1t
Cimmeria, land of Darkness and deep Night.

It was so long ago and far away

I have forgot the very name men called me.

The axe and flint-tipped spear are like a dream,
And hunts and wars are shadows. I recall

Only the stillness of that sombre land;

The clouds that piled forever on the hills,

The dimness of the everlasting woods.

Cimmeria, land of Darkness and the Night.

Editing Text Files

STEP 8 Emacs can offer an uncomplicated view of your text
File or one with a plethora of information regarding
the structure of the file in question; it's up to you to work out your
own preference. There's also a hidden text adventure in Emacs, which

we cover later in this book, why not see if you can find it without
our help.

pi@raspbemypi: ~

File Edit Tabs Help

STEP 9 Gedit is another excellent text editor for Linux. Again,
it's not installed by default on the Raspberry Pi;

however, by entering: sudo apt-get install gedit and
accepting the installation, the program can be on the Piin a matter of
seconds. Once it's installed, use gedit in the Terminal to launchiit.
Gedit is a great text editor for coding.

Circle.py
|r~w;nf1r"{ turtle
for tin range(4):

print("Making a square...")

turtle forward(100)

turtle left(90)

turtle.getscreen()._root.mainloop()

Finally, Jed is an Emacs-like, cross-platform text editor
STEP 10 that's lightweight and comes with a wealth of

fFeatures. To install it, enter: sudo apt-get install jed.Accept
the installation and when it's complete, use: jed to launch.

pi@raspbe

File Eait Tabs Help

This 1s a scratch buffer. It 1s NOT saved when you exlt.

press F10 or ESC-m and the use the arrow
keya to nau1gate

L atest version information 1s available on the web from
<http://ww. jedsoft.org/jed/>. Other sources of JED

information include the usenet newsgroups comp.editors and
alt.lang.s-lang. To subscribe to the jed-users malling list, see
<http://vww. jedsoft.org/jed/mailinglists.html>.

Copyright (C) 1994, 2000-2009 John E. Davis
Email comments or suggestions to <jed@jedsoft.org>.
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Getting to Know Users

You might think you're the only person using your Raspberry Pi but there are several different

users and even groups of users. Your main account is normally called Pi and there is an
account above it called root, which is more powerful. You can also create users and groups.

WHAT IS A USER?

An important part of using Linux is the concept of users and understanding which user you are and which group you belong to. Like all
modern computers, you can have multiple user accounts with each having different levels of access.

The First thing you need to do is get a concept of
STEP 1 _ B

which user you are. Enter: whoami into the command
line and press return. It should say “pi” (unless you set up your account
name differently during setup). The “whoami” command might seem a

bit simplistic, but it comes in very handy sometimes.

I i ‘,"‘l‘“]‘.}:[l]'i‘, LU : whoaml
pi

piEraspberiryp]

2 When you are working in Linux, from time to time a
STEP e o . .

Permission denied’ error will occur, typically when you
try to create, edit or execute (run) a file or directory outside of your
area of privilege. If you want to see this, enter: mkdir /testdir.

Attempting to create a new directory in your root directory
isn't allowed.

pifFraspherrupi mkdir ~test
mkdir: camnot create directory
P L, h"'-:'_.:-v‘.Lii'i: rUp .

“stest’ @ Permissi
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STEP 3 To allow this, you need to use the sudo command.
Sudo loosely stands fFor Substitute User Do; essentially
it's the highest level of access to the system and you've already
installed text editors using sudo. You'll come across sudo frequently in

Linux, so let’s create a second account to get the hang of it. Enter:
sudo useradd -m lucy (or pick your name).

pifraspberrupi sudo useradd -m lucy

Now add a password for the new account. Enter: sudo
STEP 4
passwd lucy and enter: a short password. Retype
the same password and you'll now have two accounts on your
Raspberry Pi. Now enter: 1s -1 /home to view the home directories

For both users. Notice that the lucy directory lists lucy as the owner
and group; and pi directory is belongs to pi.

piEraspberrupi sudo passwd lucy
Enter new UNIA password.-:

Hetype new UNIX password:

passuwd: password updated successfully
pifraspberryp s =1 /home
total H
druxr—xr—-x

druxr—xr—-x 33 pl pli

2 lucy lucy 4096 May 13 19:01
41096 May 13 183:37

plEraspberrypl




Getting to Know Users

Let's try switching to our new account. Enter: su We'll look at permissions in the next tutorial, but for
lucy and enter the password you just created for that now try to create a file as before. Enter: touch
account. Notice that the command line now says “lucy@raspberrypi” testfile to create a file. It will say “touch: cannot touch ‘testfile":
but the working directory is “still /home/pi” (check this using “pwd"”). Permission denied"”. This is because your new user account doesn't
Enter: whoami to confirm that you are now the new user. have the right to create files in the /home/pi directory. Enter: su pi
to switch back to your pi account.

lucy@raspberrypi s lucy

Password: pifraspherrypi su lucy
lucyPraspberrypi pud Fassword:
shonespi lucy@raspberrypi touch testfiile

touch: cammot touch “testfile’ : Permission denied
lucyPraspberrypi

lucy@Praspberrupi

GETTING SUDO

We now have two accounts on our Raspberry Pi: lucy and pi. The lucy account can edit files in /home/lucy and the pi account can edit files in /
home/pi. But there’s also a third account, called “root”, that sits above both lucy and pi. It can edit files anywhere.

STEP 1 The root account is all-powerful. It is possible, but not STEP 3 It's rare that you use sudo to substitute another user. If
recommended, to switch to the root account, although you don't specify a user using the “-“u option with a
you'll need to give it a password First (using “sudo passwd root”). Then  username it defaults to the root account, as if you'd typed “sudo -u

just type “su” to switch to root. Please don’t do this though: root”. Enter: sudo touch /home/lucy/anothertestfile to
knowledge is a good thing but it's safer and wiser to use sudo instead.  create a file in the lucy directory while still using the pi account.

pifraspherrypi Sudo touch <homeslucysanothertest
plPrazpberrypl 1= #home~s lucy~

anothertestfile pistore.desktop test

L 1Eras llh‘.: L i

pilfraspherruypi sudo passwd root
Enter new UMNIX password:

Retype new UNIA password:

passud : password updated successful ly
piPraspberrypi L

Passuword :

This step is optional. Only the pi user can use sudo. If
we want to give the lucy account sudo privileges, it
needs to be added to the sudoers File. Enter: sudo visudo to view
the sudoers file. Add 1ucy ALL=(ALL) NOPASSWD: ALL to the last
line and use Control+O to output the file. Remove the “.tmp” that is

Most people think sudo stands for “super user”, butit  3dded to the file name as a security measure. Note that most accounts
STEP 2 stands For “substitute user do”. It enables you to are not added to the sudoers file as a matter of course.

perform a command as another user. Enter: sudo -u lucy touch / GNU nano 2.2.6 File: cetc/sudoers. tmy
home/lucy/test to create a file inside the lucy home directory. You
won't get an error because the lucy user has permission to edit

that directory.

! Thic file MUST be edited with the "visudo' command az root.

i Please consider adding local content in setc/sudoers.ds instead of
directly modifying this file.

see the man page for details on how to write a sudoers file.

ietaults enu_reset
Defaults mail_badpass
letfaults secure_path="rusr~localssbin: usr-local bin: usr-shin: usr-bin:sshin:sbin"

pilfraspberrypi sudo —u lucy touch Ahomes lucy-te:

F I epep—— PP | it Host alias specification
pifraspherrypi

| User alilas specification

i Cmnd alilas specification

User privilege specification
'O ALL=C(ALL ALL) ALL

i Allow members of group sudo to execute any command
ssudo ALL=C(ALL :ALL) ALL

i See sudoers(5) for more information on "#Hinclude” directives:
Hincludedir setc/sudoers.d

31 ALL=(ALL) NUPASSWD: ALL
lucy ALL=(ALL) NOPASSWD: ALL

www.bdmpublications.com 67




Learning Linux
/

Ownership and
Permissions

Once you've got the hang of users, you need to learn about ownership and permissions.
Different users have different areas of ownership and can do different things with each file.
Permissions in Linux can be quite complex but with careful thought it's not too difficult.

OWNER AND PRIVILEGE

Each user account in Linux is an owner of a section of the Filesystem: their Home area. Within this area, they do what they like (within
reason), as they have owner privileges. Elsewhere though, they usually just have read-only privileges.

If you followed the previous tutorial you should now The First letter in the permissions also indicates a
have two accounts on your Raspberry Pi. One called directory or file. Notice that all the other files start

“pi” and the other with a name (Lucy in our case). An essential aspect with a ‘d’ and our textFile.txt File starts with a -'. That's what the first

of Linux is the idea of File and directory ownership; who owns, and has  letter means. It's either a ‘d’, in which case it's a directory, ora ‘-, in

access, to what. You need a test file so enter: touch testfile. which caseit'snot:it'safile. Enter: 1s -1 testfile.txt toview the
permissions for just this File.

pi@raspberrypi touch testfile.txt
!'li:ﬂr‘i';,‘-:!'l‘i'h‘,.'l"'l",.__[!'li g —1
total £b
druxr-xr—-x &£ pl1 pl 4036 Apr <1 1700
druxr—-xr—x J pi pi 4096 May 13 18:0H
drux 2 pl pl 4096 May 13 11:01]
druxr—-xr—x J pi pi 4096 Apr 17 18:48
druxr-xr-x 3 pi pi 4096 May 13 14:53
druxruxyr—x 2 pi pi 4096 Jan 1 1970
druxr-xr—-x £ pl pl 4096 May 13 11:05
rw-r-——-r pL pl 0 May 13 £1:149 testiile. txt
pifraspberrypi s =1 testfile. txt
ru-r--r 1 pi pi 0 May 13 £1:14 testfile.txt

pilPraspberrypi

STEP 2 Now enter: 1s -1 and let's have a good look at the
default permissions File. Our testfile.txt files starts
with the text “-rw-r—r—". Start with the first letter, which is a dash *-.

All the other items in our home directory are directories. You can tell
because they are blue, and our testfile.txt file is white.

pifraspbherrypi touch testfile.txt

‘E:Llll“"ﬂ'f“ml 15 -1 STEP 4 The next nine letters of the permissions are known as
druxr—-xr-x & pi pi 4096 Apr 21 17:55 “alpha notation” because they let you know the
druxr-xr-x 3 pi pi 4096 May 13 18:¢ permissions using letters. Each permission is either on, in which case
drwx—————— & pi p1 4036 May 13 11:C you see a letter, or it is off, in which case you see a dash. The letter
‘7"_“-‘”'?““_""“?““’ S Pr B 1096 ﬂ'."ﬁ $ m ; doesn’t change for each place. So the first permission - the second
Aruxr—-xr—x 3 pl pl1 4096 May 13 14:a.

druxruxr-x 2 pi pi 4096 Jan 1 1970 letter after the directory one - is eitheran 'r ora - It's never any
druxr-xr-x £ pi pi 40906 May 13 11:05 other letter.

ru-r——r 1 pi pi 0 May 13 £1:14 testfile.txt

piPraspberrypi

pilfraspberrupi lz -1 testiile.txt
-rw-r——r—— 1 p1 p1 O May 13 £1:149 testtile.txtL

piPraspberrup)
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STEP 5 The ‘r means that particular permission is read and it's
set to On. The nine letters here are divided into three

groups of three letters: r, w, x. They stand for read, write and execute

(run). Read means the File can be viewed (using cat or nano); w means

the File can be edited or moved, and x means the file - typically a script
or program - can be run.

- TWX W= [--

S

Read

Read

Write

(Don't
execute)

Read

Write
Execute

only

CHANGING PERMISSIONS

Ownership and Permissions
N\

STEP 6 The presence of r, w, or x means that this aspect is
¥ possible, a dash means it isn't. Our testfile.txt has no x
letter; so if it were a script it wouldn't run. So why are there so many

letters? Why not just three; read, write and execute? The three blocks
of three letters are for different sets of people: user, group and other.

User Group Other

Now that you know how groups of permissions work, it's time to look at how to change them.

The first block of three is the most important. This is
STEP 1 _ . . .
¥ the user who owns the file (typically pi); the second is
For other people in the same group as the user, and the third is for
other people on the system. Permissions are changed using the

chmod (change file mode bit) command. Enter: man chmod to look at
the manual.

CHMODC(1)

NAME
chmod change file mode bits
SYNOPS IS
chmod | i i Vi
chmod | ...
chmod | | [P

DESCRIFPTION
This manual page documents the GNU version of chmod.
representing the bit pattern for the new mode bits.

chmod changes the file mode

The format of a symbolic mode is [ugoa...l[[+-=1l| .eed...1, uhere

rated by commas,

A combination of the letters ugoa controls which users’ vweg to the file will
(a)., If none of these are given, the effect is as if a were given, but bits that

The operator + causes the selected file mode bits to be added to the existing fil
except that a directory’ s unmentioned set user and group ID bits are not affected

The letters ruxXst select file mode bits for the affected users: read (r), writ
for some user (X)), set user or group ID on execution (8), restricted deletion fla
granted to the user who ouns the file (u), the permissions granted to other us
gories (o).

A numeric mode 1s from one to four octal digits (0-/7), derived by adding up the b
set group ID (£) and restricted deletion or sticky (1) attributes. The second d
other users in the file's and the fourth for other u

STEP 2 The chmod command is one of the trickier ones to
understand. There are two ways you can adjust
permissions; the first is using chmod with an option to target one of
the three groups: owner, group, other. For these you use u,goro
followed by = and the letters or dashes you want. So enter: chmod

ugo=rx testfile.txt to make all three groups read, write
and execute.

group,; with the same values;

chmod ugo=rux testfile.txt
pi@Praspberrypl s -1

total Z0

druxr-xr-x & pil p1 4096 Apr 21 1/7:55
druxr-xr-x 3 pi pi 4096 May 13 18:

drwx 2 pl p1 4096 May 13 11:01
druxr—-xr-x 3 p1 p1 4096 Apr 17 18:40

plPraspberrypl

druxr-xr-x 3 pl1 pl 4096 May 13 14:53

druxruxr-x < pl pl 4096 Jan 1970
druxr-xr—-x < pi pi1 4096 May 13 11:05
ruxrwuxrwux 1 pi1 pi 0 May 1.
pi@raspberrupi

Turning everything on is probably overkill, so you need
to target each group. Do this by putting commas

between each mode option. Enter: chmod u=rwx, g=rw, o=r

testfile.txt to give users read, write and execute privileges, user

read and write and other just read. Enter:
1s -1 to see your handiwork.

chmod u=rwx,g=rw,o=r testfile.txt
pl@raspberrypl 1s -1

total Z0

druxr-xr-x < pi1 p1 4096 Apr 21 1/7:55
druxr-xr-x 3 pi1 pi1 4096 May 13 18:08
drux > pl pl 4096 May 13 11:01
druxr—-xr—-x 3 pl1 p1 4096 Apr 1/ 10:40
druxr-xr-x 3 pi1 p1 4096 May 13 14:53
druxruxr-x < pl1 p1 4096 Jan 1 19570
druxr-xr-x < pi pi1 4090 May 13 11:050
ruxru-r 1 p1 pi 0 May 13 21:14
pi@raspberruypi

piPraspberrupl

Alpha notation is fine, but many Linux admins use
STEP4 y - )

¥ octal notation instead. This is a three-digit number
that represents permissions. This is the formula: read=4, write=2 and
execute=1 and you add them up for each group, therefore if a group is
read, write and execute it's 7, if it's read and write it's 6 orif it's just

execute it's 1. A popular option is 755. Enter: chmod 755 testfile.
txt to change the file using octal notation.

Read = 4
Write = 0
Execute = 0
Total = 4

Read = 4
Write = 0
Execute = 1
Total = 5

Read = 4
Write = 2
Execute = 1
Total = 7
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Useful System and
Disk Commands

Understanding these core Linux commands will enable you to not only master the inner

workings of your Raspberry Pi but also to transfer those skills to other Linux distros, such as
Ubuntu or Linux Mint.

LOTS OF LINUX

Linux is @ huge and versatile command line language and there are hundreds of commands you can learn and use. Here are a few that can
Enter: uname to view the name of the operating

help you get more from your Raspberry Pi.
STEP 1 The Raspber!'y Piis a g_reat llttlE.! computer, so let’s STEP 3 ! W ‘

start by getting some information. Enter: cat / system’s kernel, this is the element that sits between

the interface and hardware. Just as you would suspect, the response

proc/cpuinfo to view some details on your Raspberry Pi processors.
IF you have a Raspberry Pi 3 you will see four processors, along with from the command is Linux, as Raspbian is a Linux distro, which in
itself is based on another Linux distro called Debian. While it may

the model name and other info.
sound complicated, it actually demonstrates how versatile Linux is.

.Hi'="|' '.'-!I]'I'.'I"l" |J_|i
processor - -
node !l name . ARNu
HogoM IS : 38 .40
Features : halt

: Ox41
LU architecture: ¢

LPU variant : Ox0
LU part : Dxco/
LI'U

cat sprocscpuinfo
Frocessor rev o (wil)

thumb fastmult ufp edsp neon ufpuld tls ufpud idiva idivt ufpd3Z lpe

|.|;III ‘irl'lj:'l Il‘l':'lr'l'lTl‘I" II II"-i rrI!_J:

) i JHI"*":‘{'I}"I' rrup i
L Inux

pil@raspberrupi

reulsiomn

Remember that catis

'I'II"'!Il‘.l:f'."-:lll"
model name
bogoM 1S
reatures

LU implemen
LI'U architec
CPU variant
LU part

CPU revision

processor
model name
BogoM1FsS
Features

LU 1mplementer

: ARKMuY Pro
: 38.40
: half
: Ox11

g

-S|
: ARNuY
. J0 .90
: half

« 1 Ox41

Processor rev

thumb ftastmult

r Dx0

: Dxcl)/

LSS0 I'CLW

thumb fastmult

CPU architecture: 7

LPU variant
el |I.-1|“'T_
LU revision
processonr
mode]l name

BogoM TIPS

: BDxl)
: Oxclhy

.
3

- |||':H4.-|-." I.'I"'i"ll'l"."i]]:" L) ll
38 .40

5 (uidl)

utp edsp neon

a (u/l)]

vipud tls

wi tls v FI"‘"" id iuva

ufpud idiva 1divt vuipd3s 1p

idivt ufpd3Z 1pa

used to list the

contents of a text File,
which is what cpuinfo
is. There are other text
Files with system info
available. Try “cat /
proc/meminfo” to get
information about your
memory, “cat /proc/

partitions” for

information about your
SD card, and “cat /proc/
version” shows which
version of Raspberry Pi

you are using.
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MemAvail lable:
Butters:
Cached:
swapCached :
Active:
Inactive:

Act ive (anon):
Inactivelanon):
Active(file):
Inactivel(tile):
Unevictable:
Mlocked:
owaplotal:
swaplkree:
Dirty:
Writeback:
AnonPages :
Rapped :
Shmemn:

alab:
SReclaimable:
alnreclaim:
KernelStack:
Fagelables:
NFS Unstable:
Hounce :
WritebackTmp:
CommitLimit:
Committed AS:
Umal locTotal:
Umal locUsed :
Umal locChunk :

nilPras !II!' ‘e ”:i

|;=11:|,il.t.|' minor #blocks

79 1

b

cat sproc/smeminfo
oB4304 kb
81576 KB
8340880 kB
11660 kb
ob340 kB
0 kb
43148 kB
JOO/L kB
11256 kB
ot kB

104396 kB
102396 kB
36 kB
0 kB
11132 kB
4b4 kb
2b0 kB
16384 kB
14512 kB
abi/e kB
672 kB
b4 kB
0 kB
0 kb
0 kb
2941548 kB
43712 kB
1171456 kB
3880 kB
Y2360 kB
cat Zproi
name

spartit 10NS

frbl1920 mmcbhl kU

835890 mmchlkOp]
1 mmcblkUpe
32768 mmchlkOpd
b1440 mmchblkOpS

bo136490 mmcb l kUOpb

Enter: uname -a to view some more detailed
STEP 4 . . ,
information. Here you'll see the kernel name,
nostname and kernel version (3.18.7-v7 on ours). If you have a
Raspberry Pi 2 you'll see SMP (symmetric multiprocessing),
"ollowed by the system date, CPU architecture and operating
system (GNU/Linux).

D 1L, |"s‘,:-~.!rh‘ rrup i winame
L 1nuXx

uname -—a
3.18.7-uv/+« #7555 SMP PREEMPT Thu Feb 12

pi@raspberrypi
Linux raspberrypi
pilPraspberruypi
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Useful System and Disk Commmands

STEP 5 Enter: vcgencmd measure temp to view the current
operating system temperature of your Raspberry Pi.
Enter: vcgencmd get mem arm toview the RAM available, and
vcgencmd get mem gpu to view the memory available to the

graphics chip. Finally try 1s usb to view a list of attached USB devices.

L | [@Pra :~~:!||‘|‘ UP [ l..H.'!Z[t'"f'IHZIr|1l‘|
temp=36.9°C
pilPraspberrupi

arm=880M

vcgencmd get_mem arm

pi@raspberrypi
gpu=126HM
pi@raspberrypi lsusb

Bus 001 Device 00Z2: ID 0424:9514 Standard Microsystems Corp.

vcgencmd get_mem gpu

Bus 001 Device 001: 1D 1d6b:000Z Linux Foundation 2.0 root hub

bus 001 Device 003 1D 0421 'ecO0 Standard Nicrosystems Corp.

Bus 001 Device 004: 1D 04d9:1503 Holtek semiconductor, Inc. Shortboard |
Bus 001 Device 005: ID 1a40:0101 Terminus Technology Inc. 4-FPort HUB
Bus 001 Device 006: ID 276d:1105

pilPraspberrypl

DISK COMMANDS

STEP 6 One command you might be wondering about is how
to switch off or restart your Raspberry Pi from the
command line. Don't just hit the power switch. Enter: sudo
showdown —h now to shut down the Raspberry Pi (the “-h"” option

stands For “halt”), or enter: sudo shutdown —r now to restart your
Raspberry Pi.

piPraspberrypi sudo shutdoun -r now

broadcast message from root@raspberrypl (ttyl) (Thu May 14 12:20:£9 Z015):
The system 1s going down for reboot NOW?

Learn the two commands that enable you to view your disk space and the files on it: df (disk Free space) and du (disk usage). With these two

commands you can view the file usage on your SD card.

Start by entering: df in the command line. It returns a
list of the volumes contained on your SD card. You

might be wondering what a volume is. It's best to think of your SD card

as the drive. This contains partitions, which is where you split one drive

to act like two or more drives. And each partition can contain volumes,
which are storage spaces.

pil@raspberruypl df
Filesystem 1K-blocks Used Avallable Use’  Mounted on
rootts bH81636 3484164 10096 5Sbx /
6581636 34184164 2710096 56~ -
437856 0 437856 0/ sdeu
88432 260 88172 1 /run
5120 0 5120 0 /run/lock
176860 0 176860 07 /runsshnm
60479 14536 145943 25~ /boot

sdevsroot
devtnpfs

tmpf's

tmpfs

tmpfts
sdevs/mmchb 1kOpS

"Iq % P s s R g
piPraspber up i

STEP 2 Enter: df —h to get the list in human readable form.
The first two lines should read “rootfs” and “/dev/
root” and have matching Size, Used, Avail and Use% listings. This is the
main drive, and is an indication of how much space you have used, and

have free, on your Raspbian OS. The other volumes are for booting
and initialising devices (you can ignore these for now).

du -h | less

22M .minecratt/games/com.mo jJang/minecrattior lds/wvor ld

ZZeM . .minecraft/games/com.mo jang/minecraftlorlds

ZeM Z minecraft/games/com.mo jang

VA y 7 .minecraft/games

4 .0K Z.pulse

16K .config/gedit

d .0k .config/1libtm

1.4M Z.configsepiphanysadb lock

1.5M /.conf igsepiphany

4.0k conf'ig/ilxsession/LADE-p]

12K 7 .configslxsession
(
(
i
|

pil@Praspberrupl

8 .0K /.cont1igsdcont

o.0K .config/rnche . org

o .0k s.configslxterminal

g.0kK ./ .conflgsuk.ac.cam.cl

d .0k /.config/indieCity

4.0K /.conf igsenchant

8.0K 2 .config/lxpanel /LXDE-pi/panels
16K /. configslxpanel Z/LXDE-pi

9K .confi1g/ lxpanel

CLOK .7 .cont 1g/openbox

Now enter: du. You should see lots of text fly up the
screen. This is the disk usage for the Files contained in
your home directory and their sub-directories. As with df, it is better to
use du with the “-h” option to humanise the output. If you want to
slow down the output, you'll also need to pipe it through less. Enter:

df -h | less toview the filesand their respective usage one page
at a time.

piPraspberrypi dif -h

IFilesystem olze Used Avall Usex
rootfs b.3G J3.4G .76
sdev/root b.36G 3.4G Z.7G 5H6% /
devtmpfs 128M 0 4Z8M 0 sdeu
tmpt's 9/M ZbOK o % i
tmpis o .0M 0 5.0H D4 /run/lock
tnpts 1/3M 0o 1/73M D2 /runsshn
sdev/mmchb 1 kOpS bun 1oM 9oM 254 /boot

D I :r"l"-'_.'-'!Ii"l".l""ln"'_lll 1

Mounted on

STEP 4 You don't typically enter: du on its own; most of the
time you want to view the disk usage of a specific
directory. Enter:du -h python games to view how much space the
python_games directory (installed alongside Raspbian) takes up. It
should be 1.8M. If you want a more comprehensive breakdown of the

files contained, use the “-a” option (all). Enter: du -ha python
games to view all the Files contained and their disk usage.

piPraspbherrupl IS
piPraspberrupi du —h python_games
1.68M python_games
piPraspberrypi du =ha python_games
12K puython_games/RedSe lector . png

1ZK python _games/4row_ board . png

12K python_games-/otar.png

LUK python_games/4row_humanw inner . png
LK python_games-Wall_bBlock_Tall.png
H.0K python_games/princess.png

12K python_games/
.0k python_games/
4 .0K python_games
20K python_games/f1ippuy.puy

JbK python_games/matchd.wav

24K python_games/starpusher . py
4.0K python_games/grassl.png

40K python_games/beepd . ogy

12K python _gamess/slidepuzzle.py
gens . png

16K python_games/tourinarouw.py
g.0k puthon_games/gens . png

36K python_games/f 1 1ppyboard. png
12K python_games/Grass_Block.png

oe lector . png
4rouw_black.png
scatanimation.py

8 .0K python_games/

www.bdmpublications.com 71



\ i/ . .
- Learning Linux
/

Managing Programs

and Processes

Being able to effectively manage the active programs and processes on your Raspberry

Pi allows you to change the way the systems work. If you have a project requiring more
memory, you can Kill a process to free up the available system resources.

PROGRAMS AND PROCESSES

Linux has a trick up its sleeve when it comes to being able to manage programs and processes. When Windows closes a program, the
allocated memory often isn’t freed up again. However, Linux is far more streamlined.

STEP 1 As you get
Into Linux

you'll start to hear more
about processes and
another thing called the
"kernel”. The kernel sits
beneath the software and
hardware. It passes
instructions to the
hardware running
processes, which takes up
memory, and when the
process is finished it
closes it and reclaims

the memory.

Haraware

Software

You're probably used to thinking in terms of programs
STEP 2 , |
and most OS’s tend to keep processes out of sight. In
_inux on the other hand, you're right in at the deep end. A process is
ike a program, only it's a single task running on your computer.
Programs as you know them, may be a single process, or multiple

processes working together. In Linux, you should learn to manage
processes. This is done using the “ps” (process status) command.

pifraspberrupi
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If you type in “ps” on its own you don't see much. You
STEP3 .

should see two items: bash and ps. Bash (Bourne
Again Shell) is the command line environment you are typing in, and ps
is the command you just entered. IF that seems a little light, that's

because it is. These are just the processes owned by the user and are
running in the foreground.

piEraspbherrupi ps
Fily TTY TIAE CHD
Z1b63 ttyl OO0 01 bash
Z37b6 ttyl 00 00100 ps
P 1Pras P ks Errup m

STEP4 = TIME CMD
—— Lt 00:02 init

processes USECI by Other 0000 kthreadd

3 7 00:00 ksoftirqgd/o
users (including those 5 7 00:00 kworker./0:0H
y 1 0O :00 kworker-ug:0
started by root) enter: ps 2 7 00:00 rcu preempt
—a. The option stands for - 4o e
all users. This still isn't 7 00:00 migration/e
. ! 00:00 migration/
everything though 2 7 00:00 ksoftirqd/
because it doesn't include i e :?:::ftn}l'.f:..f--
background processes. For il e i”: irgqd/2
. ; " 0000 kworker/<:0
this you can enter either ? 00:00 kuorker/2:
i " T " . . 9 %9 DO :00 migration/d
ps—A" or “ps—e". This will 20 1 00 :00 Tlf'.lu i-,-l-r::;.--fr:
show you every process on 99:69 kwarker/3:
) ) o3 1 0000 khelper
the system including the 24 7 00:00 kdeutnpfs
25 7 DO 00 netns
background processes. You % 4 00:00 perf
may need to pipe it ey b ik 'f"": g ';*"
. oo DO 00 writeback
through less using 00:00 crypto
T I. n : 4 0O :00 bioset
ps = | ess . '_ ? 0000 kblockd

00:0Z2 kworker-1:1
00:00 rpciod

D000 kswapdO

DO 0D fsnotity_mark
U000 nisiod

00:00 kthrotld
V000 UCHIY-O




Managing Programs and Processes

STEPS RS
crmerd - EREEEA R R

one of the oldest known, and ST I SRR BN O 4
it has a lot of legacy. Because (SIS SIS SUNNNE BN & - gt
of this, it also has alternative
options that can be used
without the dash at the start.
The most common way to
use psis to enter: ps aux.

biping this command S L

1100 [rpc iod

hroughlessis the bestway  [EEHENESTETINEER RN IE - I 4

'0 go about using ps. Enter: [ uET RIS A S S T R

1:G8 [WCH IO

08 [WCH s

less to view

pPS aux |
your processes. or EET 1 4 L &R ymsauw

] { el b s
0 <00 | ke ke
1200 [ kworker
D iuw [ mncgd.
R0 L bl Tam
Lo [extd—rs
1 =1 |F|||.'|'F_| i~

LD | kEworker

VIEWING AND QUITTING PROCESSES

STEP 6 The “ps aux” command displays the processes in
columns. The first is the User followed by the Process
ID (PID), then we see the percentage of CPU and memory.

1:00 | Kworker<ul: s
D0 | kworker, i
[ AmcCogd. o )

00 [ jhd2. mm h||-|"|lf- |
):00 [extd-rsu-conuerl
IR | kworker/ 4111

D [kKworker-s3:11]

) wdeud d VI

O wdewd daerion

ks el el e el e el el el el
B Y RT S R El R Mg LYy

||I‘I|'||I1 I"I.II"HI“II-I

) susresbinsifpluyd =i v -y - w0 -d10 -w -]
031 susrsshinsifplugd -1 ethd - -f -ud -410 -u -1
porker-0:qc )
. 71
1

(=1

el AebLtoaL i_|||4r|]||-1r-

U |"I||1-L-ii|-|.}|||1 i T et 2 10k
IS —daemnn S TEm

Lty 30100 tiyl
1 1H400 ttyd
y 38900 tty1
y 38400 ttySs
tty 38400 ttyb
vinsgetty -L ttyAMAD 115200 ot 100
) =pf srunsdhcl lent .ethO. pid
: TEA G~ il
001 ba=h
1:00 [kworker-0:11
10 [ kworker0:0]
1 :HH s AllX
My :

s il el il Bl e ek Pl e el ek el e el el bl el (el Bl il [l
= o ek & | T - Ty YR = e n i o P

Now that you've got a handle on processes, you need to know what to do with them. You can view processes running in real-time, and quit

ones that you no longer need, or those that are problematic.

STEP 1 While ps is a great tool for checking all the processes
on your Raspberry Pi, sometimes you need to view
them in real-time. In particular you may want to check the CPU and

memory usage of processes and see if any process is hogging all your
computer’s resources. Use “top” to do this.

top - 15:31:39 up 3:10,
Tasks: 74 total, 1 ruming,
ZCpu(s): 0.0 us, 0.1 sy,
KiB Men: 884304 total,
KiB Swap: 102396 total,

1 user, load average: 0.00, 0.01, 0.05

73 sleeping, 0 stopped, 0 zombie

0.0 ni, 99.8 id, 0.0 wa, 0.0 hi, 0.0 si,

146240 used, 738064 free, 38084 buffers
0 used, 102396 free, 31224 cached

PID USER PR NI VIRT RES SHR S xCPU »ME TIME+ COMMAND

2539 pi 20 0 4704 2472 2084 R 5.9 0, 00.04 top
root 2.0 0 2152 1364 1260 5 0.0 0.2 D:0Z2.09 init
2 root 20 () 0 ) 0D S 0.0 0.C D00 .00 Kthreadd
root 20 () 0] 0] 0 0.0 0.¢ D:00.19 ksoftirgd/(
root 0 =20 0 0 0 JN 0.0 0.C D:00.00 kworker-0:(
h root 20 ) 0 0 ) 0.0 0.0 D:00.95 kworker-u8
? root 20 0 0 0 0 0.0 0.0 D:00.86 rcu_preemp
root ¥l () 0 0 0 0.0 0.¢ D:00.00 rcu sched
root 2.0 0 0 0 0 0.0 0.0 D:00.00 rcu bh
root rt () ) 0 0 0.0 0.0 J:00.03 migrationst
root rt v 0 0 0 0.0 0.C D:00 .02 migration/
Z root 20 0 0 0 0 0.0 0.0 D:00.01 ksoftirqgd/
4 root 0 -20 0 () () 0.0 0.C D:00.00 kworker-1:(
) root rt 0 0 ) () 0.0 0.0 D:00.01 migrationse
root 20 ) () 0 ) 0.0 0.0 D00 .01 ksoftirgds:«
¢ root 20 0 0 0 0 0.0 0.C D:00.00 kworker-/s:(
root 0 —20 0] 0] 0] 0.0 0.¢ D:00.00 Kworker/<Z:(
9 root rt 0 0 0 0 0.0 0.0 :00.0Z migration/:
20 root 20 0 0 0 0 S 0.0 0.0 D:00.0Z ksoftirgd/.

R A R R R R Y " r. Ny
Wi e e W --l"-I ooy Wy W l---'-.- E-'r --"I- o o ---"::I

Fo8

STEP 2 Top fills the display with processes and it Fits as many
as it can on one screen. These runin real-time so as
you watch, the display items will move up and down according to their
usage. You can interact with top as it is running: use < and > to change

the sort column. Press H to view a help page with all the commands
you can use.

Help for Interactive Commands
Window MI Cumulative mode Off. » >k

L
2. B Global: "2’

1,t,

1]

o

procps—-ng version J.3.3
Delay 3.0 secs: Secure mode

change color mappings: "B’ disablesenable bold
m Toggle Summaries: 1’ load avg: 't’ taskscpu stats: 'm’ mem
’ Toggle SMP view: '1’ singlesseparate states: "I’ Irix-/Solari
¥ Manage Fields: add-remove: change order: select sort field
. Locate: 'L"/'& findragain: Move sort column: ‘<" /"> leftsr
. Toggle: "R’ forest view
. Toggle: "¢’ cumulative ti
. Toggle highlights: ’x’
. Toggle: "z° color/s/mono: b
. Show: "u’ effective user: U’
. ot maximum tasks displauyed
. Toggle scroll coordinates msg for: up,doun, left,right,home,e

norn/rev sort: '"H show threads: "V’
cmd namesline; "1 idle tasks: 'S
sort field: "y ruming tasks
bold/reverse (only if "x° or "y

real, saved, tile or ettective

Manipulate tasks: "k’ kill: "'r° renice
set update interval
Urite configuration file
Juit
( commands shoun with " ." require a visible task display windo

“or 7?7 for help with Windouws,

STEP 3 Now that you've got an idea of what processes are,
how do you go about stopping them? Some processes
run in the foreground until you quit them. Enter: ping www.google.

comand you'll start a ping process continuously contacting Google.
This sort of process runs until you press Control+C.

pifraspberrypi ping gqoogle.com

PING google.com (bs.£5£.169.182) H56(84) bytes of data.
b4 bytes from midb—mpl-cuxlb.lan.ntl.com (bg. 202,103,

b4 bytes from midb-mpl-cuxlb.lan.ntl.com (bL.£02 .16,
64 bytes from mdIB-mpl-cuxlb.lan.ntl.com (6£.252.169.;
b4 bytes from md3B-mpl-cuxlb.lan.ntl.com (62.252.169.

“C

——— google.com ping statistics ——

4 packets transmitted; 4 recelved, U< packetl loss, Lin
rtt minsavgsnax- -mdeu 11.3974-11.967 712 .480.-0 .401 ms

pilPraspberrypi

STEP 4 Processes are stopped using the kill command. Enter:
sleep 100 & tocreate adummy process. Enter:
pgrep sleep tofindits PID number (on oursitis 2192). Now enter:

kill 2192 and the sleep process will be stopped. You can also use
pkill sleep if you're sure you know the process name.

D i 'r"r'+'?-:ll]“|':|"r‘ Ip !
L1] Z£11]
pil@Praspberrypl
2211

pi@raspberrupi

sleep 100 &
pgrep sleep

kill 2211
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Input, Output and Pipes

Most operating systems allow you to direct the output of something on the screen to, for

example, a file. Linux, with its ancestral history of Unix-like command-based arguments, goes

a step further and offers much more control.

IN, OUT, LINUX ALL ABOUT

Everything on a computer is about input and output. You input things into the computer (press keys, move the mouse) and it makes
calculations and outputs content (changes the display, makes a noise, for example).

STEP 1 When you enter commands into Linux (in the
command line), you are using standard input and
output. This is so obvious that most people don’t even think about it.
You enter commands using the keyboard (that’s input) and it responds
to the screen (output). This is the reqular way of doing it, which is why
it's “standard input and output” (often called “stdin” and “stdout”

for short).

Input (keyboard)

Qutput (display)

STEP 2 As Far as the computer is concerned, input and output
can be to and from a whole range of different sources
that you might never even think about. A program can get input from
other programs, from files stored on the hard drive and a whole host

of other areas. It outputs back to the display line, but also to Files,
other programs and even other commands.

Files

Command line Other programs
"\

-] g;“__j fh"'?.
*{E [ A\ &

‘-«.._H‘H ,,/ \/_,..r e
rogram

.-"""'--

P
f
v~ / {\
\ 5 -

J""F k-
-

"~

Display

Other programs

Printer Files Other commands
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STEP 3 You can change the standard output to something
else using the “>" character after your command. If we

wanted to see all the items in the python_games directory we could
use “ls -l python_games". Using “Is -l python_games > games.txt"
outputs the list of items to a new text file called "games.txt”.

pifraspherrupi 1s -1 python _games > games.txt

The games.txt File now contains the output from the Is
command. You can check it using “nano games.txt”.

It's an editable text File containing all the permissions, user and file

size information and the names of the Files. The output from the Is -l

command, normally displayed on the screen, was instead sent to this
File. Press Control+X to quit nano.

GNU nano 2.2.6

total 1800

ru-ru-r pi pi 9731 Jan 27 31 4row_arrouw.png
w=ruw-=—i

ruW—ruwu-—-r

pi pi 7463 Jan 27
pi pi 8666 Jan 27
pi p1 18933 Jan 2, : 34 4row_comnputerwinner.png
pl1 p1  2541<Z Jan &7 341 4row_humanwinner.png

pl1 pi 8bhbZ Jan 27 31 4rouw_red.png

p1L pi o91< Jan &7 31 4row_tie.png

pi pi 36908 Jan 27 : 31 badswap.uwav

pi pi 39782 Jan 27 ;341 beepl.oqy

p1 p1 39284 Jan £¢7 08:34 beeps.oqq

p1 p1 30581 Jan £¢7 08:34 beepd.oqq

p1 pl .
p1 pl J08 Jan £/ 34 blankpygame . py

: 31 4row_black.png
: 31 4row_board . png
~ru-ru-r—-—
"W=Irw—i"
rw-ru-r
ru-ru-r
ru-ru-r
ru-ru-r
ru-ru-r
ruw—rw-r
—Irru=ruw-r-——
ru-ru-r

39214 Jan 27 .34 beep4.oqg

W Iru—Ir
ru—-rw—r

pl1 pi bhdl Jan £/ : 341 boy.png

p1 pi 1034 Jan &7 31 catanimation.py

p1 pi (e Jan &7 :J1 catgirl.png

pi pi 12574 Jan 27 :34 cat.png

p1 pi 1178 Jan 27 08:34 drawing.puy

ru-ru-r pi pi 83036 Jan 27 :34 flippybackground . png

1
1
1
]
]
1
1
1
1
I
1
I
1
1
1
rw-ru-r 1
]

|

1

-rw-ru-r-— 1 pi p1 340700 Jan £/ 34 flippyboard.png

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

|

1

]

"W=ruw-i
"wW—Irw—I

ru-ru-r pi pi 19479 Jan £/ 31 flippy.py
pi pi 13080 Jan 27 ;341 fourinarow.py
pl1 pi 2134 Jan &7 31 gamelicon.png

W= Irw—rI
rW-ru-—-nr
ru—rw-r
N T T —
W rw—Ir
"w—Ir'w—I
"w—ruw—Ir
"w=rw—r
I"wWw=1rw=I*

p1 pl 430 Jan &7 31 geml.png

pi pi 5665 Jan 27 34 geml . png

pli pi 3454 Jan 2/ 34 gem3 . png

p1 pl 4217 Jan 47 .31 gemd.png

pi pi 2ab¢ Jan &7 - J1 gemo. png

pi pi 1681 Jan Z/ 31 gemb . png

pi pi 3132 Jan 27 08:34 gem?.png

p1 p1 22489 Jan 47 ‘31 gemgemn . py

pi pi 3009 Jan 27 34 grassl.png
pl pl 3019 Jan £/ 34 grasss.png
p1 pl Jo03 Jan 47 -39 grassd.png
p1 pl JU3L Jan £/ 31 grass4.png
p1 pl 0c11 Jan &7 : 31 Grass_Block.png
‘34 horngirl.png

rW-—ru-—r
—I'W—ruW—r—
—I'W=Irw—I—
'Ww—Ir'w—rIr
"'w—ru—I*
r'u=—ruw—Ir
"i=rw=r
"u—rw—r

pi pi 7186 Jan 27
pi pi 18855 Jan 27
pi pi 18739 Jan 27
pl1 pl (000 Jan &7

4 1nkspilllogo.png
DE8:34 inkspill.py
0:349 Inkspilllresetbutton.png

r'w—rw-—-r
-PU-re-r—



So > enables you to output to files, but you can also

get input from a file. Make a new directory called
music (“mkdir music”) and switch to it (“cd music”). Enter: nano
bands.txt tocreate anew text file. Enter some band names and
press Control+0O to output the file. Press Control+X to quit nano.

GHNU nano £.2.6

The Heatles

The Who

The Kinks

Credence Clearwater Hevival
Jefferzon Alrplane
Aerosmilth

S TOP

USING PIPES

\

Input, Output and Pipes

We're going to use this text file as input to the sort

command. Enter: sort < bands.txt and the
content from the text File is used as input to sort. Because the output
isn't specified, it uses the standard output (the screen) but you use
input and output together. Enter: sort < bands.txt > bands
sorted. txt to create anew file with the band names in order to

switch back to your pi account.

piPraspherrypi sort < bands.txt
Aerosmith

Credence Clearwater Hewviwval

Jefferson Airplane

The Beatles

The Kinks

The Who

s 1op

pillPrazpberrupl sort < bands.txt > bands_

As well as directing input and output to and from Files, you can send the output from one command directly into another. This is known as

yn
]

piping, and uses the pipe character

As you start to get more advanced in Linux, you
STEP 1 .
begin to create more powerful commands, and
one way you do this is by using the pipe character (“|"). Take

some time to find this character if you haven't already: it usually
sits above or to the left of the Return key on most keyboards.

piPraspberrupi ps aux | less

We've used the pipe a few times in the book (“ps aux |
STEP 2 i : ,
less”), but you might not have understood what's
actually happening. Enter: cat bands.txt | wc. The output from
the cat command (the text inside the document) isn’t displayed on the

screen, instead it is piped into the wc (word count) function. This then
tells us how many lines, words and characters are in the document.

pifPraspberruypi cat bands.txt | wcC

I 13 el |

pilPraspberrypl

You can pipe commands multiple times. Enter: cat
bands.txt | sort | grep The* togetthe bands

starting with “The" in alphabetical order. The output of the text from

the bands.txt document is passed into sort, and the output from sort is

passed into grep which Filters out the bands starting with “The". These
bands form the output.

piPraspberrupl cat bands.txt | sort | grep IThe

beatles
KiInks
Who

pilPraspberruypi

You can combine pipes with input and output to create
complex expressions. You can also use >> to append
outputted data to a file that already exists. Enter: cat bands.txt |
wc >> bands.txt. This takes the output from the bands.txt file and
pipes it into the wc (word count) function. The output from wc is
appended to the end of the bands.txt file. Enter: cat bands. txt to

view it.

>> bands . txt

piPraspberrupi cat bands.txt | wc
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Now you've got the basics
down, you can improve and
learn more essential sKills in

our next quide...

TRICKS AND TIPS

Coming soon!
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